
PART 10
Fairlight



Chapter 123

Using the 
Fairlight Page

This chapter covers the basic user interface controls found on the 
Fairlight page, where they are and what they do, in order to give you an 
overall orientation of how to work with this integrated audio environment.
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The Fairlight Page User Interface
In single monitor mode, the Fairlight page is an optimized look at the audio tracks of your 
project, with an expanded mixer and custom monitoring controls that make it easy to evaluate 
and adjust the levels of your program in order to create a smooth and harmonious mix.

Audio page

The Interface Toolbar
At the very top of the Fairlight page is a toolbar with buttons that let you show and hide different 
parts of the user interface. These buttons are as follows, from left to right:

The Interface toolbar

�� Media Pool: Shows and hides the Media Pool, from which you can edit audio clips into 
the Fairlight page timeline.

�� Effects Library: Opens the Audio FX panel of the Effects Library, from which you can 
apply VST and other audio effects to clips in the timeline.

�� Index: Shows and hides the Index and its Tracks and Markers panels. The Tracks panel 
lets you manage the tracks of the timeline, showing and hiding which ones you want 
to work with. The Markers panel lets you see every marker in the timeline, along with 
associated data, so that it’s easy to browse through your markers all at once to quickly 
find the information you need.

�� Mixer: Shows and hides the Mixer, to the right of the timeline, that lets you adjust 
various effects and levels associated with each track of the timeline in order to create a 
harmonious mix.

�� Monitoring: Shows and hides the Monitoring audio meters and viewer at the top of the 
Fairlight page.

�� Inspector: Show and hides the Inspector, from which you can edit different clip attributes.

�� Metadata: Shows and hides the clip metadata inspector. 
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Showing Which Panel Has Focus
Whenever you click somewhere on the DaVinci Resolve interface using the pointer, or use a 
keyboard shortcut to “select” a particular panel (such as in the Edit page), you give that panel of 
the user interface “focus.” A panel with focus will capture specific keyboard shortcuts to do 
something within that panel, as opposed to doing something elsewhere in the interface. 
A highlight appears at the top edge to show you which panel has focus so that you can keep 
track of which part of the current page is taking precedence, and you can switch focus as 
necessary to do what you need to do.

The focus indicator shown at the top edge of the Media Pool, 
shown next to a Viewer that doesn’t have focus

The Audio Timeline
The heart of the Fairlight page, the Audio Timeline presents the audio channels and tracks of 
the currently selected timeline differently than the Edit page does, in a one-channel-per-track 
format that’s optimized for audio mixing and sweetening. The Audio page timeline cannot 
be closed.

The Audio page timeline
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Controls in the Audio Timeline
The audio timeline has the following controls.

�� Timecode fields and Range buttons: Four timecode fields show the current timecode 
value corresponding to the position of the playhead (at the very top), the Range In 
point, the Range Out point, and the Range duration. Clicking the Range In and Range 
Out buttons (to the left of the timecode fields) set these points and their corresponding 
timecode value.

Timecode fields and Range buttons in the Fairlight page

�� Transport controls: The bar defining the top of the timeline contains the Fairlight page’s 
audio-specific transport controls, which differ from those found on the Media, Edit, 
Color, and Deliver pages due to its inclusion of recording capabilities. These include 
Fast Reverse, Fast Forward, Play Forward, Stop, Record, and Loop.

Fairlight page transport controls

�� Automation toolbar: Clicking this button opens a secondary toolbar with all the 
controls you need to configure the recording of mixer automation.

Fairlight page automation toolbar

��  Monitoring controls: At the far right of the transport controls, a set of three monitoring 
controls let you quickly control the output volume of your mix. An audio Enable/Disable 
button lets you mute audio playback, while a slider lets you change the volume, and 
a DIM button lets you temporarily duck the monitored volume being output in order 
to have a quick chat with your client about sports or the state of the world while 
keeping half an ear on the mix. Dim and Mute commands are also available from the 
Fairlight menu.

The monitoring controls

�� Timeline Ruler: The Timeline Ruler shows the program’s timecode. The playhead 
indicates the current frame and sample where you’re working in the Timeline, and 
the playhead has a handle that appears within the Timeline Ruler. Dragging within 
the Timeline Ruler moves the playhead. When you add markers to the timeline, these 
markers appear within the Timeline Ruler, as well.
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�� Playhead: Shows the current frame and sample of playback, and provides a visual 
representation of where you are while playing, shuttling, and jogging through the 
timeline. Also used as a reference point for editing operations. The largest timecode 
display at the upper left-hand display shows the position of the playhead.

�� Audio tracks: The Fairlight page of DaVinci Resolve supports multiple audio tracks, 
and each audio track may contain multiple lanes with which to accommodate the audio 
channels that are contained within multi-channel audio clips using track mappings such 
as stereo, 5.1, 7.1, or Adaptive (1–24 channels). All audio clips that have been edited 
into the Timeline appear within each track, with the recorded channels within each clip 
occupying as many lanes as that clip has available. At the left of each track is a header 
area that contains a number of controls.

The Fairlight timeline is divided into tracks and lanes; track A1 has a single lane for the 
mono audio within it, and track A2 has two lanes to accommodate stereo audio

�� Track header: The track header contains different controls for selecting, locking/
unlocking, and soloing/muting tracks. Each track header also lists how many clips appear 
on that track. The track header contains the following five controls, from left to right:

The track header controls of the 
Fairlight page timeline

–– Track color: Each track can be color-coded with one of 16 different colors. These 
color codes correspond to the Edit page Mixer, and to the Fairlight page Mixer and 
Audio Meters. You can choose a new color for any track by right-clicking the track 
header and choosing from the Change Track Color submenu. You can set multiple 
tracks to the same color by Command-clicking in the track header of multiple 
tracks to select them, and then right-clicking one of the selected track headers and 
choosing from the Change Track Color submenu.

–– Track number: Indicates the number of each track.

–– Track name: Each track has a name that defaults to the track number, such as Track 
1, Track 2. However, you can click any track’s name and edit it to be whatever you 
like. For example, you can rename each track with the type of audio you’re editing 
onto it, such as Production, Ambience, SFX, or Music. These track names are also 
used to identify each track’s channel in the Mixer, in the middle of each channel strip 
(each channel strip’s track number is simultaneously displayed at the top).
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–– Audio channel type indicator: Audio tracks also show which channel configuration 
that track uses, listing the number of channels for mono, stereo, 5.1, 7.1, and adaptive.

–– Fader value: A field displays the current fader setting at the position of the playhead, 
in dB.

–– Lock Track button: Light gray when turned on, dark gray when turned off. When a 
track is locked, clips can’t be replaced, moved, or otherwise edited, although clips 
on locked tracks can be graded.

–– Arm button: This button arms recording onto that track.

–– Solo button: Disables all other tracks but the current one, enabling you to quickly 
hear a single track in isolation. This affects rendering, so if one or more tracks are 
soloed, the muted tracks won’t be output or rendered.

–– Mute button: Temporarily disables audio on that track so it’s neither monitored nor 
output. This affects rendering, so if one or more tracks are muted, they won’t be 
output or rendered.

–– Audio meters: Each track has audio meters in the track header that let you see 
levels during playback.

�� Toolbar editing tools: The toolbar contains both modal and command buttons to let 
you work on your projects. More detail on these appears in the following section.

�� Vertical and horizontal scroll bars: If your project is longer than the current width of the 
Timeline, or the number of audio tracks is taller than the current height of the Timeline, 
these scroll bars let you drag to navigate around your program. When you scroll 
horizontally, you also move the playhead. You may also scroll vertically using the scroll 
wheel (or other scroll control) of your mouse or other pointing device. You may scroll 
horizontally by holding the Command key down while using your scroll control.

�� Individual Timeline track resizing: Any track in the Timeline can be individually resized 
by right-clicking anywhere within that track’s header control area and choosing a track 
height from the Lock Track Height To submenu of the contextual menu. You can choose 
a fixed size including Micro, Mini, Medium, Large, and Extra Large. When you choose 
a fixed track height, vertical zooming no longer affects that track until you change that 
track’s Lock Track Height to option back to None.

Resizing an individual audio timeline track using contextual menu options
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Track Layering
Audio layering is a special audio editing mode that lets you superimpose multiple audio clips in 
the same track, with audio clips edited into the top layers muting overlapping sections of audio 
clips appearing on lower layers. With audio layering enabled, superimposed audio clips are 
treated similarly to superimposed video clips that have opacity set to 100%, with clips on top 
obscuring (or muting) clips underneath. 

Turning on track layers opens up space to edit more audio into each track

Audio layering is incredibly useful for any situation where you’re combining segments of 
multiple takes together to create a single voiceover, audio vocal track, or dramatic performance, 
as you can choose which segments to use via their superimposed position in the stack of clips 
appearing in that track, while at the same time you’re preserving the other takes underneath in 
case you might want them later.

TIP: Track layering can be enabled for audio tracks on the Edit page as well.

Switching Among Multiple Timelines
Timelines can be organized like any other clip in the Media Pool. To open or switch among 
timelines, use the following procedures.

To switch timelines, do one of the following:
�� In the Edit page Media Pool, double-click a timeline.

�� In the Edit page Timeline Viewer, choose a timeline from the Timelines pop-up menu 
at the top of the viewer.

�� In the Color page, choose a timeline from the Timelines pop-up menu at the top of 
the viewer.

�� In the Fairlight page, choose a timeline from the Timelines pop-up menu to the left of 
the transport controls.
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Toolbar
The Toolbar has buttons that let you choose modes of functionality and other buttons that let 
you execute commands such as placing markers and flags.

Buttons in the Fairlight Page toolbar

�� Normal Edit mode: The default mode in which you can move and resize clips in the 
Timeline, roll edits, and do other basic editing tasks.

�� Region Selection mode: Performs an insert edit to the Timeline with whatever clip is in 
the Source Viewer.

�� Add Cut: Click to add a cut to every clip on an unlocked track that intersects the 
position of the playhead.

�� Snapping: Enables or disables clip snapping. When turned on, clip In and Out points, 
markers, and the playhead all snap to one another for reference while you’re editing. 
A pop-up menu lets you choose how to use snapping to quantize clip position, to Bars, 
Beats, Divisions, Tics, or via Smart snapping. 

�� Flag Clip/Flag Colors pop-up menu: Flags identify clips, and indicate all clips that 
correspond to the same item of media in the Media Pool. Clips can have multiple flags. 
Clicking the Flag button automatically adds a flag to whichever clip is currently selected 
in the Timeline. A pop-up menu to the right lets you choose differently colored flags, 
and clear all flags from the currently selected clip.

�� Add Marker/Marker Colors pop-up menu: Markers identify specific frames of individual 
clips. Clicking the Add Marker button adds a marker of the currently displayed color 
to the clip at the position of the playhead in the Timeline. A pop-up menu to the right 
lets you choose differently colored markers, and clear all markers from the currently 
selected clip.

�� Timeline View Options pop-up menu: Contains a variety of controls with which to 
customize the display of clips in the Timeline:

–– Timeline View Options: The left button lets you display or hide the video tracks 
in the current timeline, for use as a reference while you work. The right button lets 
you set the playhead to be fixed, so that during playback the tracks scroll past the 
playhead as it remains in place, which is useful when working with the Fairlight 
control surface.

–– Scroller: Three buttons let you turn on one video and two audio scrollers, which 
act as scroll bars and zoomed-in visual references for the video and audio media 
immediately surrounding the playhead.

–– Audio View Options: The left button lets you toggle full waveforms on and off, while 
the right button lets you toggle waveform outlines on and off.

–– Zoom Presets: These buttons let you choose from one of 7 zoom levels, and 
checkboxes let you show and hide flags and markers, full waveforms, and 
waveform borders.
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Selecting the Audio Timeline View options

�� Zoom Height slider: Lets you change the height of all tracks and clips in the Timeline 
at once. You can also zoom the height of timeline tracks by pressing the Command key 
while using the scroll control of your pointer, if it has such a control. The scroll wheel of 
a mouse is most common.

�� Zoom Width slider: Lets you shrink or expand the width of the contents of the Timeline. 
You can also control the width of the contents of the timeline using the scroll control of 
your pointer, if it has such a control. The scroll wheel of a mouse is most common.

Customizing Clip Display in the Timeline
Choose Fairlight > View Clip Info Display to open a dialog with which you can customize what 
information is shown at the bottom of each clip in the timeline. This dialog has options for 
viewing the clip name versus the display name, and for choosing from among a variety of 
metadata that you might want available as you work.

Selecting the audio clip view options
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Customizing the Timeline’s Display
There are a variety of ways you can customize the timeline to better see what you’re 
working on.

Fixed Playhead Mode
Turning on the Fixed Playhead mode in the Timeline View Options pop-up menu, or choosing 
View > Show Fixed Playhead, puts the Fairlight timeline into an audio-centric mode where the 
playhead remains fixed in place, and the Timeline scrolls underneath it as you use the transport 
controls or JKL to play, shuttle, or scrub forward or back.

Visible Video Tracks
A checkbox in the Timeline View Options pop-up menu of the toolbar lets you display small 
versions of the video tracks in the Fairlight timeline, for reference. These video tracks are 
uneditable; they’re simply there so you can see which audio clips correspond to which video 
items, and so they can be used as snapping targets for positioning audio.

Showing video tracks on the Fairlight page

Video and Audio Scrollers
Checkboxes in the Timeline View Options let you optionally show one Video Scroller and up to 
two Audio Scrollers at the bottom of the Fairlight timeline. 

Video and Audio Scrollers at the bottom of the Fairlight timeline
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At the default Low zoom level, the Video Scroller provides a scrollable frame-by-frame filmstrip 
view of the video of your program, where one frame of the scroller equals one frame of your 
video. Each of the two Audio Scrollers, on the other hand, let you focus on a continuous 
waveform view of a particular audio track. You choose which track populates an Audio Scroller 
via a pop-up menu in the Timeline header. 

Audio Scrollers showing the pop-up menu 
that selects which track they display

What Are They Used For?
The Audio Scrollers always provide a zoomed-in view of specific audio tracks that you’re 
focused on, regardless of the zoom level of the Timeline tracks above. This means you can 
focus on subtle details of the audio of one or two tracks that you’re working on, while the rest of 
the Timeline shows you the overall stack of tracks with clips that are playing together at 
that moment.

Meanwhile, the Video Scroller always shows the exact frame of video that corresponds to the 
current moment in time, so it’s an aid to precision editing involving frame-specific adjustments.

Additionally, both the Filmstrip and Waveform viewers scroll continuously during playback, 
giving you a preview of what visual actions and audio cues are coming a few moments forward 
in time that you can refer to while performing automation or recording foley.

Repositioning the Scroller Playhead
While the scrollers are visible, the Scroller playhead can be dragged to the left or right in the 
Timeline to give you more or less preview room to the right.

Zooming the Video Scroller
Right clicking on the Video scroller lets you choose a Low, Medium, or High zoom level. At Low, 
you get a frame-by-frame view of the program that feels like scrolling a strip of film on a 
Steenbeck. At Medium and High, you get a progressively abbreviated film strip that lets you 
zoom more quickly.

Scrolling the Fairlight Timeline Using the Scroller Tracks
Dragging the scroller tracks to the left or right smoothly scrubs through the Timeline in greater 
detail, regardless of the zoom level of the Timeline tracks above.
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Mixer
The Audio Mixer provides a set of graphical controls you can use to assign track channels to 
output channels, adjust EQ and Dynamics, set levels and record automation, pan stereo and 
surround audio, and mute and solo tracks.

The Audio Mixer exposes two sets of channel strips with controls that correspond to the tracks 
in the Timeline. The leftmost set of channel strips expose one set of controls for each track in 
the Timeline, while the rightmost set of channel strips expose another set of controls for each 
Main and Sub (submix) you’ve created to bus the mixed audio tracks to whatever set of output 
tracks you want to expose.

The Audio Mixer, with channel strips 
corresponding to the tracks in the Timeline

�� Track color: Each track can be differently color-coded, to help you keep organized.

�� Track number: The number of the timeline track corresponding to each channel strip 
appears here.

�� Input: A pop-up menu that lets you patch inputs, patch buses, and configure the input 
settings of audio signals routed through Blackmagic hardware interfaces.

�� Effects: VST and Audio Unit effects that you apply to tracks from the Effects Library 
appear here, with controls for enabling/disabling each effect, opening an effect’s 
custom controls, and deleting that effect.

�� Insert: Enables the routing of effects from Blackmagic audio interface hardware to 
outboard effects boxes and back again. This button can be toggled to enable/disable 
such routing.

�� EQ: Double-clicking exposes a four-band parametric equalizer with additional Hi and 
Lo Pass filters, that has both graphical and numeric controls for boosting or attenuating 
different ranges of frequencies of audio on each track. You can select from among 
four types of EQ filtering from the Equalizer Type pop-up menu, with options for Earth 
(the default), Air, Ice, and Fire. Each band has controls for the filter type (Bell, Lo‑Shelf, 
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Hi‑Shelf, Notch), Frequency, Gain, and Q-factor (sharpness of the band), with the 
available controls for each band of EQ change depending on the filter type.

The channel strip EQ window

�� Dynamics: Double-clicking exposes a set of dynamics controls with three sets of 
controls corresponding to an Expander or Gate, a Compressor, and a Limiter that can 
be used separately or in concert to manage the dynamics of the audio on that track.

The channel strip Dynamics control window

�� Aux: Lets you route that track’s channels through an Aux send bus. Each Aux bar 
corresponds to a specific Aux bus that you created. Double-clicking any of these bars 
opens up the Auxiliaries window, with which you can enable or disable auxiliaries, set 
each one to be routed Pre the channel strip or Post the channel strip (the default), and 
set the Send level and Pan value.

The Auxiliaries control window
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Whatever level you set an Aux bus will be shown in the bar that represents that Aux bus 
in the Mixer’s channel strip.

The Auxiliaries levels shown in the 
channel strip of the Mixer

�� Pan: A pan control compatible with stereo and surround panning. You can drag within 
this control to adjust pan, or you can double-click to expose a pan window. What 
controls are available in the pan window depend on the mapping of the audio track, but 
both stereo and surround panning controls are available, with corresponding numeric 
controls.

The Pan control window

Option-double-clicking on the Pan control of the Mixer opens an alternate 3D Audio 
Pan window. Whereas the regular Pan window lets you do stereo and conventional 5.1 
and 7.1 surround panning, the 3D Audio Pan window lets you do the kind of spatial 
audio positioning enabled by advanced surround formats such as Auro 3D and NHK 
22.2 (more information about specific support for these and other formats will 
come later). 

The 3D Pan window
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�� Main: These buttons let you assign a track or Sub’s channels to one or more of the 
main buses.

�� Submix: These buttons let you assign that track’s channels to one or more submix 
buses.

�� Track name: This mirrors the track name found in the header controls of the timeline. 
If you customize a track’s name in the timeline, that name appears here.

�� dB: Shows you the volume, in decibels, that track is currently set to.

�� Arm, Solo, and Mute buttons: Identical to the controls found in the track header 
controls of each timeline audio track. Arm lets you enable a track to be recorded onto. 
Solo lets you mute all other tracks in order to play that track in isolation (along with any 
other Soloed tracks). Mute disables audio playback from that track.

�� Fader: Each track’s vertical faders let you adjust the volume of that track, and perform 
automation recording.

The Monitoring Panel
The Monitoring panel that runs along the top of the Fairlight page shows all of the audio meters 
corresponding to the tracks in the timeline, as well as the Master Output meter, control room 
meters, and a video viewer.

The Monitoring panel

At left, a row of audio meters corresponds to the channel strips of the Mixer, one meter for 
every audio track in the timeline. Each track displays the number of meters that corresponds to 
that track’s audio mapping, with mono tracks having a single audio meter, stereo tracks having 
two, 5.1 tracks having six, and so on. All of these track and bus meters (with the exception of the 
Loudness meters) display both peak and RMS (root mean square) levels against a dB scale.

To the right of the Track meters are the Bus meters, in which all Mains, Subs, and Aux buses 
appear, separated by type, and each displaying the number of meters that corresponds to that 
track’s audio mapping. This way you can see the sum of all tracks that have been routed to a 
particular bus.

The last set of meters, to the right of all others, are the Loudness meters, which consist of two 
sets of meters and a numerical readout. These meters let you keep track of the integrated 
loudness of the overall mix, which is the standard to which all contemporary mixing 
specifications refer when describing the deliverables you’re expected to provide to the client.

Viewer
A small viewer to the left of the Monitoring panel shows the frame of video at the position of the 
playhead. The only available control is a button in the lower right-hand corner that lets you 
expand the Viewer into its own floating window.
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The Monitoring panel

The Media Pool
In the Fairlight page, the Media Pool serves as the repository of all audio clips in your project, 
both clips that appear within the timeline, and clips that you’ve added to your project but have 
not yet used. When you record audio into the timeline, the resulting clips are stored in the 
Media Pool as well, for future use. The Media Pool is also mirrored on the Media and Edit pages, 
and contains all of the video clips and timelines within that project. 

The Bin list at the left shows a hierarchical list of bins used for organizing your media, which is 
also used to organize your timelines. By default, the Media Pool consists of a single bin, named 
“Master,” but you can add more bins as necessary to organize timelines and clips by right-
clicking anywhere in the empty area of the Media Pool and choosing Add Bin. You can rename 
any bin by double-clicking on its name and typing a new one, or by right-clicking a bin’s name 
and choosing Rename Bin. The Bin list can be hidden or shown via the button at the upper 
left-hand corner of the Fairlight page toolbar.

The Media Pool in Thumbnail mode showing audio clips

Chapter – 123  Using the Fairlight Page 2420



The browser area to the right shows the contents of the currently selected bin in the bin list. 
Every clip you import, every timeline you create, and every AAF, XML, or EDL file you import 
appears here. You can create or import as many timelines as you need within a single project.

As elsewhere, the Media Pool can be displayed in either Icon or List view. In List view, you can 
sort the contents by any one of a subset of the total metadata that’s available in the Metadata 
Editor of the Media page. Of particular interest to audio editors are columns for Name, Reel 
Name, different timecode streams, Description, Comments, Keyword, Shot, Scene, Take, Angle, 
Circled, Start KeyKode, Flags, and Usage.

For more information on using the myriad features of the Media Pool, see Chapter 11, “Adding 
and Organizing Media with the Media Pool.” In the sections that follow, some key features of the 
Media Pool are summarized for your convenience.

Importing Media Into the Media Pool on the Fairlight Page
While adding clips to the Media Pool in the Media page provides the most organizational 
flexibility and features, if you find yourself in the Edit or Fairlight pages and you need to quickly 
import a few clips for immediate use, you can do so in a couple of different ways.

To add media by dragging one or more clips from the Finder 
to the Fairlight page Media Pool (macOS only):

1	 Select one or more clips in the Finder.

2	 Drag those clips into the Media Pool of DaVinci Resolve, or to a bin in the Bin list.

Those clips are added to the Media Pool of your project.

To use the Import Media command in the Fairlight page Media Pool:
1	 With the Fairlight page open, right-click anywhere in the Media Pool, and choose 

Import Media.

2	 Use the Import dialog to select one or more clips to import, and click Open.

Those clips are added to the Media Pool of your project.

For more information on importing media using the myriad features of the Media page, see 
Chapter 11, “Adding and Organizing Media with the Media Pool.”

Media Pool Preview Player
The Media Pool has a preview player at the top that provides a place to open selected source 
clips in the Media Pool, play them, add marks to log them, and set In and Out points in 
preparation for editing them into the Timeline via drag and drop. The Media Pool Preview Player 
effectively acts as a Source monitor for editing in the Fairlight page.

The preview player in the Media Pool
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�� Various viewing controls populate the title bar at the top. A pop-up menu at the upper 
left lets you choose a zoom level for the audio waveform that’s displayed. To the right 
of that, a Timecode window shows you the duration of the clip or the duration that’s 
marked with In and Out points. Next to the right, a real-time performance indicator 
shows you playback performance. In the center, the title of the currently selected clip 
is shown, with a pop-up menu to the right that shows you the most recent 10 clips 
you’ve browsed. To the far left, a Timecode field shows you the current position of 
the playhead (right-clicking this opens a contextual menu with options to change the 
timecode that’s displayed, and to copy and paste timecode).

�� The center of the Media Pool Preview Player shows you the waveforms in all channels 
of the currently selected clip, at whatever zoom level is currently selected.

�� Transport controls at the bottom consist of a jog bar for scrubbing, Stop, Play, and Loop 
buttons, and In and Out buttons.

Bins, Power Bins, and Smart Bins
There are actually three kinds of bins in the Media Pool, and each appears in its own section of 
the Bin list. The Power Bin and Smart Bin areas of the Bin list can be shown or hidden using 
commands in the View menu (View > Show Smart Bins, View > Show Power Bins). Here are the 
differences between the different kinds of bins:

�� Bins: Simple, manually populated bins. Drag and drop anything you like into a bin, 
and that’s where it lives, until you decide to move it to another bin. Bins may be 
hierarchically organized, so you can create a Russian dolls nest of bins if you like. 
Creating new bins is as easy as right-clicking within the bin list and choosing Add Bin 
from the contextual menu.

�� Power Bins: Hidden by default. These are also manually populated bins, but these 
bins are shared among all of the projects in your current database, making them ideal 
for shared title generators, graphics movies and stills, sound effects library files, music 
files, and other media that you want to be able to quickly and easily access from any 
project. To create a new Power Bin, show the Power Bins area of the Bin list, then right-
click within it and choose Add Bin.

�� Smart Bins: These are procedurally populated bins, meaning that custom rules 
employing metadata are used to dynamically filter the contents of the Media Pool 
whenever you select a Smart Bin. This makes Smart Bins fast ways of organizing the 
contents of projects for which you (or an assistant) has taken the time to add metadata 
to your clips using the Metadata Editor, adding Scene, Shot, and Take information, 
keywords, comments and description text, and myriad other pieces of information to 
make it faster to find what you’re looking for when you need it. To create a new Smart 
Bin, show the Smart Bin area of the Bin list (if necessary), then right-click within it and 
choose Add Smart Bin. A dialog appears in which you can edit the name of that bin and 
the rules it uses to filter clips, and click Create Smart Bin.

Showing Bins in Separate Windows
If you right-click a bin in the Bin list, you can choose “Open As New Window” to open that bin 
into its own window. Each window is its own Media Pool, complete with its own Bin list, Power 
Bins and Smart Bins lists, and display controls. 

This is most useful when you have two displays connected to your workstation, as you can drag 
these separate bins to the second display while DaVinci Resolve is in single screen mode. If you 
hide the Bin list, not only do you get more room for clips, but you also prevent accidentally 
switching bins if you really want to only view a particular bin’s contents in that window. You can 
have as many additional Bin windows open as you care to, in addition to the main Media Pool 
that’s docked in the primary window interface.
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Filtering Bins Using Color Tags
If you’re working on a project that has a lot of bins, you can apply color tags to identify particular 
bins with one of eight colors. Tagging bins is as easy as right-clicking any bin and choosing the 
color you want from the Color Tag submenu.

For example, you can identify the bins that have clips you’re using most frequently with a red 
tag. A bin’s color tag then appears as a colored background behind that bin’s name.

Using color tags to identify bins

Once you’ve tagged one or more Media Pool bins, you can use the Color Tag Filter pop-up 
menu (the pop-up control to the right of the Bin List button) to filter out all but a single 
color of bin.

Using Color Tag filtering to isolate the red bins

To go back to seeing all available bins, choose Show All from the Color Tag Filter pop-up.

Sorting the Bin List
The Bin list (and Smart Bin list) of the Media Pool can be sorted by bin Name, Date Created, or 
Date Modified, in either ascending or descending order. Simply right-click anywhere within the 
Bin list and choose the options you want from the Sort by submenu of the contextual menu.

You can also choose User Sort from the same contextual menu, which lets you manually drag all 
bins in the Bin list to be in whatever order you like. As you drag bins in this mode, an orange line 
indicates the new position that bin will occupy when dropped.
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Dragging a bin to a new position in the 
Bin list in User Sort mode

If you use User Sort in the Bin list to rearrange your bins manually, you can switch back and 
forth between any of the other sorting methods (Name, Date Created, Date Modified) and 
User Sort and your manual User Sort order will be remembered, making it easy to use whatever 
method of bin sorting is most useful at the time, without losing your customized 
bin organization.

Filtering Clips With Audio in the Fairlight Page
The Media Pool in the Fairlight page has one additional feature: the ability to filter out audio-
only clips, or clips with audio, in the currently selected bin. This makes it easy for you to find 
audio clips that you’re looking for, which are hidden along with lots of video clips in the same 
bin. To use this feature, click the Option menu of the Media Pool and choose Show All Clips, 
Show Audio Only Clips, or Show Clips With Audio. 

The Media Pool filter options in the option menu

Searching for Content in the Media Pool
An optional Search field can be opened at the top of the Media Pool that lets you quickly find 
clips by name, partial name, or any of a wide variety of Media Pool metadata. 

To search for a clip by name:
1	 Select which bin or bins you want to search.

2	 Click the magnifying glass button at the upper right-hand corner of the Media Pool.

3	 Choose the particular column of information you want to search (or All Fields to search 
all columns) using the Filter by pop-up menu. Only selected bins will be searched.

4	 Type your search string into the Search field that appears. A few letters should be 
enough to isolate only those clips that have that character string within their name. 
To show all clips again, click the cancel button at the right of the search field.

TIP: Smart Bins are essentially multi-criteria search operations that scope the entire 
project at once and are saved for future use.

Chapter – 123  Using the Fairlight Page 2424



Taking Advantage of the Media Pool’s Usage Column
In List view, the Usage column does not automatically update to show how many times a 
particular clip has been used. However, you can manually update this metadata by right-clicking 
within the Media Pool and choosing Update Usage Data from the contextual menu that 
appears. Afterwards, each clip will display how many times it’s been used in this column. Clips 
that have not been used yet display an x.

Effects Library
The Effects Library on the Fairlight page displays both the built-in FairlightFX audio plug-ins that 
accompany DaVinci Resolve on macOS, Windows, and Linux, as well as whatever Audio FX are 
available on your workstation. 

�� FairlightFX are built-in audio processing effects that are fully cross-platform on all 
platforms DaVinci Resolve supports. 

�� On macOS and Windows, DaVinci Resolve supports the use of third-party VST audio 
plug-ins. 

�� On macOS, DaVinci Resolve supports Audio Unit (AU) audio plug-ins. 

Once you install third-party effects on your workstation, they appear in this panel of the Effects 
Library alongside the FairlightFX that are always available. Audio plug-ins let you apply effects 
to audio clips or entire tracks worth of audio, to add creative qualities such as echo or reverb, or 
to take care of mastering issues using noise reduction, compression, or EQ.

The Effects Library

Similar to the Media Pool, the Effects Library’s Bin list can be opened or closed using a button 
at the top left.
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Effects Library Favorites
You can click on the far right of any transition, title, or generator to flag that effect with a star as 
a favorite effect. When you do so, the favorited effects appear in a separate Favorites area at 
the bottom of the Effects Library Bin list.

Stars indicate a flagged favorite effect, all favorites are currently filtered

ADR
The Fairlight page of DaVinci Resolve has a sophisticated interface for doing ADR, or 
automated dialog replacement, in a structured and straightforward manner. Simple yet powerful 
cue list management, industry-standard audio beeps and visual cues, and sophisticated take 
management with star ratings and layered take organization help you manage the resulting 
recordings to use the best parts of each take in your program.

When open, the ADR interface consists of three panels to the left of the Timeline: a Record 
panel, a List panel, and a Setup panel. The controls of these panels are described in the order 
in which they’re used.

The Setup Panel
As its name implies, the Setup panel is where you configure your ADR session. It presents the 
controls letting you set up which audio input you want to use and what tracks to listen and 
record to, as well as preferences governing what the actors will see on the display you output 
video to, to help them keep their performance in sync.

The Setup panel of the ADR interface
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The List Panel
This is where you create a list of cues you need to re-record, either from within the Fairlight 
page, or imported from a .csv file that someone provides you. It presents controls for adding, 
editing, importing, and exporting cues that you want to record.

The List panel of the ADR interface

The Record Panel
This is where you actually run the ADR recording session you’ve set up, using the dialog cues 
you’ve put into the Cue list. It presents controls for displaying and selecting which cues to 
record, previewing and initiating recording, and adding metadata to rate the different takes 
you’ve recorded and to keep track of which cues have been completed.

The Record panel of the ADR Interface

For more information on using the VO panel, see Chapter 127, “ADR.”
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Sound Library Browser
A Sound Library panel is available from the Interface toolbar for browsing sound effects libraries 
that you have available to you, on your system or on a SAN you’re connected to. It includes the 
capability of scanning specified file paths to catalog available sound files and their metadata, 
storing this data within the currently selected project database (or another database that you 
select) to use when searching for the perfect sound effect within your library. Once you’ve 
cataloged your sound effects collection, it’s easy to search for sounds, preview what’s been 
found in the list, and edit the one you like best into the Timeline.

The Sound Library panel

The Sound Library panel has the following controls:

�� List display controls: The Sound Library title bar has controls for sorting the sound 
effects list, showing it in List or Icon view, and an Option menu with various other 
settings and commands.

�� Search field: Enter a term into the search field to look for sound effects files using 
that metadata. A pop-up menu to the right lets you search the database by name or 
description metadata.

�� Library controls: Clicking the Library button (to the right of the Search field) reveals a 
menu that lets you choose which database to use for searching (and cataloging) sound 
effects collections. Each PostgreSQL database can have a different catalog.
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Choosing a library to search

�� Preview and Audition controls: These controls let you preview and audition sound 
effects that you find as you look for the right one.

–– Clip name: The name of the current clip you’ve selected.

–– Next/Previous buttons: Two buttons let you select the next or previous sound effect 
clip in the Sound Effect list.

–– Zoom control: Controls the zoom level of the Playthrough waveform.

–– Duration field: Shows the duration of the current clip, or of the section of the clip 
marked with In and Out points.

–– Playhead timecode field: The timecode of the playhead’s position.

–– Navigation waveform: The waveform of the entire sound effect appears here, 
making it easy to jump to different parts of the selected clip. All channels are 
summed together in this display.

–– Playthrough waveform: A zoomed-in section of the selected clip that lets you see 
more waveform detail for setting In, Out, and Sync points.

–– Jog bar: Lets you scrub around the clip.

–– Transport controls: Stop, play, and Loop buttons let you control playback, although 
you can also use the space bar and JKL controls. Right-click the Stop button to 
switch it into “Stop and Go to Last Position” mode.

–– Marking controls: The Sync Point button lets you mark which frame of the sound 
effect you want to use to sync to a frame of the Timeline when you audition. In and 
Out points let you mark how much of the sound effect clip you want to edit into 
the Timeline.

–– Audition controls: The Audition button puts you into Audition mode where the 
currently selected sound effect clip appears at the position of the playhead in 
the currently selected Timeline track. Cancel and Confirm buttons let you choose 
whether you want to remove the clip from the Timeline and try again with another 
clip, or leave the sound effect clip in.

�� Sound Effect list: All sound effect clips that match the current search criteria appear in 
this scrollable list. Each item in the list shows its name, duration, channel mapping, and 
star ratings that you can customize.
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To catalog all audio files within a given file path:
1	 Open the Sound Library.

2	 (Optional) Click the Library button (to the right of the Search field), and select which 
PostgreSQL-based project database you want to save the resulting metadata analysis 
to using the Library pop-up menu that appears. The current database is selected 
by default. If you’re using a disk database instead, the top compatible PostgreSQL 
database in the list will be the default.

3	 Click the Option menu and choose Add Library. From the file dialog that appears, 
select the top-most directory of a file path that contains sound effects; if you’ve 
selected a directory with subdirectories inside, each subdirectory will be examined 
for content.

4	 Click Open.

A progress bar will show you how long the operation will take. When you’re finished, a 
dialog will appear letting you know how many clips were added to the current library.

To search for a specific sound effect and edit it into the Timeline:
�� Type a search term into the Search field. Optionally, you can click the Library button to 

the right of the search field, and use the Type, Duration, and Format pop-up menus to 
help limit your search.

All audio cues that include the search term in their file names will appear in a list below. 
Selecting an item on the list loads it into the preview player where you can play it or 
audition it in your timeline.

Auditioning clips you’ve found in the Timeline:
1	 Select a sound effect clip you’ve found from the list that you want to audition in 

the Timeline.

2	 Move the playhead to the part of the sound effect that you want to sync to, and click 
the Sync Point button to place a sync mark on that clip. For example, if you’re syncing a 
car door closing, you might sync to the peak of the “slam.”

3	 Set In and Out points to define the range of the sound effect you want to potentially 
use.

4	 Select a track you want to preview the sound effect in by clicking its track header or 
Mixer channel strip.

5	 Position the playhead at the place in the Timeline you want to align the sync mark in the 
sound library to.

6	 Click the Audition button in the Sound Library. That clip now appears, temporarily, in the 
Timeline, and you can play through that section of the Timeline to see how you like the 
sound effect in context with the rest of the mix.

7	 If you like the sound effect, click Conform to keep it in the Timeline. If you don’t, 
click Cancel.
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Index
The Index provides a handy interface for listing all of the clips in the current edit, all the tracks in 
the current timeline, and all the markers in the current timeline. Using these lists, multiple items 
can be selected, tracks can be managed, and marker notes can be consulted with ease. Each 
of these three categories of information is displayed in separate panels:

�� Tracks: Every track in the currently open timeline corresponds to a row of controls and 
information in this panel. From left to right, each track has a visibility control, a color 
control, a number, a name, a format, and a group that it belongs to.

The Tracks panel shows a row of information for each of the tracks in the Timeline

�� Markers: The markers panel can be displayed in either thumbnail or list mode. In 
thumbnails mode, each marker in your timeline corresponds to a thumbnail displaying 
the timecode of its location underneath it, and the color of the marker to the left of 
the timecode location. In list view, each marker displays a row with the following 
information; marker number, frame (showing a thumbnail), marker name, start timecode, 
end timecode, duration, marker color, and notes.

The Markers panel shows a row of information for each of 
the markers in the Timeline

Inspector
When you add an audio effect to a clip or a track, those effects appear in the Inspector when 
that clip or track is selected.
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Metadata Editor
Lets you view and edit the metadata of selected clips in the Fairlight page.

Oscillator for Generating 
Tone, Noise, and Beeps
The Fairlight page has a general purpose oscillator, the settings of which you can customize by 
choosing Fairlight > Oscillator Settings. This opens the Oscillator Settings window that you can 
configure to generate tones, noise, or beeps using five sets of controls:

�� Enable/Disable Oscillator toggle: Lets you turn the Oscillator on or off system-wide.

�� Frequency dial: Sets a custom frequency of oscillating tone, from 20 Hz to 10kHz. 
Defaults to 1kHz.

�� Level dial: Sets the output level for the tone or noise, from –50dB to +10dB. Defaults 
to –15 dB.

�� Frequency presets: Four buttons let you choose from four commonly used tones: 
100 Hz, 440 Hz, 1 kHz, and 2 kHz.

�� Noise type buttons: Two buttons let you choose from White noise or Pink noise.

You can set up the Oscillator to output whatever kind of tone or noise you require, and then 
patch it to tracks for recording tones, or patch it to audio outputs for calibrating speakers. If you 
use the beep options of the ADR panel, those are performed via the Oscillator.

To play the Oscillator out of your speakers:
1	 Choose Fairlight > Patch Input/Output to open the Patch Input/Output window.

2	 Choose Osc from the Source pop-up menu, and choose Audio Outputs from the 
Destination pop-up menu.

3	 At the left, click the button of what you want to output, Osc (Oscillator) or Noise.

4	 At the right, click the connected audio outputs that you want to patch to, and click 
Patch. Tone or noise should immediately start playing out of your configured speakers.

5	 To stop, select one of the patched buttons, and click Un-Patch.

To record a tone or noise from the Oscillator to an audio track:
1	 Choose Fairlight > Patch Input/Output to open the Patch Input/Output window.

2	 Choose Osc from the Source pop-up menu, and choose Track Input from the 
Destination pop-up menu.

3	 At the left, click the button of what you want to output, Osc (Oscillator) or Noise.

4	 At the right, click the connected audio outputs that you want to patch to, and click 
Patch. Close the Patch Input/Output window.

5	 Click the Arm Record (R) button in the track header of the track you patched the 
Oscillator to. If your Main is properly patched to your outputs, you should hear the tone 
or noise, and that track’s audio meter should immediately rise to the level being output 
by the Oscillator.

6	 Click the Record button of the transport controls to initiate recording of that tone to 
the patched track. Click the Stop button or press the Spacebar to halt recording when 
you’re done.
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Dual Monitor Layout
The Audio page has a dual monitor layout that provides maximum space for the mixer and 
audio meters on one screen and a full-screen timeline on the other.

To enter dual screen mode:
Choose Workspace > Dual Screen > On.

The Fairlight page in dual screen mode

To switch which UI elements appear on which monitors:
Choose Workspace > Primary Display > Display 1 or Display 2, which reverses the 
contents of both monitors in dual screen mode.
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Customizing the Fairlight Page
The default layout is quite efficient for a number of tasks on most displays. You can always 
return to the default layout by choosing Workspace > Reset UI Layout. However, the Fairlight 
page can be customized to create more room for specific areas of the interface to 
accommodate different tasks.

To resize any area of the Fairlight page:
Drag the vertical or horizontal border between any two panels to enlarge one and 
shrink the other.

To resize the height of individual audio tracks:
Move the pointer to the bottom border of any audio track header, and when it becomes 
a resize cursor, drag that border up or down to resize that track. Each track can have an 
independent size when you do this.

To resize any column of the Index: 
Move your pointer over the divider between any two columns and drag when the 
horizontal resize cursor appears.

To rearrange Index columns: 
Drag the header of any column to the left and right to move that column.

Undo and Redo in DaVinci Resolve
No matter where you are in DaVinci Resolve, Undo and Redo commands let you back out of 
steps you’ve taken or commands you’ve executed, and reapply them if you change your mind. 
DaVinci Resolve is capable of undoing the entire history of things you’ve done since creating or 
opening a particular project. When you close a project, its entire undo history is purged. The 
next time you begin work on a project, its undo history starts anew.

Because DaVinci Resolve integrates so much functionality in one application, there are three 
separate sets of undo “stacks” to help you manage your work.

�� The Media, Edit and Fairlight pages share the same multiple-undo stack, which lets you 
backtrack out of changes made in the Media Pool, the Timeline, the Metadata Editor, 
and the Viewers.

�� Each clip in the Fusion page has its own undo stack so that you can undo changes you 
make to the composition of each clip, independently.

�� Each clip in the Color page has its own undo stack so that you can undo changes you 
make to grades in each clip, independently.

In all cases, there is no practical limit to the number of steps that are undoable (although there 
may be a limit to what you can remember). To take advantage of this, there are three ways you 
can undo work to go to a previous state of your project, no matter what page you’re in.
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To simply undo or redo changes you’ve made one at a time:
�� Choose Edit > Undo (Command-Z) to undo the previous change.

�� Choose Edit > Redo (Shift-Command-Z) to redo to the next change.

�� On the DaVinci control panel, press the UNDO and REDO buttons on the T-bar panel.

TIP: If you have the DaVinci control panel, there is one other control that lets you 
control the undo stack more directly when using the trackballs, rings, and pots. 
Pressing RESTORE POINT manually adds a memory of the current state of the grade to 
the undo stack. Since discrete undo states are difficult to predict when you’re making 
ongoing adjustments with the trackball and ring controls, pressing RESTORE POINT 
lets you set predictable states of the grade that you can fall back on.

You can also undo several steps at a time using the History submenu and window. At the time 
of this writing, this only works for multiple undo steps in the Media, Edit, and Fairlight pages.

To undo and redo using the History submenu:
1	 Open the Edit > History submenu, which shows (up to) the last twenty things you’ve 

done.

2	 Choose an item on the list to undo back to that point. The most recent thing you’ve 
done appears at the top of this list, and the change you’ve just made appears with a 
check next to it. Steps that have been undone but that can still be redone remain in this 
menu, so you can see what’s possible. However, if you’ve undone several changes at 
once and then you make a new change, you cannot undo any more and those steps 
disappear from the menu.

The History submenu, which lets you undo several steps at once

Once you’ve selected a step to undo to, the menu closes and the project updates to show you 
its current state.
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To undo and redo using the Undo window:
1	 Choose Edit > History > Open History Window.

2	 When the History dialog appears, click an item on the list to undo back to that point. 
Unlike the menu, in this window the most recent thing you’ve done appears at the 
bottom of this list. Selecting a change here grays out changes that can still be redone, 
as the project updates to show you its current state.

 The Undo history window that lets you browse 
the entire available undo stack of the current page

3	 When you’re done, close the History window.
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Chapter 124

Setting Up 
Tracks, Buses, 
and Patching

One of the first things you need to do when you’re setting up a new 
project for mixing in the Fairlight page is to define all of the audio tracks 
and buses you’re going to need, including submixes and mains that route 
and combine the audio being output. This chapter covers how to create 
audio tracks, and how to use buses to manage your mixes in the most 
efficient possible way.
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Audio Tracks
Each audio track in a Resolve timeline corresponds to a single channel strip on the Mixer’s left 
side. Depending on how an audio track has been configured, each audio track is assigned a 
specific audio format such as stereo, LCRS, 5.1 surround, or 7.1 surround, so that multiple audio 
channels within the clips on that track can be correctly routed to the proper audio output for 
monitoring and rendering via the lanes that can be seen within each track on the 
Fairlight timeline.

Audio tracks in DaVinci Resolve have been designed to contain multiple channels of clip audio 
within a single track, but how those individual audio channels are displayed depends on the 
page. The Edit page hides these individual audio channels, displaying only a single clip in the 
timeline to make it easier to edit multi-channel sources without needing to manage a huge 
number of tracks. However, the Fairlight page has a unique track and lane system for 
displaying audio. 

The Fairlight page displays the same number of tracks as the Edit page, but each track on the 
Fairlight page is divided into lanes, which expose each individual channel of clip audio for 
editing and mixing.

(Top) Stereo audio in the Edit page represented by a single track; (Bottom) The same stereo audio in the Fairlight 
page shows the two lanes that correspond to each of the stereo audio tracks
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Now that you understand how tracks work on the Fairlight page, the next important concept 
you need to understand in order to unlock the power of the Fairlight page is the audio bus, 
which lets you combine multiple audio tracks in different ways.

What Is a Bus?
In audio postproduction, a bus is essentially a destination channel to which you can route 
multiple audio feeds (typically the audio tracks in the timeline) so they are mixed together into a 
single signal that can be controlled via a single channel strip.

For example, if you have five audio channels into which have been edited all of the dialog audio 
clips for a particular program, you can route the output of all five dialog tracks to a Submix bus, 
which combines them so that all dialog can then be mixed with a single set of controls.

There are multiple levels of busses. For example, individual tracks can be routed to Submix 
busses, as described above. Additionally, multiple Submixes can be routed to one or more 
Mains. For example, you could have four submix busses, one for German dialog, one for English 
dialog, one for Music, and one for Effects. You could route the German, Music, and Effects 
submix busses to Main 1 for the German version of the program, and route the English, Music, 
and Effects submix busses to Main 2 for the English language version of the program.

Audio tracks from the timeline are routed to buses via each channel strip’s multiformat surround 
panner, so buses are configured to accommodate specific audio formats such as stereo, LCRS, 
5.1 surround, or 7.1 surround. 

Types of Buses
There are four types of busses in DaVinci Resolve.

Mains
Main busses are typically the primary output of a program; each new project you create starts 
out with a single Main called M1, to which all tracks are routed by default. You can add 
additional Mains, and you can use them however you like, as either full or partial mixes of the 
program you’re working on. Mains can be directly output in the deliver page.

Sub (Submix)
Sub busses are often the means by which multiple tracks of audio that belong to the same 
category (dialog, music, effects, ambience, and so on) are combined together so that 
everything in that category can be mixed as a single audio signal. Multiple Sub busses can be 
themselves routed to Main busses, or they can be directly output in the deliver page.

Aux (Auxillary)
Each channel strip includes the ability to expose up to 12 auxiliary bus sends, which are 
typically used to route audio to software or hardware effects of some kind. Typically, an audio 
signal is sent to the effect (or hardware) applied to that bus and then is routed back to the 
channel it came from. Auxiliary send signals can be connected either immediately before or 
after a channel strip’s fader, based on a Pre setting. Each auxiliary bus can also be configured 
to accommodate specific audio formats such as stereo, LCRS, 5.1 surround, or 7.1 surround.

Multi Track
Multitrack buses provide bus paths for combining feeds that you want to re-record to disk, or 
route to other I/O.
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Buses in Nested Timelines
When you nest a timeline inside of another timeline that has buses set up for mixing in the 
Fairlight page, all Sub and Aux routings work as intended within the nested timeline, which 
exposes all channels of Main 1 in the enclosing timeline. In this sense, the audio of the nested 
timeline can be considered to be a submix that outputs its resulting audio to the audio track it’s 
edited onto.

Controlling Signal Flow
The process of setting yourself up for editing and mixing in the Fairlight page involves: 

�� First, customizing the tracks of the timeline to be organized and configured as required.

�� Second, creating the busses you need in order to organize your signal flow.

�� Third, patching the tracks to Subs, and the Subs to Mains, in order to create the signal 
flow you need.

Managing Audio Tracks
When you’re getting ready to record or edit audio clips into the Fairlight Timeline, you need to 
make sure you’ve got enough tracks to do the job. The following procedures cover the different 
methods available for adding, removing, and rearranging tracks as you work. These commands 
are all available via the contextual menu that appears when you right-click anywhere in the 
Timeline header area (the header of the Timeline is the area to the left where each track’s 
various buttons and controls are located).

Defining Timeline Audio Track Channels at Creation
If you decide to create a new audio track, you have to choose what kind of audio track it will be. 
Right-clicking in the bottom audio portion of the Timeline track header reveals a contextual sub-
menu that lets you create different kinds of audio tracks.

�� Mono: Holds a single channel with only one lane.

�� Stereo: Holds stereo left and right channels, with two lanes.

�� 5.1: Holds the six channels corresponding to a 5.1 surround mix, for a total of six lanes. 
For broadcast, SMPTE specifies Left, Center, Right, Left Surround, Right Surround, and 
LFE. For cinema distribution these tracks are ordered Left, Right, Center, LFE, Surround 
Left, and Surround Right.

�� 7.1: Holds the eight channels corresponding to a 7.1 surround mix, for a total of eight 
lanes. For broadcast, SMPTE specifies Left, Center, Right, Left Surround, Right 
Surround, LFE, Back Surround Left, and Back Surround Right. For cinema distribution 
these tracks are ordered Left, Right, Center, LFE, Left Surround, Right Surround, Back 
Left Surround, and Back Right Surround.

�� Adaptive: Capable of holding up to 24 audio channels, which would display up 
to 24 lanes within the track. An adaptive audio track can hold clips with different 
combinations of channels, up to the maximum number of channels allowed within 
that track. The number of channels allowable on a particular Adaptive track is user-
definable (1–24) at the time that track is created. If you edit a clip with more channels 
into an Adaptive track that was created to hold fewer channels, the extra clip channels 
are muted.
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Creating Tracks
There are two commands with which to create new audio tracks, and both are in the contextual 
menu found by right-clicking within any audio track’s header controls. Add Track adds a single 
audio track of the type you choose from a submenu. Add Tracks lets you insert as many tracks 
as you like, of a type and at a position you designate using the Add Tracks dialog.

Rearranging Tracks
You can rearrange tracks by right-clicking in a track’s header area and choosing either Move 
Track Up or Move Track Down in the contextual menu that appears.

Changing How Many Channels an Audio Track Has
If you had set up your timeline with one kind of audio track, but you discover you actually need 
a different kind, you can change any audio track’s type at any time. Just right-click anywhere in 
that audio track’s timeline header, and choose an option from the Change Track Type To 
submenu of the contextual menu.

Deleting Tracks
Right-click within a track’s Timeline header and choose Delete Track. If there are clips on a 
track you remove, they are also deleted from the Timeline, but preserved in the Media Pool.

Linked Groups of Mono Tracks
Linked groups are an organizational construct that you can create using mono tracks (other 
kinds of tracks such as stereo, 5.1, 7.1, or Adaptive cannot be used in a Linked Group). Unlike a 
multi-channel track with lanes, a linked group of mono tracks functions as five independently 
editable tracks in the Timeline. However, each track is mapped just like an audio channel using 
one of the standard multi-channel mappings (stereo, 5.1, 7.1, Adaptive), and linked groups of 
mono tracks are mixed using only a single channel strip.

Linked groups are extremely useful when you’ve been given a set of six independent audio 
files that need to be assembled as a single surround mix, or when you have surround channels 
that need to be specifically re-edited on a channel by channel basis.

To create a Linked Group:
1	 Create two or more Mono audio tracks that you want to group together. If you need 

to create a linked group with a specific channel mapping, such as 5.1, make sure you 
create enough tracks (in this case, 6).

2	 Choose Fairlight > Link Group.

3	 When the Link Group dialog appears, Mono audio tracks are represented by active 
buttons (all other channel mapped tracks are disabled, since they can’t be linked). Click 
to enable the button of every track you want to include in the group you’re about to 
create. Which mappings are available to use for creating your group depends on how 
many tracks you’ve selected.

Selecting six tracks to use for creating a link group
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4	 After you’ve selected all the tracks you need to, click one of the available “Link as” 
buttons below. In this example, six tracks have been selected, so you could click 5.1 
Film or 5.1.

When you select enough tracks, you can create 
groups linked as specific surround mappings

Afterwards, the tracks you selected should turn into a single block, showing they’ve 
been linked.

When you select enough tracks, you can create groups linked as specific surround mappings

5	 Close the Link Group window when you’re finished.

Once you’ve created a linked group, the mono tracks in the timeline that you linked 
appear with a bar to the left in the track header that spans every track that’s linked. 
If the tracks are tall enough, they’ll also be labeled to identify which track corresponds 
to which surround channel, L, R, C, Lfe, Ls, Rs, and so on. At this point, you can edit 
each channel of a surround mix into the appropriate track.

Tracks in a Linked Group are labeled to 
identify which track corresponds to which 
surround channel

If necessary, you can also unlink a linked group to turn it back into independent mono tracks.
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To unlink a Linked Group:
1	 Choose Fairlight > Link Group.

2	 When the Link Group dialog appears, select the Linked Group you want to unlink.

3	 Click Unlink.

4	 Close the Link Group window when you’re finished.

Creating Buses
Choosing Fairlight > Bus Format opens the Bus Format window, which lets you create as many 
busses as you need (up to the limitations of your system) to organize the tracks and channels of 
your program.

The Bus Format window lets you add busses to the mixer

Four buttons at the top of the window let you create any type of bus Fairlight supports. Creating 
a new bus, whether it’s a Main, Sub, Aux, or Multi Track, adds the new bus to the list that 
appears below.

The Bus list lets you rename the bus, choose the format of each bus (a pop-up menu appears in 
the Format column of each entry of the list), and color-code each bus (a Color pop-up lets you 
choose that bus’s color). Simply click any item on the Bus list to select it, and choose different 
options from the Format and Color pop-up menus, or click on the User Name of any bus to 
select it, and type a custom name.

At the bottom of the list are two additional buttons that let you Duplicate or Remove selected 
Buses. When you’re done modifying the available busses, you can click OK to accept the 
change and close the Bus Format window, Cancel to close the window (although any busses 
you’ve made remain in place), or Bus Assign to open the Bus Assign window.
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NOTE: Text at the upper left-hand corner of the window lets you know how many 
buses you’re using out of how many your workstation will support.

Assigning Buses
Once you’ve created one or more busses, you’ll want to assign different tracks to specific 
busses, and different Subs to specific Mains. This is accomplished in the Bus Assign window, 
which you can open by choosing Fairlight > Bus Assign, or by clicking the Bus Assign button in 
the Bus Format window.

The Bus Assign window lets you choose which tracks are connected to which 
busses, and which busses are connected to which mains

The top shows all of the available Main, Sub, and Multi Track busses, while the bottom shows all 
available tracks, Sub busses, and Aux busses. The Bus Assign window defaults to Icon view, in 
which each Bus and Track is shown as a button, but it can be switched to List view, in which the 
Available Tracks section is shown as a list.

Methods of making bus assignments:
�� To assign specific tracks to a bus: Click a button in the Buses section to select that 

bus, and then either click or drag a bounding box over all the available tracks that you 
want to assign to that bus. Once assigned, the Available Tracks buttons display which 
Bus they’ve been assigned to.

Assigning multiple tracks to a bus by dragging a bounding box
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�� To assign every track, Sub, and Aux to a bus: Click a button in the Buses section to 
select that bus, and then click Assign All.

�� To clear all track assignments from a particular bus: Click a button in the Buses 
section to select that bus, and then click Unassign All.

When you’re done making bus assignments, click Save.

Patching Signal Paths
While bus creation and assignment is a straightforward way of creating a cascade of routing 
from tracks to Subs to Mains, sometimes you need to create more specific signal paths. For 
example, if you need to record audio to a track, you need to patch the audio input you want to 
record from to the track you want to record to. This, and many other scenarios, are 
accomplished using the Patch Input/Output window.

Using the Patch Input/Output Window
Choosing Fairlight > Patch Input/Output opens the Patch Input/Output window, which can be 
displayed in either Icon or List view. This window is split into two halves, with the left half 
containing whichever Audio Source controls you choose, and the right half containing 
whichever Audio Destinations you choose. In the following screenshot, the Audio Inputs from a 
Scarlett2i2 USB audio interface are shown, while the available Track Inputs are shown to 
the right.

The Patch Input/Output Window showing Audio Inputs and Track Inputs

Creating a Patch
By default, the Patch Input/Output window shows the available Audio Inputs as the Source, and 
the Track Inputs as the destination. This makes it easy to patch whatever audio source (such as 
a microphone connected to a USB audio interface) to a specific audio track of the timeline to 
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prepare for recording. Patching and unpatching a source to a destination is straightfoward.

To patch a source to a destination:
1	 Choose a type of source from the Audio Source pop-up menu at the upper left-hand 

side of the window.

2	 Click the button or list item of the source you want to patch on the left side of the Patch 
Input/Output window.

3	 Choose a destination from the Audio Destination pop-up menu at the upper right-hand 
side of the window.

4	 Click the button or list item of the destination you want to patch on the right side.

A selected audio source and audio destination pair

5	 Click the Patch button at the bottom right of the window. The source and destination 
will both display the connection they’re patched to.

To unpatch a source and destination pair:
1	 Click a button or list item corresponding to a source or destination you want to unpatch.

2	 Click Unpatch.

Choosing Audio Source and Destination Controls
The Audio Source and Destination pop-up menus let you choose different categories of source 
and destination controls to patch together.

The following Audio Source options are available:
�� Audio Inputs: The available physical audio inputs on your workstation, for example SX-

36, MADI, or system audio. Useful when patching to record audio.

�� Track Repro: Short for Reproduction, this is the signal from the track playback, before 
any processing

�� Track Send: Track Insert send

�� Track Direct: Track Direct Out, can be pre or post the track fader, with an offset

�� MT-Bus Dir: Multitrack Bus Direct Out, can be pre or post the multitrack bus master 
fader, with an offset

�� MT-Bus Out: Multitrack Bus Out, always post the Multitrack bus master fader

�� Aux-Bus Send: Aux bus master insert send

�� Aux-Bus Dir: Aux Bus Direct Out, can be pre or post the Aux bus master fader, with an 
offset

�� Aux-Bus Out: Aux Bus Out, always post the Aux bus master fader

�� Sub-Bus Send: Sub bus master insert send
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�� Sub-Bus Dir: Sub Bus Direct Out, can be pre or post the Sub bus master fader, with an 
offset

�� Sub-Bus Out: Sub Bus Out, always post the Sub bus master fader.

�� CR-Mon Dir: Monitor system Direct out. Post fold up/down matrix, pre the Monitor 
VolumeLevel/Dim/Mute

�� CR-Mon Out: Monitor system output. Post fold up/down matrix and Monitor 
VolumeLevel/Dim/Mute

�� Main Send: Main bus master insert send

�� Main Dir: Main Bus Direct Out, can be pre or post the Main bus master fader, with an 
offset

�� Main Out: Main Bus Out, always post the Main bus master fader

�� Osc: Oscillator outputs. Sine, Pink noise, White noise.

�� Solo Out: AFL and PFL Solo Bus Out, always post the respective bus master fader

The following Audio Destination options are available:
�� Track Input: Input to the Record and Thru path; simply put, the available audio tracks in 

the current timeline.

�� Track Return: Track insert return

�� Aux-Bus Return: Aux Bus master insert return

�� Sub-Bus Return: Sub Bus master insert return

�� Main Return: Main Bus master insert return

�� CR-Mon In: Input to the Monitor system’s fold up/down matrices

�� Talk Back: The Talkback system, showing Comm1 and Comm2

�� Audio Outputs: The available physical audio outputs on your workstation, for example 
SX-36, MADI, or system audio.

Using a Channel Strip’s Input Menu
The Input pop-up menu at the top of each track’s channel strip in the mixer provides some 
shortcuts for patching different inputs and buses to the tracks of your mix. Each option in this 
menu makes the Patch Input/Output window appear with different Audio Source and Audio 
Destination selections automatically set up.

Input
The Patch Input/Output window appears set up to let you patch different inputs (such as the 
system audio input) to the tracks of the timeline. This makes it fast for setting up audio inputs in 
preparation for recording.

Aux Bus
A shortcut to open the Patch Input/Output window (discussed previously in this chapter), which 
appears set up to let you patch different Aux buses to specific submix and timeline 
track channels.

Sub Bus
A shortcut to open the Patch Input/Output window (discussed previously in this chapter), which 
appears set up to let you patch different Sub (submix) bus channels to specific timeline 
track channels.
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Main Bus
A shortcut to open the Patch Input/Output window (discussed previously in this chapter), which 
appears set up to let you patch different Main bus channels to specific timeline track channels.

Path Settings
Choosing Path Settings opens the Path Settings window for that track. This window contains 
controls for adjusting the input level of audio signals being input via a BMD input/output device.

The Path Settings window showing audio inputs and track inputs

These parameters control the following:

�� Mic/Instr.: Adjusts the Mic/Instrument level for this source, from 0 to 100 dB.

–– On: Enables Microphone/Instrument level for this source.

–– 48V: Enables phantom power for that input.

�� Record Level: Controls the level going to the disk before recording. It does not affect 
the track when in Thru mode.

–– Rec: Enabling this button makes this track ready to record. Only turn this on if there 
is an audio source patched to the current track.

–– Thru: When on, this makes the affected track into the equivalent to a live feed. When 
enabled, this track will monitor its input, but will not respond to a record command. 
Only turn this on if there is an audio source patched to the current track.

�� Trim: This parameter controls the level as the channel enters the mixer. For timeline 
tracks, this controls the signal coming from disk, and does not affect any current levels 
being recorded.

�� Direct Output: Controls the level going from this channel to the direct output.

–– On: Toggles direct output on and off.

–– Pre: Toggles the direct output to connect either pre or post the main channel fader.

�� Insert: Controls the insert return only. When enabled, the channel connects to its insert 
return, otherwise the Channel connects to the straight-through path. The insert send, 
on the other hand, is always active (though it must be patched somewhere before it can 
be heard). 

NOTE: Insert sends and returns are only audible if patched to physical outputs or 
inputs, or to other paths. Sends can be sent to the input of any path in the system, and 
returns can come from the output or send of any path. This is done in the Patch I/O 
screen (press the Patch I/O button).
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Chapter 125

Transport 
Controls, Timeline 
Navigation, and 
Markers

The Fairlight page has unique transport control, zooming, and scrolling 
options not found in the other pages of DaVinci Resolve that help you to 
work with audio more efficiently. This chapter covers how to get around 
the Fairlight version of the Timeline.
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Transport Controls and JKL Navigation
Because of the Fairlight page’s audio-focused workflow, the transport and playback controls 
differ from those found in the Media, Edit, Color, and Deliver pages.

Transport Controls

Fairlight page transport controls

The Fairlight transport controls are also designed to mirror their counterparts on the Fairlight 
control panels. They include the following functions:

�� Rewind and Fast Forward: Initiates accelerated playback through the Timeline in either 
direction. Pressing either of these buttons multiple times speeds up this motion, cycling 
through 8x, 24x, 60x, 150x, and 360x play speeds.

�� Play: Plays forward. Identical to pressing the Spacebar or L keys while playback is 
stopped.

�� Stop: Stops playback. Identical to pressing the Spacebar or K keys while playback is 
engaged.

�� Record: Initiates recording if you have an audio source patched to a track, and if that 
track is enabled for recording. For more information about recording, see Chapter 126, 
“Recording.”

�� Loop: Toggles looped playback off and on. While looped playback is on, playback 
will loop at the end of the Timeline, and will also loop when you use the Play In to Out 
command, and will continue to loop automatically until you stop playback.

�� Automation controls: This button exposes the automation toolbar. For more information 
about recording automation, see Chapter 131, “Automation Recording.”

Using JKL to Control Playback
The JKL keyboard shortcuts are common to many editing applications, and experienced editors 
know these to be some of the most useful controls for playback and editing there are. Here’s a 
list of the many different ways you can use these three keyboard shortcuts to play through clips 
and timelines as you work.

J Plays 100% backward.

K Stops playback.

L Plays 100% forward.

Press J repeatedly Increases backward play speed each time you press J, for a range 
of fast-reverse speeds.

Press L repeatedly Increases forward play speed each time you press L, for a range of 
fast-forward speeds.

Shift-J Plays in fast reverse.
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Shift-L Plays in fast forward.

K+J Plays backward at slow motion (with slow motion audio playback).

K+L Plays forward at slow motion (with pitch-corrected audio playback 
on OS X).

Pressing K while tapping J Moves the playhead back one frame.

Pressing K while tapping L Moves the playhead forward one frame.

If you’re using Fairlight with the keyboard, then this will probably become one of the main ways 
you move the playhead around in DaVinci Resolve.

Dragging the Playhead to Scrub
You can also drag the playhead left and right to scrub through the visible area of the Timeline 
by clicking and dragging anywhere within the Timeline ruler at the top of the Timeline, directly 
below the toolbar. If you’re zoomed in at a reasonable level for editing, scrubbing the playhead 
using your pointer will result in smooth, tape-like slow and fast audio playback, giving you a 
great deal of precision while trimming audio.

Looping Playback
Two controls govern looping on the Fairlight page, similarly to how looping works on the 
Edit page.

�� Loop: Command-Forward Slash (/). Toggles looped playback off and on. While 
looped playback is on, playback initiated with any of the following commands will loop 
automatically until you stop playback.

�� Play In to Out: Option-Forward Slash (/). If you’ve marked a section of a clip or timeline 
with In and Out points, this command lets you preview how it will play.

Loop Jog Scrubbing
Currently available only on the Fairlight page, choosing Timeline > Loop Jog enables a brief 
sample preview to be heard while scrubbing the playhead through the Timeline. This can make 
it easier to recognize bits of dialog or music as you’re quickly scrubbing through tracks, in 
situations where you’re trying to locate specific lines or music cues. It also enables this brief 
sample preview to loop endlessly when you hold the playhead on a frame, so you can pause 
while scrubbing and hear (by default) the current 80 ms prior to the playhead as it loops.

A pair of settings in the User Preferences let you customize this behavior. 

�� Loop Jog Alignment: Three options let you choose whether you loop audio Pre 
the position of the playhead, Centered on the playhead, or Post the position of the 
playhead.

�� Loop Jog Width: A field lets you choose how many milliseconds of audio to loop 
when Loop Jog is enabled. How many milliseconds of audio corresponds to one 
frame depends on the frame rate of the video. For example, at a frame rate of 25 fps, 
there are 1000/25 = 40 ms per frame, so the default value of 80 ms equals two frames 
of˛looping.
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Moving the Playhead Using Timecode
You can use absolute or relative timecode entry to move the playhead in the Timeline. 
Timecode entry lets you move the playhead very precisely or jump to specific timecode values 
really quickly.

How to Enter Timecode Values
When entering timecode, type each pair of hour, minute, second, and frame values from left to 
right, with a period representing a pair of zeros for fast entry. The numbers you enter appear in 
the timecode field at the upper left-hand corner of the Viewer with focus. When you’re finished 
typing, press the Return key to execute the timecode command. The rules for timecode entry 
are as follows:

�� The right-most pair of timecode values (or period) you enter is always the 
frame number.

�� A period to the left or to the right of any number you type is considered to be a 
pair of zeroes. 

�� A single period between two numbers is considered to either be a single zero 
or ignored if it’s between two pairs of numbers.

�� Any untyped pairs of values to the left of what you enter are assumed to be whatever 
those values were prior to the timecode you entered; this makes it easy to type partial 
timecode values even when the Timeline starts at hour one. 

�� It’s not necessary to enter colons or semicolons. 

Absolute Timecode Entry
Absolute timecode is entered simply by typing the timecode value you want to move the 
playhead to, and when you press the Return key, the playhead will move to that timecode value.

Here are some examples of absolute timecode entry using this method:

Original TC Value User-Typed Value New TC Value

01:10:10:10 15245218 15:24:52:18

01:10:10:10 2.. 01:02:00:00

01:10:10:10 15 01:10:10:15

01:10:10:10 12 01:10:10:12

01:10:10:10 1.2 01:10:01:02

01:10:10:10 1115.. 11:15:00:00

01:10:10:10 23... 23:00:00:00

Relative Timecode Entry
Relative timecode is entered by starting the timecode value with a plus (+) or minus (–). Adding 
a plus results in the value you type being added to the current timecode value for purposes of 
offsetting the playhead from its current position. Adding a minus will subtract the value you type 
from the current timecode value.

Chapter – 125  Transport Controls, Timeline Navigation, and Markers 2454



Here are three examples of  relative timecode entry:

User-Typed Value Result

+20. 00:00:20:00 is added to the current timecode value.

+3.. 00:03:00:00 is added to the current timecode value.

-5 00:00:00:05 is subtracted from the current timecode value.

Clip, Marker, and Track Navigation
As of Resolve 15, the Up and Down Arrow keys are used to move the playhead from one edit 
point to the next in the Fairlight page Timeline, just as in the Edit page Timeline. 

However, holding Command-Option down while using the Arrow keys gives you Fairlight 
page-specific behaviors that are used to navigate among clips, markers, and tracks in the 
Fairlight page in a way that’s different than other pages of DaVinci Resolve but very useful to 
the way the Fairlight page operates. This section covers the basics.

Selecting Tracks
Which tracks are selected determine the behavior of the Arrow keys.

�� In Selection mode: You can select tracks by clicking or Command-clicking (to select 
multiple tracks) anywhere in the background area or on the track number of the track 
headers. If you click and drag, you can use a bounding box to select multiple tracks.

�� In Range Selection mode: You can select tracks by clicking or Command-clicking 
anywhere either in the background area or on the track number of the track header, or 
in any unused area of the track itself in the Timeline. If you click and drag, you can use 
a bounding box to select multiple tracks.

Moving the Clip Selection
The Command-Option-Left and Command-Option-Right Arrow key shortcuts are used to move 
the playhead left and right in the Timeline, navigating from clip to clip or from marker to marker. 
How these keys function depends on whether or not one or more tracks is selected in 
the Timeline.

�� If no tracks are selected: The Left and Right Arrow keys will jump the playhead from 
Timeline marker to Timeline marker. Clip markers will be ignored.

�� If one or more tracks are selected: The Left/Right Arrow keys will jump the playhead 
among clip In points, clip Out points, and Timeline markers.

Moving the Track Selection
The Command-Option-Up and Command-Option-Down Arrow key shortcuts are used to move 
the track selection up and down in the Timeline, changing which tracks are selected. By 
changing which tracks are selected, you can alter which clip’s In and Out points are used to 
jump the playhead around the Timeline.

If no tracks are selected, then nothing happens.
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Zooming and Scrolling
The Fairlight page has several methods of zooming into and out of the Timeline, and scrolling 
when you’re zoomed to the point where your edited sequence of clips extends past the left and 
right edge of the visible timeline.

Setting the Zoom Level of the Timeline
Depending on how you like to work, there are several methods of zooming into and out of 
the Timeline.

�� Using the Vertical Zoom slider: A pair of sliders at the right of the toolbar let you 
zoom vertically and horizontally. The first one lets you scroll vertically in order to see 
more detail in the height of your waveforms. If no tracks are selected, then zooming is 
centered on the top audio track in the Timeline. If one or more tracks are selected, then 
zooming is centered on the topmost selected audio track.

�� Using the Horizontal Zoom slider: A pair of sliders at the right of the toolbar let you 
zoom vertically and horizontally. The second one lets you zoom horizontally in order 
to see more detail in the width of your waveforms. Zooming is always centered on the 
position of the playhead.

�� Pressing Command-Equal (=) and Command-Minus (–): Command-Equal (also referred 
to as Command-Plus) and Command-Minus let you zoom horizontally into the Timeline. 
Zooming is always centered on the position of the playhead.

�� Using scroll controls of your pointing device to scroll horizontally: Holding the Option 
key down and using the scroll wheel (or scroll control) of your pointing device will zoom 
horizontally into the Timeline.

�� Using scroll controls of your pointing device to scroll vertically: Holding the Shift 
key down and using the scroll wheel (or scroll control) lets you zoom vertically in 
the Timeline. In this case, if no tracks are selected, then zooming is centered on the 
top audio track in the Timeline. If one or more tracks are selected, then zooming is 
centered on the topmost selected audio track.

�� Using the Fairlight panel’s Jog/Edit wheel: If you have a Fairlight panel, you can hold 
the ZOOM button down while turning the Jog/Edit wheel to zoom into the Timeline at 
the position of the playhead.

Scrolling Through the Timeline
However closely you’re zoomed into the Timeline, if you’re zoomed enough so that clips extend 
past the visible area of the Timeline, scroll bars appear below. If the playhead is offscreen, a 
small orange tic mark indicates its position relative to the entire timeline, which is represented 
by the total width of the scroll bar’s background.

If you drag the playhead, or otherwise use any of the transport controls or playback key 
shortcuts to move through the Timeline, the contents of the Timeline refresh every time the 
playhead hits the left or right edge of what’s visible.
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Using Flags
Flags are meant to mark an entire clip, and they also flag every other clip in the Timeline that 
shares the same Media Pool source clip, making this a handy way of quickly identifying which 
clips in a given timeline come from the same Media Pool source. Flags are visible in every page 
of DaVinci Resolve, making them an excellent method of tracking media from page to page.

The Flag and Marker buttons and pop-ups.

You can apply multiple flags to clips, with a variety of colors to choose from. In addition to 
flagging specific media files, flags can be useful for sorting by column in the Media Pool, as well 
as a variety of other operations.

Methods for flagging clips in the Fairlight page:
�� To flag a clip: Select one or more clips, and either click the Flag button to flag that 

clip with the current color, or click the Flag pop-up in the toolbar to choose a different 
color and then click the Flag button. In the Edit page, flags appear in the Timeline 
superimposed in the name bar of each clip.

�� To remove all flags from a clip: Select one or more clips with flags you want to remove, 
then click the Flag pop-up in the toolbar, and choose the top “Clear All” option. 

Using Markers
Markers are used to call attention to a particular frame within a specific clip. Markers can be 
individually colored, and can have customized name and note text. Whenever you enter text 
into a marker, that marker displays a small dot that indicates there’s more information inside of it. 
Once placed, markers snap to In and Out points, edit points, the playhead, and other markers 
whenever snapping is enabled, making it easy to use markers to “measure” edits and trims that 
you make in the Timeline. Markers are visible in every page of DaVinci Resolve, making them an 
excellent method of tracking frames in clips and specific moments in the Timeline from 
page to page.

You can add markers to the Timeline (in the Timeline ruler) or to clips. The full procedures for 
placing and editing markers in the Fairlight page’s onscreen interface are identical to those for 
the Edit page, so for more information, see Chapter 24, “Marking and Finding Clips in the 
Timeline.” For now, here’s a summary.

Adding Markers to Clips
The following procedures describe how to add markers to clips in the Timeline of the 
Media page.
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To mark a clip in the Timeline, do one of the following: 
�� Select one or more clips you want to mark, then move the playhead to the frame of a 

selected clip in the Timeline, and click the Marker button in the toolbar (or press M) to 
place a marker at that frame, using the current color (if multiple overlapping clips are 
selected, you’ll add a marker to all clips). 

�� To place a marker during playback and immediately open the marker dialog to enter 
a name or note within it, select one or more clips you want to mark, play through 
the selection until you want to place a mark, then press Command-M. Playback 
pauses until you enter some text and close the marker dialog again, at which point 
playback continues.

�� Select one or more clips you want to mark, and then click the Marker pop-up to choose 
a different color, and click the Marker button.

Adding Markers to Timelines
You can also place markers of any color into the Timeline ruler to denote specific times for 
future reference, or add notes about issues you want to keep track of. You should note that all 
markers placed on clips or in the Timeline also appear within the Mini-Timeline of the Color 
page, making it easy to place notes to reference particular audio cues that might be valuable 
when editing or grading.

To mark the Timeline itself, make sure all clips are deselected, and do one of the following: 
�� Click the Marker button (or press M) to place a marker of the currently selected color in 

the Timeline ruler. 

�� To place a marker during playback and immediately open the marker dialog to 
enter a name or note within it, select one or more clips you want to mark, then press 
Command-M. Playback pauses until you enter some text and close the marker dialog 
again, at which point playback continues.

�� Click the Marker pop-up to choose a different color, and click the Marker button. 

�� Right-click in the Timeline ruler and choose a marker color from the Add Marker 
submenu of the contextual menu.
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Chapter 126

Recording

It’s possible to record to one or more tracks on the Fairlight page, 
accommodating workflows as varied as editors recording scratch 
voiceover or temp sound effects, recording engineers recording narration, 
ADR, or foley as part of the audio finishing process, music studios 
recording orchestras for the music score, or garage bands recording their 
latest magnum opus. While DaVinci Resolve is a comprehensive post-
production environment for cinema and video, the Fairlight page can be 
used for any audio recording application you might have, from books on 
tape to live music to feature films and television.

This chapter covers the somewhat brief basics of audio recording in the 
Fairlight page. Keep in mind that this is a work in progress, and that the 
comprehensive recording capabilities of earlier versions of Fairlight will be 
migrating into DaVinci Resolve as time passes.
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Setting Up to Record
Depending on how your workstation is set up, it’s possible to simultaneously record to multiple 
tracks in the Fairlight page at once. How many tracks you can record to depend entirely on 
what hardware you have available. This section describes the process of recording to tracks in 
the Fairlight page.

Patching Inputs
Before you can record anything, you need to use the Patch Input/Output window to patch an 
available audio input to a track. If you’re computer has nothing else, the inputs of your 
workstation are available to connect whatever audio device is set up as the default audio input 
on your system to the track you want to record to.

To open the Patch Input/Output window, do one of the following:
�� Choose Fairlight > Patch Input/Output.

�� Click the Input menu at the top of the channel strip of the track you want to record to, 
and choose Input.

The Input pop-up menu lets you open the Patch Input/
Output window with that track selected

To patch an audio source to an audio destination:
1	 Make sure that the Audio Source menu is set to Audio Inputs, and the Audio 

Destination menu is set to Track Input.

2	 On the right, click the audio input that you want to patch so it’s highlighted.

3	 On the left, click the audio destination that you want to patch so it’s highlighted also, 
if it’s not already. In this simplified example, channel 1 of the Scarlett 2i2 is being 
connected to Audio 1, which is the only track in the timeline.

Selecting a source and a destination to patch

4	 Click the Patch button at the bottom of the window, and your recording setup will 
be patched. 
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5	 Continue steps 2 and 3 until you’ve patched all the inputs you want to record from 
to all of the tracks that you want to record onto. You can patch as many inputs to as 
many tracks as your system is set up to accommodate. In this example, there are two 
available audio sources, but there’s only a microphone connected to the first channel, 
so that’s the only one being connected.

6	 When you’re finished, close the window.

Arming Tracks
To record on a track, it must be armed. You should note that it’s impossible to arm a track that 
hasn’t been patched first, so make sure you’ve patched the audio source you want to record 
from to the track you want to record to first. Then arming that track is as simple as clicking the 
R button in the track header controls, or in the channel strip for that track in the Mixer.

(Left) The arm button turned on in the track header, 
(Right) the arm button turned on in the channel strip

Once a track has been armed, you’re ready to record.

Choosing Where to Record Audio Clips To
The process of recording in the Fairlight page creates new clips and generates additional media 
on disk. You can specify the location on disk you want to save these recordings by opening the 
Capture and Playback panel of the Project Settings and using the Browse button, found 
underneath the “Save clips to” field, to choose a new location (a folder named “Capture” on 
your scratch disk is the default location).

To choose where the new clips that are created are placed in the Media Pool, simply open the 
Media Pool and select any bin in the Bin list, or create a new bin and select it if you want to put 
your recordings in their own location.

User-Selectable Input Monitoring Options
The Fairlight > Input Monitor Style submenu presents five options governing how you want to 
monitor inputs while recording.

�� Input: You only hear the live signal being input; you never hear the contents of tracks.

�� Auto: When one or more tracks are armed for recording, you hear the live input signal; 
on playback you hear the contents of each track.

�� Record: You only hear the live input signal while actively recording, meaning the 
Record button has been pressed while one or more tracks are armed for recording. You 
don’t hear the input signal while tracks are merely armed.

�� Mute: You hear nothing.

�� Repro: While recording, you only hear what’s just been recorded, played from the track. 
In other words, you’re not listening to the live input, but you’re reviewing what’s just 
been recorded as it’s recording.
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Recording Using the Onscreen Controls
You can record anywhere you want on the currently armed track or tracks by placing the 
playhead where you want recording to begin. In this way, you can record to specific areas of 
your program as you record voiceover, sound effects, foley, or other timed performances that 
need to fit into a particular region of the edit.

To begin recording:
1	 Position the playhead where you want recording to begin.

2	 Click the Record button in the transport controls. Recording immediately begins, and 
the material being recorded immediately begins drawing a waveform in real time, giving 
you immediate feedback that the input you’re recording is properly connected or not, 
as well as where on the currently armed track material is being recorded.

To stop recording, do one of the following:
�� Click the Stop button in the transport controls.

�� Press the Spacebar.

Recording and Editing Multiple Takes 
Using Layering
There are two ways you can record multiple takes. You can either record them one after the 
other, sequentially, and then edit them later. However, you also have the ability to record 
multiple takes to the same region of the timeline, one on top of another, while at the same time 
preserving every take using track layering.

In the following screenshot, multiple takes have been recorded over the same section of the 
timeline, including some partial takes to correct specific phrases in the voiceover being 
recorded. When you do this, the result looks like a series of cuts and overwritten clips, with the 
most recently recorded segments being the ones that play back over the previously 
recorded segments.

Overlapping recordings with Audio Track Layers turned off

However, if you choose View > Audio Track Layers, you’ll see that all your recordings have 
actually been preserved via a vertical stack of overlapping audio clips.
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Overlapping recordings with Audio Track Layers turned on, showing layering within the same track

The layering of audio clips in DaVinci Resolve means that the topmost superimposed clips in a 
layered stack like this mutes the audio of overlapping clips that are lower in the stack.

Using layering, it’s easy to edit the best segments of the best takes, while preserving all other 
takes, simply by adding edits and rearranging clips in the stack so the best parts are on top.

For more information about audio layering, see Chapter 128, “Editing Basics in the 
Fairlight Page.”

Recording VSTi Instruments
DaVinci Resolve 15 introduced support for VSTi instruments working with connected MIDI 
controllers to trigger instrument sounds that can be recorded live on audio tracks of the 
Timeline. This is intended to be used for loading a VSTi sampler with foley sounds such as 
footsteps or punches, so you can perform these sounds in real time and record the result to 
another track as you watch performers walking or punching in the edit, even if you lack a 
recording booth with foley pits and props.

On the other hand, if you’re a musician, there’s nothing stopping you from loading VSTi musical 
instruments of different kinds for playback, and using the Fairlight page as a multi-track 
recorder. DaVinci Resolve doesn’t have MIDI sequencing functionality, but you can record live 
playback straight to the Timeline, using layered audio to manage multiple takes for later 
re-editing. Bet you never thought you’d be recording music in DaVinci Resolve…

A VST Instrument (in this case Serato Sample) 
loaded into a track of the Timeline
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To enable a MIDI controller in macOS:
1	 If DaVinci Resolve is running, quit before connecting your MIDI controller and 

setting it up.

2	 On macOS you’ll use the Audio Midi Setup utility to choose output hardware and 
select a speaker configuration to be made available on your system. In the Finder, use 
Spotlight and search for Audio MIDI Setup to open it.

3	 In Audio MIDI Setup, choose Window > Show MIDI Studio. A window showing icons 
for all connected MIDI controllers appears. Your controller should be showing an icon. 
If it’s not, you may need to install drivers for it.

4	 Select the icon for your controller and turn on the “Enter test MIDI setup mode” button 
(it looks like a little keyboard) to test if your keyboard is connecting with the computer. 
If it is, then turn this off.

For more information on setting up MIDI on different systems, see the DaVinci Resolve 
Configuration Guide, available on the web from the Blackmagic Design support page at  
https://www.blackmagicdesign.com/support/family/davinci-resolve-and-fusion. 

To set up the Fairlight page for VSTi instrument recording using a sampler:
1	 Open DaVinci Resolve 15.

2	 Make sure you have at least two available audio tracks in the Timeline, one for the 
instrument you’ll be playing, and one to record into. This example will use tracks A4 and 
A5 for this.

3	 Open the Effects Library, find a VSTi sampler you have installed on your system, and 
drag it to the track header of the track you want to use for playing, for example track A4. 

Massively-featured sampler/synth combinations such as Native Instruments Kontakt 
and Steinberg Halion are ubiquitous and useful when you want to specifically map a 
collection of sound effects to specific keys or pads to create re-usable multi-purpose 
instruments. However, more streamlined samplers that emphasize automatic audio clip 
slicing such as Serato Sample (Windows and macOS) or Image Line Slicex (Windows 
only) can make short work of the more specialized task of loading library sound effects 
recordings (or custom recordings you create) with multiple footsteps, punches, 
keyboard presses, cloth rustles, or other foley activities, and quickly splitting them up 
into individually playable samples you can trigger with pads or a keyboard.

4	 When the VSTi interface window appears, open the MIDI menu at the upper right-
hand corner of the VSTi window and choose the correct MIDI channel from your MIDI 
controller’s submenu. If you’ve selected the correct MIDI channel, the instrument 
should start responding to the keys or pads on your controller.
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Enabling MIDI control

5	 Next, configure the VSTi instrument you’re using to play the sound effects you want 
to use for foley. In this example, the Serato Sample VSTi plug-in is being used to 
automatically slice up a recording of footsteps from one of Sound Ideas’ many sound 
effects libraries.

Because the VSTi you added is patched to that track’s Insert (if you look at the Mixer 
you should see that the I button is enabled on the channel strip the instrument is 
patched to), the Send is PRE the Instrument. This means you need to patch that track’s 
Track Direct output to the input of another track to record the instrument.

6	 Choose Fairlight > Patch Input/Output to open the Patch Input/Output window, then set 
the Source pop-up menu to Track Direct and the Destination pop-up menu to Track 
Input. Click Audio 4 to the left, and Audio 5 to the right, and click the Patch button; this 
sets you up to play the VSTi plug-in on track A4, and record its output on track A5.

Be aware that after patching Track Direct from the track with the instrument to the track 
you’re recording onto, you also need to turn “Direct Output” on for that track in the Path 
Settings of that track’s channel strip in the Mixer. 

7	 Open the Mixer (if necessary), click the Input pop-up menu at the top of the channel 
strip that shows the VSTi instrument you’re using, and choose Path Settings. When the 
Path Settings window appears, click the ON button for Direct Output, then close the 
Path Settings window. 

At this point, you’re ready to begin recording.

To play and record a VSTi instrument:
1	 Click the Record Arming button of the track you’re recording to (in this example A5), 

move the playhead to where you want to begin recording, and then click the Record 
button to begin recording.

2	 As the video of your program plays, use your MIDI controller to trigger sound effects as 
necessary. When you’re finished, click the Stop button. 

If necessary, you can record multiple takes using track layering until you get the timing 
right. When you’re finished, you can remove the instrument from the track it’s on since 
the recorded audio is all you need.
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Chapter 127

ADR 
(Automated Dialog 
Replacement)

The Fairlight page of DaVinci Resolve has a sophisticated interface 
for doing ADR, or automated dialog replacement, in a structured and 
straightforward manner. Simple, yet powerful, cue list management, 
industry-standard audio beeps and visual cues, and sophisticated 
take management with star ratings and layered take organization 
help you manage the resulting recordings to use the best parts of 
each take in your program.
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ADR (Automated Dialog Replacement)
Clicking the ADR button on the Interface toolbar opens up the celebrated Fairlight ADR panel, 
which provides a thoroughly professional workflow for doing automated dialog replacement. 
Dialog replacement, for those who don’t know, is the process whereby audio professionals 
bring in actors to re-record unsalvageably bad dialog recordings from the comfort of their 
recording studios, line by line and with a great deal of patience.

The ADR panel on the Fairlight page

It’s an old joke that ADR isn’t really automatic, but the Fairlight page aims to give you all the help 
it can to make this a structured and straightforward process. Simple, yet powerful, cue list 
management lets you efficiently assemble a re-recording plan. Industry-standard audio beeps 
and visual cues via your BMD video output device help the actors in the booth nail their timings 
and their lines. Then, sophisticated take management with star ratings and layered take 
organization in the Timeline help you manage the resulting recordings to pick and choose the 
best parts of each take when you edit the results.

The ADR Interface
When open, the ADR interface consists of three panels to the left of the Timeline: a Record 
panel, a List panel, and a Setup panel. The controls of these panels are described in the order 
in which they’re used.

The Setup Panel
As its name implies, the Setup panel is where you configure your ADR session. 

The Setup panel of the ADR interface
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This panel presents the following controls:

�� Pre Roll and Post Roll: Specifies how many seconds to play before and after each 
cue’s specified In and Out points, giving actors a chance to listen to what comes before 
and after each cue in order to prepare. If you enable the Beep options below, beeps 
provide a countdown during the specified pre-roll.

�� Record Source: (Disabled until you select a Record Track) A pop-up menu lets you 
choose the input you want to record from, creating a patch to the Record Track.

�� Record Track: A pop-up menu lets you choose the track you want to record to. 
Selecting a track with this menu creates a patch from the Record Source to the Record 
Track, and automatically toggles Record Enable on.

�� Guide Track: A pop-up menu lets you choose which track the original production audio 
you need to re-record is on. This is used for sending audio playback to the talent to use 
as a guide for recording their own replacement performance.

�� Record File Name: A text entry field that lets you provide a name for the audio files 
being recorded to be saved with.

�� Character Setup: A list for adding the names of all the characters that have dialog cues 
you’ll be re-recording, to help with cue creation and management. An Add New button 
lets you add additional names to this list, while a Remove button lets you delete 
characters you no longer need.

�� Beep to In Point: Enables a three-beep sequence to be heard leading up to 
the recording.

�� Beep at In Point: Enables one last beep at the In point.

�� Count In: An onscreen counter that counts down to the start of the cue.

�� Video Streamer: A visual cue for the talent to watch during pre-roll to ready them for 
recording. A pair of vertical lines superimposed over the program being output to video 
that move toward one another across your video output screen during the pre-roll to 
the cue to give the talent a visual indication of the countdown to the beginning of the 
cue. When the beeps play, these lines stretch upward and down briefly. Both lines 
come together at the cue point, and a large cross is shown as recording begins.

�� Smart Timeline: When turned on, this option automatically moves the playhead to each 
cue as it’s selected, and zooms in to frame the duration of that cue in the Timeline.

�� Mixing Control: Enables automated switching of audio playback, to independently 
control what the talent and the audio engineer hear at various stages of the ADR 
recording process. For example, with this enabled, the Guide track is not routed to the 
Control room while the engineer is reviewing a take.
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The List Panel
This is where you create a list of cues you need to re-record, either from within the Fairlight 
page, or imported from a .csv file that someone provides you.

The List panel of the ADR interface

This panel presents the following controls:

�� Cue editing controls: Displays the data for the currently selected cue (or a cue that was 
just created). In and Out timecode fields store the Timeline In and Out points that were 
set when the cue was created but can be manually edited for fine tuning. A Character 
pop-up menu lets you choose which character that line of dialog belongs to. A text 
entry field lets you enter the dialog cue that’s to be re-recorded, so you and the talent 
can both refer to it.

�� New Cue button: Clicking this button adds a new cue to the list using whatever In and 
Out points have been set in the Timeline, and whatever character was last selected.

�� Cue list: The list of all cues that have been entered or imported. The Cue list can be 
filtered using the Filter pop-up menu at the top-right of the ADR panel (next to the 
option menu). You can choose to show the cues for all characters, or for any selected 
combination of characters. You can also choose to hide all cues that are marked as 
done to experience the joy of this list shrinking more and more the closer you are to 
being finished.

Additionally, the ADR interface option menu has three commands pertaining to the List panel:

�� Import Cue List: Lets you import a properly formatted .csv file to create cues that have 
been prepared in a spreadsheet. Correct formatting for cue lists you want to import 
is no headers, one line per cue, with four individual columns for In timecode, Out 
timecode, Character Name, and Dialog.

�� Export Cue List: Lets you export the contents of the Cue list to a .csv file, for exchange 
or safe-keeping.

�� Clear Cue List: Deletes all cues in the Cue list. It’s recommended you export a copy of 
your Cue list before eliminating it completely, in case you ever need to revisit a cue.
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The Record Panel
This is where you actually run the ADR recording session you’ve set up, using the dialog cues 
you’ve put into the Cue list. 

The Record panel of the ADR Interface

This panel presents the following controls:

�� Record and rehearse controls: Four transport controls and two buttons let you control 
recording during ADR sessions. These controls are only clickable when you’ve selected 
a cue from the Cue list to record.

–– Rehearse: Runs the section of the Timeline specified by a cue without actually 
recording anything, giving the talent an opportunity to run through their dialog and 
practice their timing and delivery. Beeps and on-screen streamers are not played 
during a rehearsal.

–– Play: Plays the currently selected take from the Take list (described below). If no take 
is selected, the most recently recorded one on top is played.

–– Stop: Immediately stops rehearsal, playback, or recording.

–– Record: Initiates recording of the cue to the specified audio track, with cue beeps 
and video streamer cues.

–– Keep Playing: At the end of a take you may wish to keep playing, so the talent 
can hear the next section of the track. Pressing the Keep Playing button at any 
time, even while recording, results in post roll being ignored and normal playback 
resuming after the cue’s Out time.

–– Keep Recording: At the end of a take you may wish to keep recording until you 
manually stop. Pressing the Keep Recording button at any time, even while 
recording, results in the Out point of the current cue being ignored and recording 
continuing until you stop it.
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�� Take list: The Take list shows every take you’ve recorded for the current cue, with 
take number, name, and a five-star rating that you can set to keep track of which takes 
worked and which didn’t. Earlier takes are at the bottom of this list, while recent takes 
are at the top (the same order in which the corresponding layered audio clips appear in 
the Timeline track they’ve been recorded to).

�� Cue list: The list of all cues that have been entered or imported. The Cue list can be 
filtered using the Filter pop-up menu at the top-right of the ADR panel (next to the 
Option menu). You can choose to show the cues for all characters, or for any selected 
combination of characters. You can also choose to hide all cues that are marked as 
done to experience the joy of this list shrinking more and more the closer you are to 
being finished.

�� Cue list Done column: A sixth column appears in the Record panel only, labeled Done. 
It contains check boxes for each cue that you can turn on to keep track of which cues 
you’ve successfully finished.

Additionally, the ADR interface Option menu has one command pertaining to the Record panel:

�� Record Early In: Enables recording during pre-roll, in the event you’re working with 
talent that likes to start early.

Setting up to Do an ADR Session
Setting up to record ADR is straightforward but requires some steps.

Patching tracks in preparation to record ADR:
1	 In the Timeline, create two new audio tracks, one to record ADR to, and another to 

route the Oscillator through to play preview beeps.

2	 Open Fairlight > Patch Input/Output to choose the Patch window

3	 Choose Audio Inputs from the Source pop-up menu, and choose Track Inputs from the 
Destination pop-up menu, then patch the audio input for your recording microphone to 
the track you created to record onto in step 1.

4	 Next, choose Osc from the Source pop-up menu, and patch the Beep output to the 
track you created to preview beeps in step 1.

5	 Close the Patch Input/Output window.

6	 To make sure you can hear the preview beeps, open the Mixer (if necessary), click the 
Input pop-up menu at the top of the channel strip that shows “Beeps,” and choose 
Path Settings. When the Path Settings window appears, turn on the Thru button in the 
Record Level controls, and close the path settings.

Thru mode places a track into a “live” input mode, bypassing track playback in order to 
play the patched input. Thru mode is typically used for external sources that you want 
to bring into a mix. While a track is in THRU, there’s no need to arm the Record button, 
the external source is always feeding to the mix.

7	 If you’re recording ADR to your main timeline, Solo the Guide track, the Record track, 
and the Beep Preview track to focus only on the audio you’re re-recording.

Now you’re ready to configure the Setup panel.
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Configuring the Setup panel:
1	 Open the ADR interface, and then open the Setup panel.

2	 Choose the Pre Roll and Post Roll you want to use, in seconds. A pre roll of at least 3 
seconds is recommended to give the talent time to get ready.

3	 From the Record Source pop-up menu, choose the microphone you patched earlier.

4	 From the Record Track pop-up menu, choose the Record track you created.

5	 From the Guide Track pop-up menu, choose the track with the original production 
audio that you’re replacing.

6	 At the bottom of this panel, turn on the Preroll Cue options you and the talent want to 
use. Options include Beeps to provide an audible lead up to re-recording, and a Video 
Streamer that gives both visual cues and also displays the dialog text for that cue on 
screen for the actor to refer to, keeping their eyes on the screen.

Creating and Importing ADR Cue Lists
You must have a list of cues to be able to use the ADR interface properly. There are two ways 
you can create a Cue list to record with, make one on the Fairlight page, or import one. If you’ve 
been doing all of your dialog editing inside of DaVinci Resolve, you can go ahead and create a 
list by marking the sections of the Timeline you need to re-record and creating cues from 
those timings.

To manually add cues to the Cue list:
1	 Open the Setup panel of the ADR interface, and use the Add New button in the 

Character Setup list to create all the character names you’ll be creating dialog cues for. 
These will help you to filter and sort the list as necessary later on.

2	 Next, open the List panel of the ADR interface. This is where all the controls for creating 
and editing cues are.

3	 In the Timeline, set In and Out points to mark the section of dialog you want to turn into 
a cue. Those timecode values appear in the Cue Editing section of the List panel.

4	 In the Cue Editing section, choose the character who’s speaking that cue, and type the 
dialog they’re speaking.

5	 When you’re done, click New Cue, and that cue will be added to the Cue list.

6	 Repeat steps 3 through 5 until you’re finished creating all the cues you intend to re-
record. If you need to edit any cue, simply click to select that cue, and edit it in the Cue 
Editing section above.

To import a .csv file to the Cue list:
1	 Choose Import Cue List from the ADR option menu, then use the dialog to choose the 

.csv file containing the Cue list you were given, and click Open. 

2	 An ADR Setup dialog appears, letting you assign the columns of the .csv file you 
selected to the relevant column of the ADR panel. Correct formatting for Cue lists 
you want to import is no headers, one line per cue, with four individual columns for In 
timecode, Out timecode, Character Name, and Dialog, but if any of these columns are 
transposed, you can correct this here.
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Dialog for rearranging columns of cue data, if necessary

3	 Click Import CSV. The cues should appear in the Cue list.

To export a .csv file from the Cue list:
�� Choose Export Cue List from the ADR option menu, choose a location to save the file, 

and click Save.

Recording ADR to the Timeline
Once you’ve configured your workstation for recording, and you’ve set up a cue list to work 
with, it’s time to start recording each cue.

To record a cue from the Cue list:
1	 Open the Record panel of the ADR interface.

2	 If you want to record a particular character’s cues, you can turn off Show All Characters, 
and turn off all unnecessary characters, in the ADR Option menu.

3	 With the list showing the character cues you need, select the cue you want to start 
recording. That cue contains the timecode necessary to determine which part of the 
Timeline to record to, and the playhead automatically moves to that part of the Timeline.

4	 Click the Rehearse button to run through the cue with the talent a few times. Both audio 
and video corresponding to that cue will play, including pre roll and post roll.

5	 When the talent is ready to try a take, click the Record button, and let the Fairlight page 
do the work of playing through pre roll with beep notifications and visual streamer cues, 
initiating recording, and then stopping recording automatically once the cue is done.

6	 If you or the talent want to hear what the take sounds like again, you can select it in the 
Take list and click Play. Depending on how you like the take, you can mark it with the 
5-star ratings control and then record another take.

7	 To record another take, click the Record button again. New takes are placed on the 
same track using layered audio, so you can record as many takes as you like into the 
same area of the Timeline that corresponds to the media you’re replacing. When you’re 
finished recording takes, you’ll have a neatly organized stack of alternate takes to draw 
upon as you edit the best parts from each recording.

8	 When you’re finished recording a cue, click the Done checkbox for that cue, and select 
the next cue you want to record. When you’re finished re-recording dialog, simply close 
the ADR interface. 
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Chapter 128

Editing Basics in 
the Fairlight Page

You can use the Fairlight page to refine the editing of audio that was 
initially assembled in the Edit page, or you can use the Fairlight page to 
both record and edit audio programs from scratch. Because audio clips 
have properties that video clips do not, audio editing encompasses 
additional procedures that are not available in the Edit page. This chapter 
takes you through the fundamental steps of editing audio the Fairlight way.

Chapter – 128  Editing Basics in the Fairlight Page 2477



Compatible Audio Formats	 2481

Adding Audio Clips to the Timeline	 2481

Overwriting Vs. Layering Clips That Overlap	 2481

Choosing Parts of Clips to Edit in the Media Pool	 2482

Dragging Individual Audio Clips Into the Timeline	 2482

Drag and Drop Editing of Several Clips Into the Timeline at Once	 2483

Support for Mixed Audio Track Formats from Source Clips	 2483

Making Audio Clip Selections in the Timeline	 2484

Clip Selection	 2485

Track Selection	 2486

Range Selection	 2487

Automatic Selections in Selection Mode With Selected Tracks	 2489

Automatic Selections in Range Selection Mode With Selected Tracks	 2490

Locking Audio Tracks You Don’t Want to Change	 2491

Splitting Clips	 2491

Trimming Clips Without Rippling the Timeline	 2492

Seven-Point Editing	 2492

Resizing the In and Out Points of a Clip	 2492

Trim Start and Trim End	 2493

Moving (Sliding) and Overwriting Clips	 2493

Slipping	 2494

Disabling and Re-Enabling Clips in the Timeline	 2494

Deleting Audio Clips and Regions	 2494

Cut, Copy, and Paste	 2494

Conventional Cut, Copy, and Paste	 2495

Using the Cut/Copy Head and Tail Commands	 2497

Paste and Remove Attributes	 2498

Copying and Pasting Clip Attributes	 2498

Copying and Pasting Track Attributes	 2499

Removing Attributes	 2499

Contents

Chapter – 128  Editing Basics in the Fairlight Page 2478



Audio Clip Layering	 2499

Audio Compound Clips	 2501

Audio Crossfades	 2501

Fades and Crossfades	 2502

Using Fades	 2502

Fade In and Out to Playhead	 2503

Creating Crossfades With Overlapping Fades	 2503

Using Crossfades From the Edit Page	 2504

Finding Clips in the Media Pool	 2505

Changing Clip Color in the Timeline	 2505

Editing Audio Clips in External Editors	 2505

Sample Editing	 2506

Chapter – 128  Editing Basics in the Fairlight Page 2479



Compatible Audio Formats
DaVinci Resolve is compatible with WAVE, Broadcast WAVE, AIFF, MP3, AAC (M4A), CAF 
(macOS only), both MTS and QuickTime containers that use the AC3 audio format, and 
Enhanced AC-3 (macOS and Windows only). DaVinci Resolve is compatible with audio at 
sample rates including 32, 44.1, 48, 88.2, 96, and 192 kHz.

Adding Audio Clips to the Timeline
The Fairlight page offers a complete audio editing environment that lets you either record and 
assemble clips from scratch, or refine tracks full of audio clips that have been edited together in 
different ways. There are four ways of adding media to the Timeline in the Fairlight page, 
depending on the type of work you do:

�� Recording new audio into one or more tracks (for more information, see 
Chapter 126, “Recording”)

�� By dragging and dropping new audio clips from the Media Pool into the 
Fairlight timeline

�� By editing audio clips into audio tracks on the Edit page

�� By importing a project with audio clips

However audio clips come to be in your timeline, the rest of this chapter covers the myriad 
methods available to edit and sweeten the contents.

Overwriting Vs. Layering Clips That Overlap
When you add clips to the Timeline, what happens when you add a clip that overlaps another 
clip that’s already in the track you’re editing to depends on the Timeline > Layered Audio 
Editing setting. By default, with Layered Audio Editing turned off, overwriting one audio clip with 
another results in the overlapping part of the overwritten clip being non-destructively deleted 
from the Timeline by the incoming clip.

However, if you turn Layered Audio Editing on, then incoming clips do not overwrite overlapping 
clips in the Timeline; instead, they’re layered within that track, such that the incoming audio clip 
takes precedence over what was previously there, but overlapping audio segments that were 
previously in the Timeline are preserved, which can be seen when you choose View > 
Show Audio Track Layers.

In this way, you can choose whether you want to overwrite previously edited clips, or layer 
newly edited clips, as your needs require, regardless of whether or not Audio Track Layers are 
visible. Audio layering can be enabled in both the Edit and Fairlight pages.

For more information about audio layering, see the section later in this chapter.
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Choosing Parts of Clips to Edit in the Media Pool
The Media Pool has a preview player at the top that provides a place to open selected source 
clips in the Media Pool, play them, add marks to log them, and set In and Out points in 
preparation for editing them into the Timeline via drag and drop. The Media Pool Preview Player 
effectively acts as a Source monitor for editing in the Fairlight page.

The preview player in the Media Pool

�� Various viewing controls populate the title bar at the top. A pop-up menu at the upper 
left lets you choose a zoom level for the audio waveform that’s displayed. To the right 
of that, a Timecode window shows you the duration of the clip or the duration that’s 
marked with In and Out points. Next to the right, a real-time performance indicator 
shows you playback performance. In the center the title of the currently selected clip 
is shown, with a pop-up menu to the right that shows you the most recent 10 clips 
you’ve browsed. To the far left, a Timecode field shows you the current position of 
the playhead (right-clicking this opens a contextual menu with options to change the 
timecode that’s displayed, and to copy and paste timecode).

�� The center of the Media Pool Preview Player shows you the waveforms in all channels 
of the currently selected clip, at whatever zoom level is currently selected.

�� Transport controls at the bottom consist of a jog bar for scrubbing, Stop, Play, and Loop 
buttons, and In and Out buttons.

Dragging Individual Audio Clips Into the Timeline
You can show the Media Pool in the Fairlight page, and edit audio clips into the Timeline in their 
entirety by dragging and dropping individual clips onto whichever audio track you want them 
to appear.
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Drag and Drop Editing of Several Clips 
Into the Timeline at Once
If you want to edit several clips into the Timeline at once by dragging them from the Media Pool, 
you’ll probably want to do a bit of preparation to make sure they’re edited in the right order.

1	 Change the sort order of the Media Pool’s browser area to put the clips into the order 
in which you want them to appear. In Thumbnail view you can use the Sort Order 
menu, but in List view you can click the header of any metadata column to sort by that 
column’s data.

Using the Sort Order menu to change the 
sort order of clips in the Media Pool

2	 Use the Media Pool thumbnails, the Media Pool List view Filmstrip, or the Source 
Viewer to set In and Out points to define the part of each clip that you want to edit into 
the Timeline.

3	 Select the Media Pool clips you want to edit into the Timeline by dragging a bounding 
box, Command-dragging multiple bounding boxes over different sets of clips, by 
Shift‑clicking a range of clips, or by Command-clicking individual non‑contiguous clips.

4	 Drag any of the selected clips to the desired position in the Timeline to perform 
an overwrite edit.

The clip(s) you drag overwrite whatever other clips they overlap in the Timeline. 
Multiple clips dragged from the Media Pool will be edited in the order in which 
they’re sorted in the Media Pool, using each clip’s In and Out points.

Support for Mixed Audio Track Formats from Source Clips
As of DaVinci Resolve 15, there is support for media with multiple audio tracks that have 
differently formatted channels embedded within them. For example, a clip with one stereo 
track, one 5.1 surround track, and six mono tracks can all be appropriately set up in the Audio 
panel of Clip Attributes after that clip has been imported.

The Audio panel of Clip Attributes now has controls over what format (Mono, Stereo, 5.1, 7.1, 
Adaptive) the channels embedded within a particular audio track should be configured as. 
This means you can set up clips with multiple tracks, each one using different formats of audio 
employing different combinations of channels, which is useful for setting up imported audio mix 
files that you want to output when mastering a program.
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Clip Attributes now lets you assign channels among different 
tracks with different channel assignments

Making Audio Clip 
Selections in the Timeline
Nearly every editing operation described in this chapter and others requires you to make a 
selection to define which clips will be affected. The two main editing modes in the Fairlight 
page are the Selection tool and the Range Selection tool. Which mode you choose determines 
how clips and clip segments are selected in the Timeline in preparation for all manner of 
editorial operations.

The Selection and Range 
Selection tools seen in the toolbar

In Selection mode, the process of making selections and working in the Fairlight page 
resembles that of the Edit page, although there are still key differences in terms of automatic 
behaviors that take place when you select tracks you want to work on.

To choose Selection mode:
�� Click the Selection tool (the arrow) in the toolbar.

�� Choose Trim > Selection Mode.

�� Press A.
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In Range Selection mode, the process of making selections and selecting tracks works more 
similarly to traditional Fairlight editing systems. This unlocks more of the power of Fairlight 
editing, enabling the easier selection of tracks and partial selection of clips for purposes of fast 
audio editing. However, these operations are very different from similar operations found on the 
Edit page.

To choose Range Selection mode:
�� Click the Range Selection tool (the crosshairs) in the toolbar.

�� Choose Trim > Range Selection Mode. 

�� Press R.

Clip Selection
If you’re doing simple operations to entire clips, you can select clips in the Timeline of the 
Fairlight page in most of the same ways you select them in the Edit page.

Methods of selecting clips:
Click any clip to select it.

Click a clip to select it

Command-click multiple clips to select them all at once.

Command-clicking multiple clips selects those clips, even if they’re separated by other clips

Click anywhere in the background of the Timeline and drag a bounding box over 
multiple clips.

Dragging a bounding box over multiple clips selects all of them
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Track Selection
The Timeline on the Fairlight page lets you select entire tracks, in order to simplify the process 
of choosing which clips on which tracks you want to be included in a particular operation, as 
well as to facilitate the automatic selection of clips that intersect the playhead for easy 
operation with keyboard shortcuts and the Fairlight Editing panel.

For example, if you want to copy clips on tracks A3 and A5, then you’ll want to start by doing 
one of the following things:

�� In Selection mode: You can select tracks by clicking or Command-clicking anywhere in 
the background area or on the track number of the track headers.

�� In Range Selection mode: You can select tracks by clicking or Command-clicking 
anywhere either in the background area or on the track number of the track header, or 
in any unused area of the track itself in the Timeline.

Command-clicking multiple track headers selects those tracks

Were you to select tracks A3 and A5, then moving the playhead over the two clips you want to 
copy automatically selects them, and gets you ready for any operation you need to perform on 
both clips together, as seen in the previous screenshot. This is analogous to the use of the Auto 
Select controls on the Edit page, which define which clips and clip segments are automatically 
affected whenever you set In and Out points in the Timeline.

Methods of selecting and deselecting tracks in the Fairlight page timeline:
�� To select a single track: Click anywhere in the background or on the track number of 

that track’s header (not on a button). In Range Selection mode you can also click in any 
unused area of the track itself.

�� To deselect a single track: Click anywhere in the background or on the track number 
of a previously selected track’s header (not on a button). In Range Selection mode 
you can also click in any unused area of the track itself. If multiple tracks are selected, 
Command-clicking one will remove just that track from the selection.

�� To select multiple tracks: Command-click in the track header background of every 
track you want to select. In Range Selection mode you can also Command-click in any 
unused area of the tracks themselves. Command-clicking an already selected track will 
deselect it.
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�� To select multiple continuous tracks: Click anywhere in the background or on the 
track number of a track header, and then drag a bounding box up or down over all 
other tracks you want to select. In Range Selection mode you can also drag a bounding 
box over any part of the tracks themselves, while also defining a range in which you 
want to work.

�� To move the selection to higher or lower tracks: Press Control-Option-Up or Down 
Arrow to move the selection state to the next track higher (Control-Option-Up Arrow) 
or lower (Control-Option-Down Arrow). If multiple tracks are selected, then the multi-
selection will be moved as a block; for example, selecting tracks A2 and A3 and then 
pressing Control-Option-Down Arrow will result in tracks A3 and A4 being selected.

Range Selection
Pressing the R key enables Range Selection mode, in which you can create ranged selections 
with which to perform an operation to segments of one or more clips. Using the methods shown 
in this section, it’s easy to select specific segments of larger clips so that you can move, delete, 
cut, copy, or paste words, phrases, musical bars, or sounds that you want to edit somehow.

For a range to act as a selection, it must also encompass the selection of one or more tracks in 
addition to one or more clip segments on those tracks. Ranges can also be defined by setting 
In and Out points on the Timeline. If you set In and Out points on the Timeline without selecting 
one or more tracks, then the range you define doesn’t actually select anything; in this situation 
the range can be used for other purposes such as recording, but you’ll be unable to make any 
editorial changes to clips falling within this range.

Methods of selecting clips via clicking and dragging:
�� To select a single clip: Click any clip to select both it and the track it’s on, and define a 

range in the Timeline that matches the duration of that clip.

Click to select a single clip as well as the track it’s on

�� To select multiple clips: Command-clicking multiple clips to select them all at once 
defines a range in the Timeline that matches the total overlapping duration of all clips 
in the selection, from the beginning of the first selected clip to the end of the last 
selected clip.
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Range selection by Command-clicking multiple clips

�� To drag to select a range within a single clip: With the Range Selection tool selected, 
drag anywhere on top of a clip to drag a bounding box over whatever segment of that 
clip (or of one or more clips) to select both that clip segment and the track it appears 
on. This is a good way of selecting part of a recording you want to move or delete.

Ranged selection within a clip using a bounding box

�� To drag to select a range within multiple clips: Click and drag a bounding box over 
whatever segment of one or more clips you want to select to select both those clip 
segments and the tracks they appear on. Or, Command-click and drag anywhere on 
top of any clip to drag a bounding box over whatever region of clips and tracks you like.

Ranged selection across multiple clips using a bounding box
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In Range Selection mode, whenever you make a selection, the In and Out point fields 
update with the range that you’ve created. 

The range fields showing you the In 
and Out point values that define the 
current range

These ranges can be cleared if necessary.

Methods of clearing In and Out points to clear the current range:
�� Press Option-I to clear the current In point.

�� Press Option-O to clear the current Out point.

Press Option-X to clear both the In and Out points.

Automatic Selections in Selection Mode 
With Selected Tracks
In the default Selection mode (press A), all clips that intersect the playhead on selected tracks 
of the Timeline are automatically selected in their entirety. Clips selected in this way display an 
orange highlight.

Clips intersecting the playhead in Selection mode are 
automatically selected with orange highlights

In this mode, the resulting selection allows whatever operation you perform to affect the 
entirety of whichever clips intersect the playhead. For example, pressing the Delete key will 
delete all selected clips in their entirety, and copying will copy the whole of each selected clip.

If you use the I (Mark In) and O (Mark Out) keys to define a range while in Selection mode, a 
range will be selected, suitable for various non-editing operations such as recording, but no 
clips or clips segments will be selected.
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Automatic Selections in Range Selection 
Mode With Selected Tracks
In Range Selection mode (press R), all clips that intersect the playhead on selected tracks of the 
Timeline define a range in the Timeline that matches the total overlapping duration of all clips in 
the selection, from the beginning of the first selected clip to the end of the last selected clip.

Clips intersecting the playhead in Range Selection mode are 
automatically selected with orange highlights

In this mode, the resulting selection allows whatever operation you perform to affect the 
entirety of whichever clips intersect the playhead. For example, pressing the Delete key will 
delete all selected clips in their entirety, and copying will copy the whole of each selected clip.

However, in this mode you can use the I (Mark In) and O (Mark Out) keys to define a range, and 
all clip segments falling into this range on selected tracks will be selected.

To automatically select clip ranges on multiple selected tracks:
Use the I (Mark In) and O (Mark Out) keys to define a range in the Timeline, and all clip 
segments falling within this range on selected tracks will be selected

Selecting a range using In and Out points in the Timeline
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Locking Audio Tracks You 
Don’t Want to Change
Another step you can take to prepare before performing any kind of editorial operation is to 
lock tracks with media that you don’t want to be affected by whatever it is you’re about to do. 
For example, if you have a complex set of music edits on track A3 that you don’t want to be 
affected by operations that will delete media that overlaps it, you can lock track A3 so those 
clips remain unaffected.

Locking an audio track

Clips on locked tracks cannot be moved, deleted, cut, or otherwise affected by editorial 
operations. Furthermore, parameters of locked clips cannot be edited in the Inspector. 
However, clips on locked tracks can be played back and mixed like any other audio clips.

To toggle the lock or unlock state of audio tracks in the 
Fairlight page, do one of the following:

�� Click any track’s lock control to toggle lock on and off.

�� Click any track’s lock control and drag over the lock controls of other tracks in the 
Timeline to quickly lock or unlock several adjacent clips.

Splitting Clips
In many situations you may find yourself splitting audio clips in order to separate multiple 
rolling takes.

To split one or more clips in either Selection or Range Selection mode:
1	 Select each track that has a clip you want to split.

2	 Move the playhead to intersect the clips you want to split at the frame where you want 
the split to happen.

3	 Do one of the following:

a	 Choose Timeline > Split Clip or press Command-\ (backslash).

b	 Choose Timeline > Razor or press Command-B.

When you split a clip in the Edit page, a through edit appears to show that you currently have 
an edit with continuous timecode running from the outgoing to the incoming half. This is called 
a through edit and is displayed in the Edit page with a dotted line running along its edge so you 
know that it’s special. The Fairlight page doesn’t display through edits as of the time of 
this writing.

NOTE:  Clips cannot be joined as of the time of this writing.
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Trimming Clips Without 
Rippling the Timeline
Most basic adjustments in the Fairlight page only affect the selected clip or region of the 
Timeline. Clips to the right of the adjusted area of the Timeline are generally left alone so as not 
to inadvertently change sync when you don’t expect it. This section covers the most basic parts 
of the Fairlight page’s “seven-point editing” paradigm.

Seven-Point Editing
Each clip in the Timeline has seven draggable handles that affect audio editing.

�� In point: The left edge of the clip, used to resize the beginning of the clip.

�� Out point: The right edge of the clip, used to resize the end of the clip.

�� Fade In handle: A handle at the upper left-hand corner of the clip that only appears 
when the mouse is positioned over that clip, used to fade the audio in, or as part of a 
crossfade between two audio clips. Fades can be reset (eliminated) by double-clicking 
the fade handle.

�� Fade In curve:  A handle at the center of the Fade In curve that only appears when the 
curve is exposed, used to adjust the power of the fade in. This handle can be dragged 
vertically to change the X-Level of the fade, and horizontally to change the X-Point of 
the fade. Fade curves can be reset by double-clicking the curve handle.

�� Fade Out handle: A handle at the upper right-hand corner of the clip that only appears 
when the mouse is positioned over that clip, used to fade the audio out, or as part of a 
crossfade between two audio clips. Fades can be reset (eliminated) by double-clicking 
the fade handle.

�� Fade Out curve: A handle at the center of the Fade Out curve that only appears when 
the curve is exposed, used to adjust the power of the fade out. This handle can be 
dragged vertically to change the X-Level of the fade, and horizontally to change the 
X-Point of the fade. Fade curves can be reset by double-clicking the curve handle.

�� Level: Considered an editorial characteristic, the level of any given audio clip can be 
adjusted via a level overlay running across each clip. The level of any clip can be reset 
to the default 0.0 dB by double-clicking the level overlay.

Resizing the In and Out Points of a Clip
Trimming the head or tail of a clip in the Fairlight page means to resize the In or Out point of that 
clip, making it shorter or longer accordingly.

To resize the beginning or end of a clip:

�� To shorten or lengthen clips: Move the pointer over the beginning or end of a clip, 
and when it turns into the Resize cursor, drag the In or Out point to the left or right 
to change the clip’s length. As you drag the In or Out point of an audio clip in the 
Fairlight page, an overlay appears showing the waveform of all available media at the 
head (if you’re dragging the In point) or tail (if you’re dragging the Out point) of the clip 
you’re resizing.
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The overlay seen when resizing the In point of an audio clip in the Fairlight page

To quickly resize the beginning or end of a clip to the very 
beginning or end of available media:

�� Double-click the In point of the clip to move the In point to the very beginning of that 
clip’s media.

�� Double-click the Out point of the clip to move the Out point to the very end of that 
clip’s media.

If you resize a clip’s In or Out point to overlap one or more neighboring clips in the Timeline, the 
overlapping parts of the neighboring clips will be overwritten by the clip you’ve resized.

Trim Start and Trim End
The Trim > Trim Start (Shift-[) and Trim End (Shift-]) commands let you move the In or Out point of 
all clips that intersect the playhead as either a ripple operation (in Trim mode) or a resize 
operation (in Selection mode). You do not need to make a selection to use Trim Start and Trim 
End, making these commands fast to use in the right situation. A classic use of Trim End is when 
you have several superimposed clips of different lengths that you want to either start or end at 
the same time.

�� Trim Start resizes or ripples (depending on what mode you’re in) all clips that intersect 
the playhead, so that each clip’s In point is moved to the current playhead position. 

�� Trim End resizes or ripples intersecting clips so that each intersecting clip’s Out point is 
moved to the current playhead position.

Clips that don’t intersect the playhead are not affected. Furthermore, you can exclude clips on 
specific tracks from this operation by locking those tracks.

Moving (Sliding) and Overwriting Clips
Formerly called slipping in previous versions of Fairlight, sliding refers to moving a clip to the 
left or right in the Timeline, changing the timing of that clip’s position in the edit.

To move or slide clips in the Timeline, do one of the following:
�� To move one or more selected clips in the Timeline: Drag any clip in the Timeline to 

any other position. If you drag a clip to overlap another clip, the clip you’re dragging 
overwrites the clip you’re moving it over. 

�� To nudge one or more selected clips in the Timeline using the keyboard: Press the 
Comma key (nudge 1 frame left) or Period key (nudge 1 frame right) to roll the selected 
edit to the left or right. Shift-Comma and Shift-Period nudges by 5 frames.

�� To move one or more selected clips up or down to other tracks at the same time: 
Hold the Shift key down while dragging clips up or down in the Timeline to lock their 
position in time while moving them to other tracks. Or, you can hold the Option key 
down and press Up or Down Arrow.
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Sync Offset Indicator
Audio clips in the Fairlight page display an “out-of-sync” or sync offset indicators when they’re 
moved out of sync with the video items they’re linked to.

Slipping
Formerly called resyncing, slipping an audio clip keeps that clip in the same place in the 
Timeline while changing the range of media that appears in that spot. Slip edits do not change 
the duration of the overall Timeline, and they don’t move the clip’s position relative to the other 
clips in the Timeline. Slipping simply changes the range of media that clip represents.

NOTE:  While available in previous versions of Fairlight, slipping is not available at the 
time of this writing.

Disabling and Re-Enabling Clips in the 
Timeline
Sometimes there’s one or more audio clips in the Timeline that you don’t want to play along with 
the rest of the edited sequence, but you don’t want to remove from the Timeline either, in case 
you change your mind later. For this reason, it’s possible to disable clips, effectively turning 
them off without removing them. Previous versions of Fairlight referred to this operation as 
Mute clip.

Disabled clips appear dimmed in the Timeline. They don’t play back, they’re not rendered, and 
they’re not output to video. However, their position is preserved in the Timeline, so you can 
always re-enable them at a later time if you change your mind and decide you want 
to use them.

To disable or re-enable one or more selected clips:
�� Right-click part of the selection and choose Enable Clip from the contextual menu.

�� Choose Clip > Enable Clip.

�� Press D.

Deleting Audio Clips and Regions
You can delete any clip(s) or clip region(s) that you can select, in either Selection or Range 
Selection modes by pressing the Delete or Forward Delete keys, or by right-clicking a clip and 
choosing Delete Selected from the contextual menu. In the Fairlight page, deleting anything 
leaves a gap. You can not ripple delete anything.

Cut, Copy, and Paste
The Fairlight page has a unique copy and paste methodology that takes advantage of the 
“ghost” overlays that are used for the waveforms of selected audio clips. This method makes it 
easy to copy and paste clips using keyboard shortcuts and the JKL keys.

Chapter – 128  Editing Basics in the Fairlight Page 2493



Conventional Cut, Copy, and Paste
The typical cut, copy, and paste commands expected of every software application are 
available in the Fairlight page, but with a unique twist that’s particularly advantageous for users 
of the Fairlight control surface, or for anyone who uses the JKL transport key shortcuts to move 
around the Timeline for keyboard-driven editing. 

To cut or copy and paste either all or part of a clip:
1	 If you’re cutting or copying a whole clip, then choose either the Selection (press A) or 

Range Selection (press T) mode. If you’re cutting or copying part of a clip, then make 
sure you’re in Range Selection mode (press T).

2	 To use the playhead to make a clip selection, select the track that contains the clip 
you want to copy or cut. If one or more tracks are already selected, you can use the 
Control-Option-Up or Down Arrow key shortcuts to move the track selection state up or 
down to the tracks with the clip you want to cut or copy.

Selecting the track with a clip you need to cut

3	 Do one of the following:

a	 To cut or copy a whole clip, move the playhead so that it intersects the clip you want 
to cut or copy. If the playhead intersects a clip on a selected track, that clip should 
become selected. You should note that even if you use the mouse to select a clip 
without selecting a track first, you should still move the playhead to intersect the 
clip you’re copying or pasting, as this sets up an important reference point for the 
operation.

b	 To cut or copy segment of a clip, move the playhead so that it intersects the clip you 
want to cut or copy. If the playhead intersects a clip on a selected track, that clip 
should become selected. Then, using JKL and the I (In) and O (Out) keys, mark a 
range in the Timeline that includes the segment of the clip you want. That segment 
should appear highlighted as a result.
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Cutting or copying a segment of a clip using In and Out points

4	 Making sure the playhead is over the section of the waveform that you want to use as 
the frame to move the clip by, press Command-X to cut or Command-C to copy that 
clip (you can also right-click a clip and choose Copy or Cut). That clip will immediately 
become highlighted.

Cutting or copying a clip at the position of the playhead
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5	 At this point, there are two things you can do to position the cut or copied clip to the 
position in the Timeline at which you want to paste it:

a	 Moving the playhead will now also move the clip you cut or copied, shown as a 
ghost clip with waveform that’s “attached” to the playhead at the frame you chose. 
Whether you drag the playhead with your mouse or use JKL to move the playhead 
through the Timeline, the cut or copied clip will move along with it, so that moving 
the playhead repositions the cut or copied clip on that track.

b	 If you want to move the cut or copied clip to another track, use the Control-Option-
Up or Down Arrow key shortcuts to change the selected track; the ghost clip will 
move along with change in track selection.

Positioning the cut or copied clip before you paste it

This way, you can use the playhead to align the ghost waveform with other audio clips 
surrounding it in preparation for pasting it.

6	 When the clip is positioned where you want it, press Command-V to paste the clip at 
the position you’ve chosen (you can also right-click a track and choose Paste from the 
contextual menu). The clip becomes solid, and you’re finished.

The pasted clip

Using this method of cutting and pasting makes it quick to cut or copy clips using only keyboard 
commands, with the clip’s ghost overlay making it easy to precisely align the clip you’re pasting 
to fit exactly where you need it to, perfectly in sync.

Using the Cut/Copy Head and Tail Commands
Four additional commands make it easy to cut or copy portions of one or more clips that 
intersect the playhead, either from the In point to the current position of the playhead (the 
Head), or from the current position of the playhead to the Out point (the Tail).
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To cut or copy the head or tail of a clip, and paste the result:
1	 Using these commands, there’s no need to make a partial selection, so you can use 

either the Selection (press A) or Range Selection (press T) modes.

2	 Select the track that contains the clip you want to copy or cut. If one or more tracks are 
already selected, you can use the Control-Option-Up or Down Arrow key shortcuts to 
move the track selection state up or down to the tracks with the clip you want to cut 
or copy.

3	 Move the playhead so that it intersects the clip you want to cut or copy at the frame you 
want to define, either the end of the head or the beginning of the tail. If the playhead 
intersects a clip on a selected track, that clip should automatically become selected. 
You should note that even if you use the mouse to select a clip without selecting a track 
first, you should still move the playhead to intersect the clip you’re copying or pasting, 
as this sets up an important reference point for the operation.

4	 Choose Edit > Cut/Copy Head/Tail to cut or copy the portion of the selected clip you 
want to paste. That portion of the clip will immediately become highlighted.

5	 At this point, there are two things you can do to position the cut or copied head or tail 
of the clip to the position in the Timeline at which you want to paste it:

a	 a ghost clip with waveform that’s “attached” to the playhead at the frame you chose. 
Whether you drag the playhead with your mouse or use JKL to move the playhead 
through the Timeline, the cut or copied clip will move along with it so that moving 
the playhead repositions the cut or copied clip on that track.

b	 If you want to move the cut or copied clip to another track, use the Control-Option-
Up or Down Arrow key shortcuts to change the selected track; the ghost clip will 
move along with change in track selection.

This way, you can use the playhead to align the ghost waveform with other audio clips 
surrounding it in preparation for pasting it.

6	 When the clip is positioned where you want it, press Command-V to paste the clip at 
the position you’ve chosen (you can also right-click a track and choose Paste from the 
contextual menu). The clip becomes solid, and you’re finished.

Paste and Remove Attributes
The Fairlight page has Paste Attributes and Remove Attributes commands that allow for the 
copying and resetting of audio parameters and effects, similar to the same commands on the 
Edit page.

Copying and Pasting Clip Attributes
For clips, this works as simply as copying a clip, then selecting one or more audio clips and 
right-clicking another clip and choosing Paste Attributes from the contextual menu. A dialog 
appears letting you choose which audio attributes you want to paste before clicking Apply.

The Paste Attributes dialog in the Fairlight page
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Copying and Pasting Track Attributes
For tracks, it works a little differently. Right-click on a track header and choose Copy Attributes 
to copy all track settings and effects. Then, select one or more other track headers, right-click 
the selection, and choose Paste Attributes. A dialog appears letting you choose which audio 
attributes you want to paste before clicking Apply.

The Paste Attributes dialog in the Fairlight page, used to copy attributes from one track to another

Removing Attributes
For either clips or tracks, you can right-click and choose Remove Attributes to open a dialog 
with which to choose which attributes you want to reset to their default settings.

Audio Clip Layering
Audio layering is a special audio editing mode that lets you superimpose multiple audio clips in 
the same track, with audio clips edited into the top layers muting overlapping sections of audio 
clips appearing on lower layers. With audio layering enabled, superimposed audio clips are 
treated similarly to superimposed video clips that have opacity set to 100%, with clips on top 
obscuring (or muting) clips underneath. 

An example of multiple audio performance editing using layers, where the 
top layer mutes overlapping sections of audio clips in lower layers

Audio layering is incredibly useful for any situation where you’re combining segments of 
multiple takes together to create a single voiceover, audio vocal track, or dramatic performance, 
as you can choose which segments to use via their superimposed position in the stack of clips 
appearing in that track, while at the same time you’re preserving the other takes underneath in 
case you might want them later.

TIP: Track layering can be used on the Edit page as well.
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To enable audio layering:
Choose Timeline > Layered Audio Editing so that a check mark appears by the 
command. All overlapping audio will be layered instead of overwritten from that 
point forward.

To view audio layering:
1	 Choose View > Show Audio Track Layers to reveal track layers for each audio track 

(and each lane within a given audio track) in the Timeline. When layering is on, space 
appears at the top of each track in the Timeline which provides a region into which you 
can edit layered audio clips.

2	 To edit an audio clip or segment as a layer within a particular audio track, drag it from 
elsewhere in the Timeline or from the Media Pool, and drop it into the empty area 
above whatever audio is already in that track.

Dragging an audio clip to become layered above another clip

3	 Edit the different superimposed layers of audio such that the segments of each 
take that you like are on top. Only the topmost clip segments will be audible. Audio 
segments that overlap underneath are silent. To put another layer on top, drag it from 
its current position to the empty area at the top of the track.

Dragging a bottom audio layer to appear on top

4	 When you’re finished editing clips in track layers, choose View > Show Audio Track 
Layers again to hide the individual layers, so that only the topmost clips appear as a flat 
sequence in each track and lane.

Hiding layers makes all audio layers appear on a single track, as if the top clips are 
overwriting what’s underneath, except the muted material underneath is preserved
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Audio Compound Clips
DaVinci Resolve supports audio compound clips, which are created just like any other 
compound clip, by selecting multiple audio clips, right-clicking one of them, and choosing New 
Compound Clip. Alternately, compound clips with video clips may now contain multiple audio 
items as well. 

When compound clips containing audio are opened in the Edit or Fairlight pages by right-
clicking an audio compound clip and choosing Open in Timeline, breadcrumb controls appear 
beneath the Timeline that let you exit the compound clip and get back to the master Timeline.

Opening an audio compound clip; note the path control at the bottom left of the Timeline

Audio Crossfades
You can add Cross Fade transitions to any edit point between two audio clips that have enough 
handles similarly to how you add video transitions, by dragging and dropping from the Effects 
Library, by right-clicking an edit and choosing an option from the contextual menu, or by 
selecting an audio edit point and choosing Timeline > Add Audio Only Transition (Shift-T). 

Cross Fade transitions are a quick and easy way to fade the volume of the outgoing clip down 
while simultaneously fading the volume of the incoming clip up, letting you create a smooth 
aural transition between two audio clips.

An audio Cross Fade transition applied between two clips

You can double-click a Cross Fade transition to open it into the Inspector, revealing the 
following parameters:

�� Duration: The duration of the transition, shown in both seconds and frames.

�� Alignment: A pop-up that lets you choose the transition’s position relative to the edit 
point it’s applied to. Your choices are “End on Edit,” “Center on Edit,” and “Begin on Edit.”

�� Transition style: You can choose –3dB, 0dB, or +3dB to set both the Fade In and Fade 
Out levels to the same value. For more information on what these levels mean, see the 
following parameter.

�� Fade In/Fade Out levels: There are three options that affect the incoming and outgoing 
halves of the Cross Fade effect independently. 0dB applies a linear fade (this is the 
default). +3dB applies a boosted curve; when applied to both Fade In and Fade Out, 
this can compensate for diminished levels in the middle of a Cross Fade. –3dB applies 
an attenuating curve, which deliberately lowers the level of the Cross Fade.

Crossfades can be created and edited on both the Edit and Fairlight pages.
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Fades and Crossfades
Part of audio editing in the Fairlight page is the use of fades and crossfades. This section shows 
you how to create these effects for smoothly segueing from one audio clip to another.

Using Fades
Like the Edit page, each audio clip has fader handles that appear at the upper right and left 
corners of a clip you’re hovering the pointer over.

Fader handles appear when you 
hover the pointer over a clip

Pulling these handles out creates a fade effect with a duration equal to the length you 
extended the handle.

Creating a fade effect by pulling 
out one of the fader handles

Once you’ve created a fade effect, you can adjust the curve of the fade by dragging 
the handle that appears right on top of the fader curve. Dragging the handle up and 
down affects the angle of the curve, and dragging the handle left and right affects the 
shape of the curve. In this way, you can create all manner of fade effects.

Adjusting the curve of the fade
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Fade In and Out to Playhead
A pair of commands in the Trim menu let you move the playhead over a clip, and use the 
playhead position to “Fade In to Playhead” or “Fade Out to Playhead.” These commands work 
in both the Edit and Fairlight pages.

(Top) Placing the playhead where you want a fade in to end,  
(Bottom) Using Fade In to Playhead

Creating Crossfades With Overlapping Fades
While a fade gradually fades a single track of audio up or down, a crossfade fades two 
overlapping clips at the same time, fading one clip up and another clip down, for the aural 
equivalent of a cross dissolve. There are currently two ways of creating a crossfade in the 
Fairlight page. Both depend on clip layering to allow you to have overlapping fades over 
overlapping clips.

To create a crossfade by overlapping two clips together:
1	 Add a fade out to the end of one clip, and a fade in to the beginning of another clip. 

By default, all fades you add in this way are linear, although you can adjust them to 
whatever gain you want.

Adding fades to adjacent clips

2	 Drag the first clip to overlap the second clip by the length of the fade you’ve created.
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Dragging the clips to overlap, the overlapping 
parts will be preserved via clip layering

3	 Drop the clip. The overlapping fades will both be preserved thanks to clip layering, and 
a crossfade will appear in the Timeline.

The resulting crossfade

To create a crossfade over two clips that are already layered:
Drag a fader handle at the beginning or end of a clip that’s layered, and a crossfade will 
automatically appear.

Creating a crossfade by adjusting the 
fader handle of a layered clip

Using Crossfades From the Edit Page
You can also add crossfades in the Edit page, but they appear in the Fairlight page as 
transitions in the Edit page style.

The resulting crossfade
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Finding Clips in the Media Pool
You can right-click any clip in the Timeline and choose Find in Media Pool to automatically 
select that clip in the Media Pool, for instances where you might want to edit another copy of 
that clip somewhere else in the Timeline, or re-edit another segment from that clip into the 
same area.

Changing Clip Color in the Timeline
You can right-click one or more selected clips in the Timeline to change the clip color, to be 
more organized. For example, you might set production audio clips containing dialog from 
different actors to different colors, or you could set clips with dialog, music, and effects to 
different colors in order to easily differentiate each clip’s purpose.

Editing Audio Clips in External Editors
While working in the Fairlight page, you have the ability to process an audio file using a third-
party application if necessary, in the event you need to use another application’s capabilities to 
create an effect or solve an issue that can’t be accomplished in the Fairlight page itself. To do 
this, you must first add one or more applications to the External Audio Process list in the Audio 
Plug-ins panel of the System Preferences.

The External Audio Process list configured to send audio to Adobe Audition

To add an external audio process:
1	 Open the System tab of the DaVinci Preferences, and select the Audio Plugins panel.

2	 Click the Add button in the “Setup External Audio Processes” section.

3	 To give the audio process a different name, double click in the Name column and type 
a new name.

4	 Double-click in the empty Path column for the new process, and choose an application 
to assign to that process from the dialog.

5	 Choose the type of process you want it to be from the pop-up menu in the Type column.
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Once you have one or more external audio applications configured in Preferences, you can use 
them to process any audio clip in the Fairlight page by right-clicking an audio clip and choosing 
the application you want to use from the External Audio Process submenu of the 
contextual menu.

When you do this, a duplicate of the audio clip media is copied (bounced) to the directory 
location specified by the “Save clips to” field of the Capture and Playback panel of the Project 
Settings. At that point, the external application is either opened or launched as a command 
from the command line (depending on how the external application has been configured in 
Preferences). 

Once the bounced audio is opened in the external application, you can process it however you 
need to and bake in any changes made by saving/rendering/outputting and overwriting the 
original copied audio media file. DaVinci Resolve detects when changes have been made, and 
the altered result is automatically reimported as an additional audio layer on top of the original 
clip in the Timeline.

The way an audio application is configured in the DaVinci System Preferences dictates how the 
bounced audio file is passed to the external program. There are three choices: 

�� Command Line: As a command line parameter, if your audio application is able to be 
run from the Terminal.

�� Clipboard: By placing the path to the bounced file in the clipboard, so you can paste 
it into the application which has been automatically launched, or import it via a File > 
Open dialog.

�� Reveal: By revealing the bounced copy in the file manager of your workstation, so you 
can drag and drop it onto the application which has been automatically launched.

Sample Editing
You can zoom quite far into audio clips on the Fairlight page timeline, until you see the 
individual samples that comprise the audio waveform of each clip. Samples are represented by 
control points once you’ve zoomed in far enough. 

When you zoom in far enough, you can see the individual samples of an audio clip as control points

You can non-destructively edit these control points to eliminate clicks and pops, and to effect 
other fixes to problem audio clips. 

Methods of editing audio samples:
�� To see the editable audio samples: Zoom all the way into an audio clip until you see 

the sample control points, using either Command-Plus or Command-Minus, the scroll 
wheel of your pointing device, or by holding down the ZOOM button of your Fairlight 
editing panel and turning the JOG/EDITING wheel.

�� To edit a single audio sample: Click and drag that audio sample up or down to change 
its height.
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�� To edit a section of samples: Click and drag horizontally left or right across the 
samples you want to edit to “redraw” the waveform any way you’d like.

Black points show the previous levels when samples have been edited in a clip

Sample editing can be undone, just like any other editing procedure, as the edited sample 
points are stored non-destructively within the DaVinci Resolve project.
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Chapter 129

Audio Clip 
Specific Inspector 
Adjustments

Each audio clip in a track has individual settings that are specific to 
that clip, which can be adjusted and animated in the Inspector. 
This makes it easy to adjust the levels and EQ of several clips to match 
one another, while reserving the track level for your overall mix. 
An additional set of clip-specific pitch controls make it easy to make 
small pitch adjustments, either static or keyframed, where necessary. 

This chapter describes how to use these clip-specific controls.
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Audio Settings in the Inspector
Each selected clip, and each selected Main, Submix, or Auxiliary bus channel strip in the Mixer 
exposes some simple audio-related parameters in the Audio panel of the Inspector.

�� Clip Volume: Each clip has a single volume control, which corresponds to the volume 
overlay over each audio clip.

�� Clip Pan: (Only exposed for clips) A simple Pan slider that controls stereo panning.

�� Clip Pitch: (Only exposed for clips) Each clip has two pitch controls, for altering clip 
pitch without altering clip speed. You can control pitch in Semi Tones and Cents.

�� Clip Equalizer: (Only exposed for clips) Each clip also has a four-band EQ, complete 
with low-pass, high-pass, and parametric settings for fine tuning and problem-solving 
audio issues at the clip level.

�� Audio Effects: If you’ve applied any FairlightFX, VST plug-ins, or Audio Unit plug-ins, 
those controls will also appear in the Inspector. For more information, see Chapter 132, 
“Audio Effects.”

Additionally, when you apply other audio plug-ins from the Audio FX panel of the Effects 
Library, additional parameters and controls are exposed (covered towards the end of 
this chapter).

Making Adjustments in the Inspector
Clip-specific Volume, Pan, Pitch, and Equalization are adjusted and can be animated in the 
Inspector. This section walks you through how this works.

Using the Inspector
Audio clips in the Fairlight page expose similar controls to those found in the Audio Inspector 
Panel of the Edit page. Additionally, the Inspector will display controls for audio plug-ins that 
you apply to clips as well. All parameters are organized into groups, with a title bar providing the 
name of that group, along with other controls that let you control all parameters within that 
group at the same time. 

Closed and open Inspector group controls in the Fairlight page

Chapter – 129  Audio Clip Specific Inspector Adjustments 2509



These controls include:

�� Enable button: A toggle control to the left of the parameter group’s name lets you 
disable and re-enable every parameter within that group at once. Orange means that 
track’s enabled. Gray is disabled.

�� Parameter group title bar: Double-clicking the title bar of any group of parameters 
collapses or opens them. Even more exciting than that, Option-double-clicking the title 
bar of one parameter group collapses or opens all parameter groups at once.

�� Keyframe and Next/Previous Keyframe buttons: This button lets you add or remove 
keyframes at the position of the playhead to or from every single parameter within the 
group. When the button is highlighted orange, a keyframe is at the current position of 
the playhead. When it’s dark gray, there is no keyframe. Left and right arrow buttons let 
you jump the playhead from keyframe to keyframe for further adjustment.

�� Reset button: Lets you reset all parameters within that group to their default settings.

Making Simple Adjustments
Every group of controls in the Inspector largely consists of sliders, checkboxes, pop-up menus, 
buttons, and the occasional custom control.

Adjusting Multiple Clips at the Same Time
There’s an easy way to make adjustments to the Inspector parameters of multiple clips at the 
same time, without needing to use Paste Attributes (described later in this chapter). All you 
need to do is simultaneously select every clip you want to alter, and then modify the parameter 
in the Inspector that you want to change. As a result, every selected clip will be adjusted by the 
same amount. This works for compositing effects, transforms, text parameters, filters, and audio 
settings, just about anything that can be simultaneously exposed in the Inspector for multiple 
selected clips.

When you select multiple clips, the Inspector will display “Multiple Clips” as the title. If each of 
the selected clips have different values in the parameter you’re adjusting, that parameter will 
have two dashes in the value field. There are two ways you can make adjustments to 
multiple clips:

�� If you want to make a relative adjustment to all selected clips while keeping their 
original offsets from one another, then drag the virtual slider in the parameter field 
which will display a + or – before however many units your adjustment is.

�� However, if you want to set all selected clips to the same value, you can double-click in 
the number field, type the value, and press Return.
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Making a relative adjustment of plus 4.00 
in the Volume level of all selected clips

Animated Inspector Adjustments
Keyframing in the Edit page works slightly differently than when using the Keyframe Editor in 
the Color page. Most simple keyframing tasks can be performed in the Inspector using three 
buttons that appear to the right of any parameter that’s capable of being keyframed. It takes 
two keyframes at minimum to create an animated effect.

The three keyframe controls that 
appear in the Inspector, from left to 
right: Previous keyframe, Create/
Delete keyframe, Next keyframe

Methods of keyframing parameters in the Inspector:
�� To add a keyframe: Select a clip, open the Inspector, then move the Timeline playhead 

to the frame where you want to place a keyframe, and click the Keyframe button next 
to the parameter of the Inspector you want to animate. Once you’ve added at least 
one keyframe to a parameter, all other adjustments you make to parameters in the 
Inspector, or using the onscreen Transform/Crop controls in the Timeline Viewer, add 
new keyframes automatically if the playhead is at another frame.

�� To move the playhead to the next or previous keyframe: Click the small left- or right-
hand arrow to either side of a parameter’s keyframe control to jump the playhead to the 
next or previous keyframe. You can also press Right-Bracket ( [ ) and Left-Bracket ( ] ) to 
go from keyframe to keyframe.

�� To edit an existing keyframe of a parameter: Move the playhead to be on top of the 
keyframe you want to edit, and then change that parameter, either in the Inspector, or 
using the onscreen controls of the Timeline Viewer.
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Methods of changing keyframe interpolation in the Inspector:
�� To change a keyframe to Ease In or Ease Out: Eased keyframes create animated 

changes that begin slowly and accelerate to full speed, or slow down gradually to 
decelerate to a stop. This only works when you have two or more keyframes creating 
an animated effect. Move the playhead to a frame with a keyframe using the next/
previous keyframe controls, then right-click the orange keyframe button and choose 
Ease In, Ease Out, or Ease In and Out, depending on which keyframe you’re editing and 
the effect you want to create.

�� To change a keyframe to Linear: Move the playhead to a frame with a keyframe using 
the next/previous keyframe controls, then right-click the orange keyframe button and 
choose Linear.

Methods of deleting keyframes and disabling keyframed effects:
�� To delete a single keyframe: Open the Inspector, move the Timeline playhead to a frame 

with a keyframe, and click the orange Keyframe button in the Inspector to delete it.

�� To delete all keyframes for one parameter: Click the reset button to the right of a 
parameter’s keyframe control in the Inspector.

�� To delete all keyframes in a group of parameters in the Inspector: Click the reset 
button to the right of a parameter group’s title bar in the Inspector.

�� To disable or enable a single parameter’s keyframed effect: In the Timeline, click the 
toggle control at the left of a parameter’s keyframe track. Orange means that track’s 
enabled. Gray is disabled.

�� To disable or enable a group of parameters in the Inspector: Click the toggle control 
at the left of a parameter group’s title bar in the Inspector. Orange means that group is 
enabled. Gray is disabled.

Paste and Remove Attributes
The Fairlight page has Paste Attributes and Remove Attributes commands that allow for the 
copying and resetting of audio Inspector parameters and effects, similar to the same commands 
on the Edit page. For more information on how to do this, see Chapter 128, “Editing Basics in 
the Fairlight Page.”

Seeing Effects in the Timeline
When you adjust any clip’s Inspector controls, or add any kind of plug-in to a clip in the 
Timeline, be it an adjustment in the Inspector or a plug-in you’ve applied, clips with that effect 
applied appear a darker shade of whatever color they are. Removing all effects from a clip (for 
example, using the Remove Attributes command) returns that clip to its original color. This 
makes it easy to see, at a glance, which clips have effects, and which clips don’t.

A closeup of the Timeline with a darker clip with effects between 
two other regularly-colored clips without effects
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Setting Clip Volume
Each audio clip, or audio item in the case of audio clips with linked audio on multiple tracks, has 
its own Volume level. This means that audio clips with multiple channels share a common 
Volume setting. There are several ways you can adjust these levels simply.

Adjusting Volume in the Inspector
Each clip has individual Volume parameters that are accessible in the Audio panel of the 
Inspector when one or more audio clips are selected.

The Volume parameters available for 
audio clips in the Inspector

Selecting an audio clip in the Timeline and adjusting its Volume only alters the volume levels of 
that clip, which lets you adjust basic levels for individual clips in your program. The Volume 
control affects every channel within that clip simultaneously. 

If you select multiple clips in the Timeline, then adjusting the Volume or Pan sliders or virtual 
sliders for all of them simultaneously will make a relative adjustment to all of the clips, 
preserving their offsets from one another. If you want to set all clips to the same level, then 
making a numeric adjustment will set all selected clips to the same absolute level.

Adjusting Volume in the Timeline
Each clip (or item) of audio in the Timeline has a Volume overlay that lets you set that clip’s level 
by simply dragging it up or down with the pointer. This overlay corresponds to the Volume 
parameter in the Inspector.

Dragging a Volume overlay to adjust the clip level

Additionally, you can click any clip’s Audio Curve Editor button, at the bottom right-hand corner 
of each audio clip, to open an audio-specific Curve Editor with which you can keyframe not just 
Volume, but Pan, and the parameters of any audio filters you might have applied to that clip.

Adding and Adjusting Volume Keyframes in the Timeline
Mixing audio by adding and adjusting individual keyframes can be a fast and effective way of 
balancing clip levels with one another and of fixing clip-specific dynamic level problems. When 
manually editing any audio parameter curve, you can use the following procedures.
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Methods of adjusting the Volume curve using the pointer:
�� To adjust any curve segment: Position the pointer over the overall segment for clips 

with no keyframes, or position it between any two keyframes, directly on top of the 
curve segment you want to raise or lower. When the move cursor is displayed, click and 
drag up to raise the Volume, or down to reduce the Volume.

�� To add keyframes to the level curve: Hold the Option key down and click the curve 
to place a keyframe at that frame. You must add at least two keyframes to create an 
automated change in Volume.

�� To adjust a keyframe in any direction: Move the pointer over a keyframe so that the 
four-way cursor appears, and then click and drag up or down to change the Volume, or 
side to side to change it’s timing.

�� To adjust a keyframe in only one direction: Move the pointer over a keyframe so 
that the four-way cursor appears, and then click and drag in the intended direction 
of adjustment, either vertically to change the volume of the clip at that frame, or 
horizontally to move the keyframe to a different point in time. Once you start dragging a 
keyframe into a particular direction, keyframe movement is constrained in that direction 
until you release that keyframe.

�� To select one or more keyframes: Click any keyframe to select it. 

�� To select multiple discontiguous keyframes: Command-click all keyframes you want to 
select, whether they’re next to one another or not.

�� To select multiple contiguous keyframes: Click the first keyframe you want to select, 
and then shift-click the last keyframe you want to select, and all keyframes between will 
also be selected.

Normalize Audio Levels Command
The Normalize Audio Levels command automatically adjusts the level of clips to peak at a 
specific target level, measured in dBFS. This is only a volume adjustment; no dynamics are 
applied, so the result of using this command is that the loudest parts of each selected clip are 
going to match one another at the target level. This command is also available in the Edit page.

To normalize one or more selected audio clips:
1	 Right-click one of the selected clips and choose Normalize Audio Levels

2	 A dialog appears with two options. Choose the Reference Level that you want to set 
the peak volume of the selected clips to match, and then choose how you want to set 
the level of multiple selected clips:

–– When Set Level is set to Relative, all selected clips are treated as if they’re one clip, 
so that the highest peak level of all selected clips is used to define the adjustment, 
and the volume of all selected clips is adjusted by the same amount. This is good if 
you have a series of clips, such as a dialog recording, where the levels are consistent 
with one another, and you want to normalize all of them together.

–– When Set Level is set to Independent, the peak level of each clip is used to define 
the adjustment to that clip, so that the volume of every selected clip is adjusted by 
an amount specific to that clip. The end result may be a set of very different volume 
adjustments intended to make the peak levels of each audio clip match one another. 
This is good if, for example, you’re trying to balance a series of different sound 
effects with one another that have very different starting levels.
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Clip Pan
Each audio clip in the Timeline has a simple stereo Pan control that lets you pan that clip. 
While most professional mixes will restrict panning to the more robust panner found in the 
Fairlight page Mixer, this simple clip-based Pan control is useful for editors of visuals working in 
the Edit page to quickly create simple panning effects to aid in a craft edit. Dragging the slider 
lets you pan audio left to right. This control is centered at 0 by default.

Clip Pan Control

Clip Pitch Controls
Each audio clip in the Timeline has Clip Pitch controls that let you alter the pitch of a clip without 
changing the speed. Two sliders let you adjust clip pitch in Semi Tones (large adjustments, a 
twelfth of an octave) and Cents (fine adjustments, 100th of an octave).

Clip Pitch control in the Inspector

Clip EQ
Each audio clip in the timeline has a four-band equalizer that has both graphical and numeric 
controls for boosting or attenuating different ranges of frequencies within that clip, before it 
even gets to the EQ built into the mixer. Each band has controls for the filter type (Bell, Lo-Shelf, 
Hi-Shelf, Notch), Frequency, Gain, and Q-factor (sharpness of the band), with the available 
controls for each band of EQ changing depending on the filter type.

When a channel strip’s EQ is enabled, the EQ button displays the equalization curve that’s 
being applied. This indicator cannot be adjusted; you must open the EQ window to 
make modifications.

The channel strip’s EQ indicator, (Left) EQ is at detent, (Right) EQ is adjusted
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Master EQ Controls
The Equalizer window has the following overall controls:

�� Enable button: Turns the overall EQ effect off and on, without resetting the controls.

�� Reset button: Resets all controls of the EQ window to their defaults.

Graphical EQ Controls
A graph at the top shows a curve with handles that correspond to each of the enabled EQ 
bands listed below. You can drag any numbered handle to boost or attenuate the range of 
frequencies governed by that band, using whatever type of equalization that band has 
been set to.

The EQ graph with user-draggable handles

Dragging the numbered handles on this graph in turn modifies the parameters of the 
corresponding band, and changing each band’s parameters will also alter the EQ graph, which 
serves the additional purpose of providing a graphical representation of the equalization being 
applied to that track.

Bands 1 and 4
The outer two sets of band controls let you make high-pass and low-pass adjustments, 
if necessary.

�� Band enable button: Turns each band of EQ on and off.

�� Band filter type: Bands 1 and 4 can be switched among four specific filtering options 
for processing the lowest or highest frequencies in the signal. These include (from 
top to bottom) Hi-Shelf, Hi-Pass, Lo-Pass, and Lo-Shelf.

�� Freq: Adjusts the center frequency of the EQ adjustment.

�� Gain: Adjusts the amount by which the affected frequencies are affected. Negative 
values attenuate those frequencies, while positive values boost those frequencies.

Bands 2 and 3
�� The middle two sets of band controls let you make a wide variety of equalization 

adjustments.

�� Band enable button: Turns each band of EQ on and off.

�� Band filter type: Bands 2–5 can be switched among four different filtering options 
(from top to bottom): Lo-Shelf, Bell, Notch, and Hi-Shelf.

�� Frequency: Adjusts the center frequency of the EQ adjustment.
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�� Gain: Adjusts the amount by which the affected frequencies are affected. Negative 
values attenuate those frequencies, while positive values boost those frequencies.

�� Q Factor: Adjusts the width of affected frequencies. Lower values include a wider 
range of frequencies; higher values include a narrower range of frequencies.

Paste and Remove Attributes 
for Clips and Tracks
The Fairlight page has Paste Attributes and Remove Attributes commands that allow for the 
copying and resetting of audio parameters and effects, similar to the same commands on 
the Edit page.

The Paste Attributes dialog in the Fairlight page
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Chapter 130

Mixing in the 
Fairlight Page

The Mixer is the spider at the center of the web that is the Fairlight page, 
and provides the primary tools you’ll use to mix the various audio tracks of 
your program into a harmonious whole using EQ, Dynamics, Panning, level 
control, and VST and Audio Units audio effects of all kinds, all with full 
automation, to hone your sound and balance each track’s elements with 
the others. This chapter focuses on explaining the various functions of the 
Mixer so you can harness its power for yourself.

Chapter – 130  Mixing in the Fairlight Page 2518



Introduction to Mixing	 2521

The Mixer	 2521

Tracks and Buses	 2521

Customizing the Onscreen Mixer Controls	 2522

Showing and Hiding Channel Strips Using the Index	 2523

Selecting Channel Strips and Tracks	 2523

Track Organization	 2524

Input	 2524

Effects	 2525

Insert	 2525

EQ	 2525

Master EQ Controls	 2526

Graphical EQ Controls	 2527

Bands 1 and 6	 2527

Bands 2–5	 2528

Dynamics	 2528

Master Dynamics Controls	 2529

Expander/Gate	 2529

Compressor	 2530

Limiter	 2533

Aux	 2533

Pan	 2534

The Stereo and Surround Pan Controls	 2534

The 3D Audio Pan Controls	 2535

Bus Assignment Buttons	 2536

Fader Groups (VCA Groups)	 2537

Making Fader Group Assignments	 2537

Using Fader Groups	 2538

Recording Fader Automation for Groups	 2538

Arm, Solo, and Mute Buttons	 2538

Fader Controls	 2539

Bouncing Audio	 2540

Third-Party Control Panel Support for Mixing	 2541

Contents

Chapter – 130  Mixing in the Fairlight Page 2519



Introduction to Mixing
This chapter describes the use of the Mixer to adjust the levels and fine-tune the audio of each 
track in the timeline. It’s focused on the function of the channel strip controls, with the 
following exceptions:

�� For more information about busing, see Chapter 124, “Setting Up Tracks, 
Buses, and Patching.”

�� For more information about recording audio, see Chapter 126, “Recording.”

�� For more information about recording automation, see Chapter 131, 
“Automation Recording.”

The Mixer
The Audio Mixer provides a set of graphical controls you can use to assign track channels to 
output channels, adjust EQ and dynamics, set levels and record automation, pan stereo and 
surround audio, and mute and solo tracks. At its most basic, each audio track in your timeline 
corresponds to an individual channel strip in the Mixer, and by default there’s a single Main bus 
labeled M1 that combines all these tracks into an overall mix.

The Audio Mixer, with channel strips 
corresponding to the tracks in the Timeline

Tracks and Buses
Once you start creating buses, the Audio Mixer exposes two sets of channel strips. The 
leftmost set of channel strips correspond to the audio tracks in the Timeline, while the 
right‑most set of channel strips expose sets of controls for each Main, Sub (submix), and Aux 
(auxiliary) bus that you’ve created. 
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The Audio Mixer is divided into two sections, one for tracks (at left) and one for buses (at right)

If you have more tracks and buses than can be displayed all at once given the width of your 
computer display, then each half of the mixer has independent scroll bars so you can choose 
which tracks and which buses you want to see next to one another.

Each audio track’s channel strip has a set of Main and Sub bus buttons that let you assign the 
audio output by that channel strip to a Sub (typically used to combine different subsets of tracks 
into submixes) or to a Main (typically used to output or render overall mixes). Each Sub and 
Aux’s channel strip has a set of Main buttons so that different combinations of Subs can be 
assigned to each Main. Main channel strips have no buttons because, from a busing 
perspective, they’re the final output.

Main and Submix buttons let you assign tracks to buses, and buses to other buses

Customizing the Onscreen Mixer Controls
The Option menu at the upper right-hand corner of the Mixer provides a number of different 
options for customizing the look of the Mixer, as well as which controls are shown or hidden.

First, you have the options of showing the Full Track Mixer or the Small Track Mixer. While the 
Full Track Mixer provides more room for buttons and controls that are large enough you don’t 
have to squint to see them, the Small Track Mixer lets you have many more channel strips 
onscreen at one time, for those times where you’re doing incredibly ambitious mixes.

The Small Track Mixer view
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Second, there’s an option to Show Labels, which are the control names listed in a column to the 
left of the mixer channel strip area. If you’re first getting started, these Labels are useful, but 
once you’ve gotten used to the layout of the Mixer, hiding these will give you a bit more room to 
work with for another channel strip or two.

Third, there’s a set of options that let you toggle the visibility of specific channel strip controls, 
so you can hide controls you know you’re not going to be using, or that you’ve used but no 
longer need to adjust or want to protect from accidental adjustment by a wandering 
mouse or pen.

Showing and Hiding Channel Strips Using the Index
You can use the Tracks panel of the Index to hide tracks you don’t need to work on in order to 
create more room for tracks you need to see. To quickly show or hide a number of tracks, you can 
click and drag over the eyeball button of each track for which you want to reverse the visibility.

The Tracks panel of the Index hiding tracks 
1–4 on both the Timeline and the Mixer

Selecting Channel Strips and Tracks
When you select a track in the Timeline, you also select that track’s accompanying channel 
strip, and vice versa. It’s possible to select multiple tracks in the Timeline and thereby select 
multiple channel strips, but you can also Command-click to select multiple channel strips in 
order to select multiple tracks. 

Selecting multiple channel strips results in the selection of multiple tracks
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Track Organization
Each channel strip has three organizational properties that let you keep track of which channel 
strip is responsible for which part of the mix.

�� Track color: Each track can be differently color-coded, to help you keep organized. 
These colors appear in the timeline track header, the mixer, and the meters to help you 
keep track of which track corresponds to which channel strip and meter.

�� Track number: The number of the timeline audio track corresponding to each channel 
strip appears here.

The track color and track number appear at the top of each channel strip

�� Track name: This mirrors the track name found in the header controls of the timeline. If 
you customize an audio track’s name in the timeline, that name appears here.

Each track’s name appears between the assignment 
buttons and the arm/solo/mute buttons

Input
A pop-up menu that lets you patch inputs, patch buses, and configure the input settings of 
audio signals routed through Blackmagic hardware interfaces.

The Input pop-up menu provides 
shortcuts for patching different buses 
using the Patch Input/Output window

For more information on using the options of the insert menu, see Chapter 124, “Setting Up 
Tracks, Buses, and Patching.”

Chapter – 130  Mixing in the Fairlight Page 2523



Effects
When you apply VST or Audio Unit effects to a track from the Effects Library, those effects 
appear here. Clicking the Plus button opens a pop-up menu with which you can apply any VST 
or AU effects installed on your machine to that track. 

Moving the pointer over the plus to add effects

Hovering the mouse over any listed effect reveals controls for enabling/disabling each effect, 
opening an effect’s custom controls, and deleting that effect.

Moving the pointer over 
an effect reveals controls 
for that effect

For more information on using audio effects, see Chapter 132, “Audio Effects.”

Insert
Enables the routing of effects from Blackmagic audio interface hardware to outboard effects 
boxes and back again. This button can be toggled to enable/disable such routing.

EQ
Double-clicking exposes a four-band parametric equalizer with additional Hi and Lo Pass filters, 
that has both graphical and numeric controls for boosting or attenuating different ranges of 
frequencies of audio on each track. You can select from among four types of EQ filtering from 
the Equalizer Type pop-up menu, with options for Earth (the default), Air, Ice, and Fire. Each 
band has controls for the filter type (Bell, Lo-Shelf, Hi-Shelf, Notch), Frequency, Gain, and 
Q-factor (sharpness of the band), with the available controls for each band of EQ changing 
depending on the filter type.
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The channel strip EQ window

When a channel strip’s EQ is enabled, the EQ button displays the equalization curve that’s 
being applied. This indicator cannot be adjusted, you must open the EQ window to 
make modifications.

The channel strip’s EQ indicator, (Left) EQ is adjusted, (Right) EQ is detent

Master EQ Controls
The Equalizer window has the following overall controls:

�� Enable button: Turns the overall EQ effect off and on, without resetting the controls.

�� Reset button: Resets all controls of the EQ window to their defaults.

�� Equalizer Type: Changes the EQ control functionality to emulate different EQ 
characteristics from “classic” mixing consoles. There are four options:

–– Earth: (Default) Native Fairlight controls

–– Air: Emulates the SSL 4K

–– Ice: Emulates the Neve V

–– Fire: Emulates the Focusrite

�� Gain fader: A post-EQ level control that lets you boost or attenuate the signal to 
compensate for the EQ adjustment you’re making raising or lowering the level.
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Graphical EQ Controls
A graph at the top shows a curve with handles that correspond to each of the enabled EQ 
bands listed below. You can drag any numbered handle to boost or attenuate the range of 
frequencies governed by that band, using whatever type of equalization that band has 
been set to.

The EQ graph with user-draggable handles

Dragging the numbered handles on this graph in turn modifies the parameters of the 
corresponding band, and changing each bands parameters will also alter the EQ graph, which 
serves the additional purpose of providing a graphical representation of the equalization being 
applied to that track.

Bands 1 and 6
The outer two sets of band controls let you make high-pass and low-pass adjustments, if 
necessary. They’re off by default.

The Band 1 and 6 controls

�� Band enable button: Turns each band of EQ on and off.

�� Band filter type: Bands 1 and 6 can be switched among four specific filtering options 
for processing the lowest or highest frequencies in the signal. These include (from top 
to bottom) Hi-Shelf, Hi-Pass, Lo-Pass, and Lo-Shelf.

�� Frequency: Adjusts the center frequency of the EQ adjustment

�� Gain: Adjusts the amount by which the affected frequencies are affected. Negative 
values attenuate those frequencies, while positive values boost those frequencies.

Chapter – 130  Mixing in the Fairlight Page 2526



Bands 2–5
The middle four sets of band controls let you make a wide variety of equalization adjustments. 
They’re on by default, to make it easy to begin making adjustments.

The Band 3 controls

�� Band enable button: Turns each band of EQ on and off.

�� Band filter type: Bands 2–5 can be switched among four different filtering options 
(from top to bottom) Lo-Shelf, Bell, Notch, and Hi-Shelf

�� Frequency: Adjusts the center frequency of the EQ adjustment

�� Gain: Adjusts the amount by which the affected frequencies are affected. Negative 
values attenuate those frequencies, while positive values boost those frequencies.

�� Q Factor: Adjusts the width of affected frequencies. Lower values include a wider 
range of frequencies, higher values include a narrower range of frequencies

Dynamics
Double-clicking exposes a set of dynamics controls with three sets of controls corresponding to 
an Expander or Gate, a Compressor, and a Limiter that can be used separately or in concert to 
manage the dynamics of the audio on that track.

The channel strip Dynamics control window
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When you enable whatever combination of dynamics controls you need for that track, the 
dynamics graph updates with curves that show you how the signal is being affected by the 
Expander or Gate, Compressor, and/or Limiter settings that are being applied.

The dynamics graph shows how the signal 
is being affected by the current settings

With these dynamics enabled, the Dynamics button on the channel strip displays these curves, 
so you know what’s happening to that channel. This indicator cannot be adjusted, you must 
open the Dynamics window to make modifications.

The channel strip’s Dynamics 
indicator, (Left) Dynamics at 
detent, (Right) Dynamics adjusted

Master Dynamics Controls
The Dynamics window contains the following overall controls at the top of the window:

�� Reset button: Resets all controls of the EQ window to their defaults.

�� Make Up fader: A post-Dynamics level control that lets you boost the signal to 
compensate for dynamics settings that have lowered the level.

Expander/Gate
The first of three sets of dynamics parameters, these controls can be switched between 
expansion and gating. Expansion emphasizes differences in volume by lowering the level of 
soft parts of the signal relative to the level of louder parts, and can be used to minimize noise 
while increasing the dynamic range of a signal. Gating reduces the level or even silences parts 
of a signal that fall below a certain level threshold in order to reduce or eliminate noise in quiet 
parts of a recording.
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�� Expander: A button that lets you enable these controls and switch them to 
perform expansion.

–– Threshold: Sets the signal level below which gain reduction occurs. Defaults to 
–35dB. The range is from –50 to 0dB.

–– Range: Unused for expansion.

–– Ratio: Sets the gain reduction ratio (input to output) that’s applied to signals which 
fall below the threshold level. Defaults to 1:1.1. The range is 1.0:1 to 10:1.

–– Attack: Adjusts how quickly the sidechain detector applies expansion when a signal 
exceeds the threshold. Defaults to 1.4mS (milliseconds). The range is 0 to 100mS.

–– Hold: Keeps dynamics from being triggered again until a certain amount of time has 
passed, in mS. Defaults to 0mS. The range is from 0 to 4000mS.

–– Release: Adjusts how quickly or gradually the sidechain detector stops applying 
dynamics when a signal goes back below the threshold. Defaults to 93mS. The 
range is 0.03 to 4.03mS.

�� Gate: A button that lets you enable these controls and switch them to perform gating.

–– Threshold: Sets the signal level below which gain reduction occurs. The range is 
from –50 to 0dB.

–– Range: Sets the maximum amount of gain reduction that will be applied when the 
signal falls below the gate threshold. Once the signal has fallen below the level 
determined by the gate threshold minus the gate range, no gain reduction is applied. 
The default is 18. The range is from 0 to 60.2dB.

–– Ratio: Unused for gate.

–– Attack: Adjusts how quickly the sidechain detector applies gating when a signal 
exceeds the threshold. Defaults to 1.4mS. The range is 0 to 100mS.

–– Hold: Keeps dynamics from being triggered again until a certain amount of time has 
passed, in mS (milliseconds). Defaults to 0mS. The range is from 0 to 4000mS.

–– Release: Adjusts how quickly or gradually the sidechain detector stops applying 
dynamics when a signal goes back below the threshold. Defaults to 93mS. The 
range is 0.03 to 4.03mS.

Compressor
The second set of dynamics parameters let you apply compression, which detects the 
envelope of an audio signal in order to automatically change its level. Typically used to detect 
and reduce the peaks of an audio signal so that the overall level can be boosted without 
clipping, thus reducing the dynamic range of a given signal. Compression is often used to allow 
voices to have more presence within a mix, and to smooth out changes in the levels of tracks 
with too much dynamic range for the task at hand.

�� Compressor: A button that lets you enable compression.

–– Threshold: Sets the signal level above which compression is applied.  
The default is –15dB. The range is –50 to 0dB.

–– Ratio: Adjusts the compression ratio. This sets the gain reduction ratio (input to 
output) applied to signals which rise above the threshold level. The default is 2.0:1. 
The range is 1.0:1 to 10:1.

–– Attack: Adjusts how quickly the sidechain detector applies compression when a 
signal exceeds the threshold. The default is 1.4mS (milliseconds). The range is 0 to 
100mS.
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–– Hold: After the attack phase has been completed, the Hold parameter controls how 
long this initial attenuation is maintained, before entering the release phase. Defaults 
to 0mS. The range is from 0 to 4000mS.

–– Release: Adjusts how quickly or gradually the sidechain detector stops applying 
dynamics when a signal goes back below the threshold. The default is 93mS. The 
range is 0.03 to 4000mS.

�� Send: Enable Send when you want to use the audio levels of the currently selected 
track to attenuate those of another track using sidechain compression. For example, 
you can turn on the compressor and enable Send for all tracks with dialog, in order to 
use those levels to attenuate the levels of another track containing music. 

�� Listen: Enable Listen when you want to use the audio levels of tracks that you set 
to Send to attenuate the levels of the currently selected track. If there are no tracks 
with Send enabled, then the current track is compressed as usual, using itself as the 
sidechain.

The following procedure shows how to set up a Compressor to automatically attenuate, or 
“duck” a music track whenever someone speaks in clips on one or more other tracks of 
the Timeline.

To use sidechain compression to automatically “duck” music 
in the presence of dialog on other tracks:

1	 Edit dialog into one track of the Timeline, and edit overlapping music into another track 
of the Timeline.

Choosing the track header in the Fairlight timeline to add Dynamics

2	 Click the track header or channel strip of a track with dialog to select that track, and 
then double-click the Dynamics indicator on the channel strip to open the Dynamics 
window.

3	 Turn on the Send button to automatically send all levels from that track to the sidechain 
of a Compressor on another track (it’s not necessary to turn on Compressor for this). If 
you hover the pointer over the Send button, a tooltip will show you which tracks of the 
current timeline are set to Send.

4	 If you have multiple tracks with dialog, you can repeat steps 2-3 for each so that the 
output levels of all dialog are sent to the sidechain.
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Turning on Send in the 
Compressor of a track with dialog

5	 Next, click the track header or channel strip of a track with music to select that track. If 
you haven’t closed the Dynamics window, the header will show you that the Dynamics 
controls are now those of the newly selected track.

6	 Turn on Compressor, and then turn on the Listen button to automatically feed all “sent” 
levels to the sidechain of the Compressor on this track. If you hover the pointer over 
the Listen button, a tooltip will show you which tracks of the current timeline are set to 
Listen.

7	 At this point, you need to lower the Threshold and raise the Ratio controls to the 
appropriate levels so that as dialog is heard, the music is compressed to be less loud. 
You may also want to raise Hold so this gain reduction doesn’t fluctuate too wildly, and 
raise Release so the volume adjustment doesn’t end too abruptly.

Turning on Listen in the 
Compressor of a track with music

If you’ve set this up correctly, then during playback the Sidechain meter should show 
the levels of the dialog tracks with Send enabled, and the Gain Reduction meter should 
show you how much the gain of the music track is being reduced when triggered by the 
dialog being fed to the Sidechain. 

As a result, you should hear that whenever speech plays, the music volume is 
automatically lowered. Adjust Threshold and Ratio to set the amount of this gain 
reduction, and adjust Attack, Hold, and Release to set how quickly gain reduction 
responds to changes in the Sidechain level (as defined by the Send levels).
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Limiter
The third set of dynamics parameters let you apply limiting, which imposes a hard limit on the 
maximum level allowed for a particular signal.

�� Limiter: A button that lets you enable Limiting.

–– Threshold: Sets the maximum allowable output level. The default is –21dB. 
The˛range is from –50 to 0dB.

–– Attack: Adjusts the attack rate time constant of the sidechain detector. The default is 
0.71mS. The range is 0 to 100mS.

–– Hold: Keeps dynamics from being triggered again until a certain amount of time has 
passed, in mS (milliseconds). Defaults to 0mS. The range is from 0 to 4000mS.

–– Release: Adjusts how quickly the sidechain detector stops applying dynamics when 
a signal goes back below the threshold. The default is 90mS. The range is 0.03 to 
4.03mS.

Aux
Lets you route that track’s channels through an Aux send bus. Each Aux bar corresponds to a 
specific Aux bus that you created. Double-clicking any of these bars opens up the Auxiliaries 
window, with which you can enable or disable auxiliaries, set each one to be routed pre the 
channel strip or post the channel strip (the default), and set the send level and pan value for 
each Aux bus. The controls for multiple Aux buses appear stacked within a single window.

The Auxiliaries control window for a mix with two Aux Buses

Each Aux bus you create exposes the following controls in the Auxiliaries window:

�� On: Turns that Aux send on or off.

�� Pre: Switches that Aux send to be processed either pre or post fader. Turning this 
button on enables that track to send levels to the Aux bus before level adjustments on 
that track are applied. One common use of this is to enable a plug-in applied by the 
Aux bus to continue to produce a “wet” version of that track’s audio while the mixing 
level is set all the way down, while raising the mixing level up mixes a “dry” version of 
the audio track against the “wet” levels produced by the Aux bus effect. For example, 
with Pre turned on you could slowly mix fade the original track level up over time over 
an Aux bus with a Delay effect to create the illusion that the echos of someone talking 
down a long hallway are giving way to a character’s own voice as they walk closer to 
the microphone.
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�� Send Level: Adjusts the amount of signal sent from the selected feed to the auxiliary 
bus. The range is OFF to +10dB.

�� Pan: Provides panning across stereo Aux bus destinations.

The level to which you set an Aux bus will be shown within the bar that represents that Aux bus 
in the Mixer’s channel strip.

The Auxiliaries levels shown in the 
channel strip of the Mixer

Pan
The Mixer provides access to two kinds of pan controls, depending on whether you’re doing 
stereo and surround or 3D positioning in your mix.

The Stereo and Surround Pan Controls
A Pan control that’s compatible with stereo and surround panning. You can drag the panning 
handle within this control to adjust panning for stereo or surround mixing, or you can 
double‑click this control to expose a large Pan window. What controls are available in the 
Pan window depend on the mapping of the audio track, but both stereo and surround panning 
controls are available, with corresponding numeric controls. You can either adjust panning 
using the graphical Pan control, or you can adjust specific panner characteristics using the 
controls to the left.

The Pan control window

When a channel strip’s Pan control is enabled, the Pan area displays the panning that’s being 
applied. Unlike the EQ or Dynamics controls, you can adjust a channel’s panning by dragging 
the handles that appear within this small area of the channel strip.
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The channel strip’s Pan indicator

The Audio Pan window contains the following controls:

�� Left/Right: Changes the balance of signal between the left and right side speakers 
you’re outputting to, depending on what speaker format you’re mixing to. At its simplest, 
accommodates stereo output.

�� Front/Back: Changes the balance of signal between the front and back sets of 
speakers you’re outputting to, depending on what speaker format you’re mixing to.

�� Rotate: Simultaneously adjusts the left/right and front/back pan controls in order to 
rotate a surround mix about the centre of the room.

�� Spread: Only available when a linked group of mono tracks is selected. Spread adjusts 
the perceived size of a surround mix.

�� Divergence: Spreads the signal for an individual feed across more of the adjacent 
loudspeakers, making the perceived size of the sound source larger.

�� Boom: The send level of that track to the LFE part of the mix.

–– On: Enables this functionality.

–– Pre: Lets you adjust the “dry” part of the signal separately from the “wet” part of the 
signal when effects are applied.

The 3D Audio Pan Controls
Option-double-clicking on the Pan control of the Mixer opens an alternate 3D Audio Pan 
window. Whereas the regular Pan window lets you do stereo and conventional 5.1 and 7.1 
surround panning, the 3D Audio Pan window lets you do the kind of spatial audio positioning 
enabled by advanced surround formats such as Auro 3D and NHK 22.2 (more information about 
specific support for these and other formats will come later). 

The 3D Pan window

Chapter – 130  Mixing in the Fairlight Page 2534



The 3D Audio Pan window has a few more controls than the ordinary Pan window:

�� Pan enable: Toggles the entire panning effect on and off.

�� Panner viewer: A large 3D representation of the listener’s perceived sound stage, with 
a blue sphere that represents the position of the track’s audio being positioned within 
that space, which casts a shadow straight down on the floor and projects a blue box on 
the four walls of this space to indicate its position more concretely.

�� Front panner: A 2D panning control that represents the horizontal left/right axis and the 
vertical up/down axis, letting you make these specific spatial adjustments.

�� Side panner: A 2D panning control that represents the horizontal front/back axis and 
the vertical up/down axis, letting you make these specific spatial adjustments.

�� Top panner: A 2D panning control that represents the horizontal left/right axis and the 
vertical front/back axis, letting you make these specific spatial adjustments.

�� Left/Right: A 1D knob that changes the balance of signal between the left- and right-
side speakers you’re outputting to, depending on what speaker format you’re mixing to.

�� Front/Back: A 1D knob that changes the balance of signal between the front and 
back sets of speakers you’re outputting to, depending on what speaker format you’re 
mixing to.

�� Rotate: A 1D knob that simultaneously adjusts the left/right and front/back pan controls 
in order to horizontally rotate a surround mix about the center of the room.

�� Tilt: A 1D knob that simultaneously adjusts the left/right and up/down pan controls in 
order to vertically rotate a surround mix about the center of the room.

�� Spread: Only available when a linked group is selected. Spread adjusts the perceived 
size of a surround mix.

�� Divergence: Spreads, or bleeds, the signal of an individual feed across the adjacent 
loudspeakers, making the perceived size of the sound source larger. A 2D button lets 
you set how this is done. With the 2D button turned off, divergence creates a one-
dimensional bleed between the left/right planes only. With the 2D button turned on, 
divergence creates a two-dimensional bleed between both the left/right and front/back 
planes of sound.

�� Boom: The send level of that track to the LFE part of the mix. An On button enables this 
functionality, while a Pre button lets you adjust the “dry” part of the signal separately 
from the “wet” part of the signal when effects are applied.

Bus Assignment Buttons
Two sets of buttons let you route audio from one channel strip’s output to Sub and Main buses 
that you’ve set up for your mix.

The channel strip’s bus assignment buttons

�� Main: These buttons let you assign a track or Sub’s channels to one or more of the main 
busses.

�� Submix: These buttons let you assign that track’s channels to one or more 
submix buses.
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Fader Groups (VCA Groups)
You can assign multiple faders to a Fader Group, also referred to as “VCA group,” which is 
controlled by a dedicated group channel strip that appears at the right of the mixer. Fader 
Groups let you simultaneously adjust multiple faders using one group fader, for instances where 
that will help you manage the levels of complex collections of audio tracks. 

The controls for doing this are found in the Group label area of each control strip, which also 
display which group each fader has been assigned to.

Group Labels in each control strip, 
above the control strip label

Making Fader Group Assignments
You can assign any fader to one of 16 groups by right-clicking the group label area and 
choosing a group from the pop-up that appears. If a fader is already assigned to a group, you 
can choose “No Group” to remove it.

Right-clicking a Group Label reveals 
a pop-up menu that lets you assign 
faders to or remove faders from groups
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Using Fader Groups
Once you’ve assigned multiple faders to a group, a dedicated channel strip for that group 
appears. Making adjustments to the group channel strip simultaneously controls all the faders, 
solo buttons, and mute buttons of all channel strips that are members of that group, as 
seen below.

Adjusting the Group 1 fader also adjusts the faders for Audio 1, 3, 
and 4 that are assigned to that group

While in a group, you can still move the faders of each individual channel strip independently to 
make relative adjustments. Channel strip faders only move together when you adjust the group 
fader, and while the group fader is being moved, each individual fader’s relative offset from 
other faders in that group is maintained, as seen in the previous screenshot, where the Group 1 
fader is moving the faders in tracks Audio 2, 3, and 4, but each individual channel strip fader in 
this group is offset from the others.

Recording Fader Automation for Groups
You can record automation data to the group fader, and all faders in that group will follow even 
though they’re not actually automated themselves. This makes it easy to record complex 
automation involving multiple faders when you still might want the freedom to finely adjust each 
individual fader later on.

Arm, Solo, and Mute Buttons
Identical to the controls found in the track header controls of each timeline audio track.

The channel strip’s Arm, Solo, and Mute bottons
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�� Record Arm: (highlights red when enabled) Lets you enable a track to be 
recorded onto. 

�� Solo: (highlights green for Solo, blue for Solo Safe) Lets you mute all other tracks in 
order to play a track you need to focus on in isolation. If solo is enabled for multiple 
tracks, all soloed tracks will play, and all non-soloed tracks will be muted. This affects 
rendering, so if one or more tracks are soloed, the muted tracks won’t be output or 
rendered.

–– Solo Safe: Command-Option-click a Solo button to put it into “Solo Safe” mode. 
Tracks set to Solo Safe, in which the Solo button is highlighted in blue, always play 
even if Solo is enabled for other tracks. This is good for tracks you want to continue 
listening to for reference even as you solo other specific tracks you want to pay more 
attention to.

�� Mute: (highlights orange when enabled) Turning on Mute disables audio playback from 
that track. This affects rendering, so if one or more tracks are muted, they won’t be 
output or rendered.

TIP: You can click a button and drag across multiple channel strips to turn that button 
on or off for multiple tracks easily.

Fader Controls
Each track’s vertical fader lets you control the level that’s output by that track, either using your 
mouse, or using the physical fader of your Fairlight console. If you’re working with a console, 
then the onscreen faders serve as a visual reference of what levels are set.

The fader area
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�� dB: Shows you the volume, in decibels, that track is currently set to.

�� Fader: Each track’s vertical fader can be dragged with your mouse or other pointing 
device to adjust the volume of that track and perform automation recording. Dragging 
up increases volume, dragging down decreases volume. Fader handles turn red while 
you record levels automation, and they turn green when automation has been recorded 
for that track.

Methods of adjusting channel faders:
�� To change the level of that channel with the mouse: Click and drag any fader up 

or˛down.

�� To reset the level of that channel to 0 dB: Double-click a fader’s handle. This does not 
work after you’ve recorded automation for a track.

Bouncing Audio
Bouncing audio refers to mixing and rendering audio from one or more Timeline tracks onto 
another track of the Timeline, in the process “baking in” processor intensive effects and 
complicated or intricate audio edits to create a new continuous piece of audio media that’s 
written to the directory location specified by the “Save clips to” field of the Capture and 
Playback panel of the Project Settings.

There are two commands available for bouncing audio on the Fairlight page when you hit the 
wall with how many tracks and effects you can mix in real time.

�� Timeline > Bounce Selected Tracks to New Layer

�� Timeline > Bounce Mix to Track

To use Bounce Selected Tracks to New Layer:
1	 Set In and Out points to define the range of the Timeline you want to bounce. If you 

don’t do this, nothing will happen.

2	 Command click the track headers or mixer channel strips of all tracks you want to 
bounce in order to select them.

3	 Choose Timeline > Bounce Selected Tracks to New Layer.

The audio on each track is processed and rendered and appears as the top layer of 
audio on that track. While View > Show Audio Track Layers is turned off, it will appear 
as if the new bounced audio is the only clip on that track. However, the original audio 
with live effects is still available as the bottom of the stack of layered audio on that 
track, and turning View > Show Audio Track Layers on will show this. The bounced 
audio is a new audio media file that’s written to the directory location specified by the 
“Save clips to” field of the Capture and Playback panel of the Project Settings.

To use Bounce Mix to Track:
1	 Choose Timeline > Bounce Mix to Track. The Bounce Mix to Track window appears, 

showing each main, submix, and auxiliary that’s currently available.

2	 In the Destination Track column, set which mixes you want to bounce by choosing 
either New Track, or choosing a specific existing track from the pop-up menus.

3	 Click OK.

The specified mix is processed, mixed, and bounced to the specified track as a new 
piece of audio. This creates new audio media that’s written to the directory location 
specified by the “Save clips to” field of the Capture and Playback panel of the 
Project Settings.
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TIP: There’s also a Bounce Audio Effects command in the contextual menu of audio 
clips in the Timeline that have audio plug-ins applied to them. For more information, 
see Chapter 132, “Audio Effects.”

Third-Party Control Panel 
Support for Mixing
DaVinci Resolve supports HUI- and MCU-compatible third-party mixing control panels with up 
to eight faders, such as the Mackie MCU Pro Control Surface, connected via USB MIDI, and 
selectable in the Control Panels panel of the Resolve System Preferences. Supported basic 
panel controls that correspond to Fairlight features at the time of this writing include the 
following.

Transport controls including:

�� Rewind (REW)

�� Fast Forward (FF)

�� Stop (double-press the Stop button for Home in the Timeline)

�� Play (double-press the Play button to “play again”)

�� Record (press Record+Play to begin recording if one or more tracks is record-enabled)

�� Jog control (Press SCRUB and rotate the jog wheel)

Channel Strip controls including:

�� Rotary controls for panning, with Rotary Value display and Rotary touch

�� Alphanumeric Track Name display

�� Record button to record-enable tracks (only works if an input is patched to a track input)

�� Solo, with a double-press selecting or de-selecting that track

�� Mute

�� Select to select the track corresponding to that channel strip

�� Fader control and optional Level display

�� Channel and Fader Bank buttons to move left and right among banks of channel strips

�� Double-press the Fader Bank Left button to move the playhead Home in the mixer 
(track 1)

�� Double-press the Fader Bank Right to move to the Master channel strips

Marker buttons:

�� Marker to add a marker

�� Pressing the Marker+Stop buttons sets Home

�� Pressing the Marker+FF/REW buttons jumps the playhead forward or backward

Additional supported controls for control panels that have them include: 

�� Master Solo clear/restore

�� Undo (pressing the Undo+Option buttons does Redo)

�� Arrows to move the selection
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�� Zoom horizontal and vertical controls

�� Audio Tracks, to turn Automation On/Off 

�� Write/Trim/Touch/Latch switches

�� Nudge controls

�� Cut, Copy, and Paste

Monitoring controls include: 

�� Level control

�� Dim

�� Mute

�� Alt Speaker

For more information on third-party mixing control panel support, see the Blackmagic Support 
site at https://www.blackmagicdesign.com/support/family/davinci-resolve-and-fusion.
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Chapter 131

Automation 
Recording

The Fairlight page provides simple, flexible, and comprehensive facilities 
for recording and editing mix automation data. Once recorded, all feed 
and bus mix parameter automation can be played back in perfect 
synchronization with the audio, including channel parameters, bus 
assignments, inserts, and direct outs.

The Fairlight page is designed to allow the operator to record every static 
and dynamic parameter change you make in the process of balancing the 
mix of tracks in the timeline. Mixer adjustments may be recorded for one 
or multiple parameters or channels at a time. Additionally, more 
adjustments may be added with each automation recording pass, which 
lets you create complex and detailed mixes that can be frame-accurately 
replayed at will.

This chapter covers automation mixing using the combined controls of the 
onscreen mixer and timeline. For more information on basic mixing 
operations, see Chapter 130, “Mixing in the Fairlight Page.”
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Automation Recording
While the recording of keyframe automation is most commonly associated with either the 
onscreen mixer or the Fairlight console, you can also record automation using controls found in 
the Inspector, or using the controls of the EQ, Dynamics, and Pan windows, thereby enabling 
you to record automation for the various audio effects that you’ve applied to a track. 

Recording automation refers to creating high-fidelity data that records changes you make to 
onscreen controls and/or Fairlight console controls, in real time as the Timeline plays, that will 
then control how those parameters will play back. In this way, you can create a dynamic mix 
where different audio level, pan, and EQ, dynamics, and other audio filter settings change over 
time to fade swells of music up and down, pan the sound effect of a car driving by from the left 
to the right speaker, or slowly increase the strength of a reverb effect applied to foley footsteps 
as a character walks into a long, dark cavern.

What You Can Automate
You can record automation for nearly every control in the mixer for channel strips 
corresponding to individual tracks, track groups, or busses, including the fader. Additionally, you 
can record automation for controls found in audio plug-ins that you use in your mix.

Automation Controls
The automation button, to the right of the transport controls, lets you show and hide the 
Automation toolbar.

Clicking the Automation button displays the automation toolbar

The Automation toolbar has buttons for each option that’s available for preparing to record 
automation in your mix.

Options found in the Automation toolbar

The Automation toolbar displays the following options:

�� Automation: Controls how automation data is recorded.

–– Write: Records absolute changes to control automation.

–– Trim: Records relative changes to control automation in order to increase or reduce 
levels that have already been recorded.

�� Touch: Defines what happens when you first adjust an automatable control.

–– Off: No automation is recorded.

–– Latch: Automation is recorded once you begin moving a control and continues 
recording after you release the control.

–– Snap: Automation is recorded once you begin moving a control and stops recording 
after you release the control; there is a brief interpolation from the last level you set 
to the prior recorded level.
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�� On Stop: Defines what happens when you release an automatable control.

–– Event: The last recorded automation value overwrites previous levels to the start of 
the next available recorded automation data (or event) in that track.

–– Hold: Deletes all previously recorded mixing data after what you’ve just recorded, to 
hold the last recorded level for the rest of that track.

–– Return: The last recorded automation value is interpolated to ramp back to the 
previously recorded automation values on that track.

�� Enables: The following buttons let you enable or disable different controls for recording 
automation.

–– Fader: Automates track and bus volume.

–– Mute: Automates the mute button.

–– Pan: Automates all pan controls.

–– EQ: Automates all EQ controls.

–– Comp: Automates just the Compressor controls in the Dynamics window.

–– Gate: Automates just the Gate controls in the Dynamics window.

–– Lim: Automates just the Limiter controls in the Dynamics window.

–– Aux: Automates the Auxiliary controls in the Auxiliaries window.

–– Plug-ins: Automates all plug-ins.

–– Misc: Automates the parameters of VST and Audio Unit plugins.

How to Record Automation 
There are two different ways you can set up the recording of automation for levels, panning, EQ, 
Dynamics, and other audio controls in the mixer.

Recording Automation for Multiple Tracks
You can use the following steps to record automated changes to any audio control in any 
control strip:

1	 Open the Automation toolbar, and do the following three preparatory steps:

a	 Choose whether you’re going to write new automation, or trim automation that’s 
already recorded. Write mode is appropriate when you’re recording automation for 
the first time, or when you’re overwriting previous automation with brand new 
values. Trim mode is appropriate when you’re making incremental changes to 
previously recorded automation.

b	 Next, choose Touch and On Stop behaviors that are appropriate for the kind of 
automation recording you need to do.

2	 Move the playhead to the beginning of the section of the timeline you want to record 
automation for. 

3	 Next, initiate playback using any method (Spacebar, L, Play button, third-party or 
Fairlight audio control panel), and make whatever adjustments you want to the controls 
for which you’ve enabled automation recording. As you make adjustments, the affected 
fader control turns red to let you know you’re recording automation.

4	 When you’re finished, stop playback using any method (Spacebar, K, Stop button, third-
party or Fairlight audio control panel). Automation recording stops as well.
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Recording Automation for Specific Individual Tracks
You can use the following steps to record automated changes to controls in specifically armed 
control strips:

1	 Open the Automation toolbar, and do the following three preparatory steps:

a	 Choose whether you’re going to write new automation, or trim automation that’s 
already recorded. Write mode is appropriate when you’re recording automation for 
the first time, or when you’re overwriting previous automation with brand new 
values. Trim mode is appropriate when you’re making incremental changes to 
previously recorded automation.

b	 Next, set Touch to Off, which disables across-the-board automation recording and 
requires you to arm specific tracks that you want to automate.

2	 Click the automation arm button above the fader of any Mixer track to which you want 
to record automation. Even though the Touch control is set to off, moving a control on 
an armed channel strip will record automation in Latch mode.

The automation arming 
button above a fader in 
the Mixer

3	 Move the playhead to the beginning of the section of the timeline you want to record 
automation for. 

4	 Next, initiate playback using any method (Spacebar, L, Play button, third-party or 
Fairlight audio control panel), and make whatever adjustments you want to the controls 
for which you’ve enabled automation recording. While you make adjustments, the 
affected fader control turns red to let you know you’re recording automation. If you’re 
displaying the same automation data in the Timeline that you’re recording, you can see 
the new automation being drawn in real time, in red.
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Automation being displayed while it’s recorded

5	 When you’re finished, stop playback using any method (Spacebar, K, Stop button, third-
party or Fairlight audio control panel). Automation recording stops as well. Displayed 
automation turns green once recording has stopped.

If you don’t like what you’ve done, you can undo and start over, or you can edit the 
automation using methods described later in this chapter. Or, you can back the 
playhead up and overwrite automation at any time with new automation.

Viewing Automation in the Timeline
Once you’ve recorded automation keyframes for a particular parameter, they can be made 
visible in an automation graph in the Timeline. While the automation controls are visible, an 
additional pair of controls appear in the header of each audio track. A pop-up lets you choose 
which automation waveform to view, with options for Fader, Mute, Pan, EQ, Compressor, limiter, 
Aux, and Plugins controls.

Mixing automation for the Fader shown in the Timeline

At the time of this writing, automation data cannot be cut, copied, or pasted.

Overwriting Automation
Once you’ve recorded automation for a particular clip, you can overwrite that automation in 
subsequent passes. Using either of the previously described methods of recording automation, 
adjusting the levels of a track control with previously recorded automation displays a red line 
that shows the new level relative to the previously recorded level.
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Setting new levels to overwrite previously recorded automation displays a red line

Pressing play to actually record this new automation will overwrite the previous levels 
at this new value.

New automation overwrites the previous levels

Editing Automation
When the automation toolbar is displayed, two additional tools appear in the regular toolbar. 
From left to right, these are the Pencil and the Select Range tools. These tools let you edit 
automation in different ways.

The Pencil and Select Range 
tools appear when you open the 
Automation toolbar

Drawing Automation Keyframes
You can use the pencil tool to literally draw new automation curves in the Timeline for 
whichever parameter’s automation data is visible. This can be a good way to smooth out ragged 
sections of automation without needing to re-record everything you did.

Simply click the Pencil tool, choose the automation data you want to edit in a track of the 
Timeline using the pop-up menu in the track header, and then click and drag to draw a new 
curve. While you’re drawing, the new curve appears in red, while the old curve appears in 
green, to help you see what you’re doing. When you’re finished, release the pointer button and 
the automation curve will be redrawn.
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Using the Pencil tool to smooth out a section of automation

Adjusting and Deleting Automation Keyframes
The Select Range tool lets you adjust automation in two different ways. 

Adjusting Individual Keyframes

Using the Select Range tool, you can click and drag any automation keyframe up or down and 
left or right (bounded by its neighboring keyframes) to adjust it directly. When zoomed in, this 
can be an effective way of making minute adjustments to troublesome keyframes. The segment 
of automation affected by the keyframe you’re dragging appears red to show you the new 
curve you’re creating, while the previously recorded curve remains green. When you release 
the pointer button, the new shape will be drawn.

Using the Select Range tool to adjust an automation keyframe

Adjusting and Deleting Multiple Keyframes
You can also use the Select Range tool to drag a bounding box to select multiple keyframes, in 
preparation for moving them or deleting them.

Dragging a bounding box over a section of 
automation using the Select Range tool
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Once you release the box, that section of keyframes becomes highlighted.

Multiple automation keyframes selected

Once it’s highlighted, you can drag the selection to move it, or you can press the Delete key to 
delete it. The remaining section of the curve flattens out to fit the first and last keyframe of the 
selection.

The newly flattened section of the automation 
curve after deleting the selected keyframes

Adding New Keyframes
You can also use the Select Range tool to add new keyframes to an automation curve. 
However, these are not Bezier keyframes, so they only let you create a single level adjustment 
at that frame. If you make a large adjustment with only a single new keyframe, you’ll end up with 
a squared off section of automation. For this reason, adding new keyframes should only be 
done when making small adjustments, unless you intend to create an abrupt change.

Adding and adjusting a keyframe using the Select Range tool, exaggerated for print
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Playing Automation
After you’ve automated a mix, playing it back is as simple as moving the playhead to an area of 
the timeline prior to the recorded automation, and initiating playback. As the timeline plays, the 
onscreen controls for each automated parameter are shown in green, and move and update to 
show the recorded levels for those controls.

Green controls show 
which ones have recorded 
automation during playback
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Chapter 132

Audio Effects

Audio plug-ins let you apply effects to the audio clips in your mix, such as 
echo or reverb, noise reduction, aural enhancement, click and pop 
removal, and so on. DaVinci Resolve is compatible with a wide variety of 
third-party VST and Audio Unit effects for audio processing, and these 
can then be used either in the Edit or Fairlight pages. This chapter goes 
through the different methods available for applying and customizing 
effects for clips and for tracks.
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About Audio Plug-Ins
Single or multiple plug-ins can be applied to clips and to tracks. A total of 96 mono channels of 
plug-ins can be applied (a stereo plug-in uses two of these channels, a 5.1-aware plug-in six 
channels, and so on). Plug-ins are accessed via each track’s control strip, or via the Inspector 
which provides access to both clip and track plug-ins.

FairlightFX
FairlightFX are a DaVinci Resolve-specific audio plug-in format that runs natively on macOS, 
Windows, and Linux, providing high quality audio effects with professional features to all 
DaVinci Resolve users on all platforms.

VST and VSTi  
VST (Virtual Studio Technology) is an audio plug-in standard created by Steinberg. The VST 
standard allows third-party developers to create VST plug-ins for use within VST host 
applications, or to create VST host applications themselves. The VST plug-in standard is the 
most widespread audio plug-in standard in use today, with thousands of available plug-ins 
spanning the gamut from EQ and compression to reverb, denoising, de-essing, aural exciting, 
and much more.

The Fairlight page supports VST effects from Mono to 7.1 - and beyond. These effects can be 
inserted on mono channels or Link Groups. If a stereo VST effect is inserted on a LCR, LCRS, or 
5.1 Link Group, the left and right channels will be allocated to left and right Link Group channels 
automatically.

As of this writing, DaVinci Resolve supports VST version 2.4. VST effects are available on 
macOS and Windows workstations, but not on Linux.

VST Effects versus VST Instruments (VSTi)
A VST effect is a type of VST plug-in that is used to process audio. A VST effect might be a 
Reverb, Compressor, or EQ. VST Instruments are typically used to synthesize sound or play 
back sampled audio. VSTs have rapidly replaced hardware synthesizers and dedicated 
samplers due to their flexibility, repeatability, and low cost.

Audio Units
Audio Units are an audio plug-in API created by Apple. Similarly to VST, Audio Units (AU) can 
either process audio, or work as instruments. Audio Units are only available on macOS 
workstations.
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Using Audio Plug-Ins
FairlightFX are pre-installed on all DaVinci Resolve installations. If you install additional VST or 
Audio Unit effects on your workstation, they appear in the Audio FX panel of the Effects Library, 
organized in separate categories.

Audio plug-ins in the Effects Library

Audio plug-ins let you apply effects to individual audio clips or entire tracks worth of audio, to 
add creative qualities such as echo or reverb, or to take care of mastering issues using noise 
reduction, compression, or EQ.

Methods of applying audio plug-ins to clips on the Fairlight page:
�� To apply an audio filter to a clip: Drag any filter from the Audio FX panel of the Effects 

Library onto the clip in the Timeline you want to apply it to.

�� To apply an audio filter to multiple clips: Select all of the clips you want to apply an 
audio filter to, then drag any filter from the Audio FX panel of the Effects Library onto 
any of the selected clips.

When you apply an audio plug-in to a clip, a badge appears to the left of that clip’s name bar in 
the Timeline to let you know there’s an effect applied to it.

Timeline clips with audio plug-ins applied appear with a badge
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Also, when you apply any kind of an effect to a clip in the Timeline, be it an adjustment in the 
Inspector or a plug-in you’ve applied, clips with that effect applied appear a darker shade of 
whatever color they are. Removing all effects from a clip (for example, using the Remove 
Attributes command) returns that clip to its original color. This makes it easy to see, at a glance, 
which clips have effects, and which clips don’t.

A closeup of the Timeline with a darker clip with effects between 
two other regularly-colored clips without effects

Methods of applying audio plug-ins to tracks on the Fairlight page:
�� To apply an audio filter to an entire track in the Timeline: Drag any filter from the 

Effects Library onto the track header.

Applying an audio filter to a whole track via the Timeline

�� To apply an audio filter to a track or bus in the Mixer: Drag any filter from the Audio 
FX panel of the Effects Library onto the clip in the Timeline you want to apply it to.

Applying an audio filter to a whole track 
via drag and drop to the Mixer

�� To apply an audio filter to a track or bus using the Mixer controls: Click the plus 
button in the channel strip of the track you want to apply an effect to, and then choose 
a filter from the pop-up menu that appears.
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Applying an audio filter to a whole track via the Mixer’s own controls

To edit a clip’s audio plug-ins:
�� Select that clip and open the Inspector. All audio plug-ins applied to that clip appear 

under the volume and pan controls, with that filter’s controls appearing directly in the 
inspector.

To edit a track’s audio plug-ins, do one of the following:
�� Click in the background of the Timeline header to select that track, and then open the 

Inspector. Click the custom UI button for that filter to open its controls.

The custom UI button 
for audio plug-ins in the 
Inspector

�� Move the pointer over the plugin’s name in the Effects area of the Mixer, and click on 
the custom UI button to open its controls.

The custom UI button for audio 
plug-ins in the Mixer
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Nearly all FairlightFX, VST, and Audio Unit audio plug-ins have a custom user interface that 
makes it much easier to manipulate that filter’s controls. These can be opened from within 
DaVinci Resolve.

The custom audio filter interface for iZotope RX4

Methods of working with audio plug-ins in the Inspector:
�� To rearrange the order of multiple video filters applied to a clip: Click the move up or 

move down buttons in any filter’s title bar, to the left of each filter’s Trash Can button.

�� To disable or re-enable a filter: Click the toggle button at the far left of each filter’s 
title bar.

�� To remove a filter: Click the Trash Can button.

�� To reset any filter parameter: Click the Reset button at the far right of the parameter 
you want to reset.

�� To open or collapse a filter’s parameters: Double-click the title bar.

�� To open or collapse the parameters of all filters: Hold the Option key down and 
double-click any filter’s title bar.

Once applied to a clip or track, audio plug-ins can also be keyframed or automated just like 
volume and pan settings, to create dynamic audio effects that change over time.

Applying Audio Plug-Ins to Buses
You can apply audio plug-ins to Main and Sub buses just like any other track, with which to 
apply any audio mastering effects operations you require to individual submixes, or even to an 
entire main.

Dealing With Processor Intensive Plug-Ins
As you apply more and more plug-ins directly to clips in complicated mixes, you may discover 
you lack the processing power to play all audio tracks and effects in real time. When this 
happens, there are two ways you can ease the burden that audio clip effects are placing on 
your workstation.

Chapter – 132  Audio Effects 2558



Caching Audio Clips With Plug-Ins
One quick fix is to manually enable the caching of one or more selected audio clips with audio 
effects applied to them to improve your project’s performance. Once an audio clip is cached, all 
plug-in effects are “baked in” and that clip’s audio waveform updates to reflect the altered 
audio. Cached clips appear with a small badge to the right of the FX badge in the name bar 
of the clip.

A cache badge lets you know this audio clip has cached effects

This is a non-destructive operation that has no lasting effect on the source media of cached 
clips. You can still alter a cached clip’s plug-in parameters whenever you want. Opening the 
graphical controls of a cached clip temporarily suspends audio caching, and when you’re 
finished, the clip is automatically re-cached and its waveform is updated to reflect the change 
so long as Cache Audio Effects remains enabled.

To cache audio effects for one or more selected clips:
Right-click an audio clip with a plug-in applied and choose Cache Audio Effects to 
enable audio effect caching for that clip. If you right-click one of multiple selected clips, 
you’ll enable Cache Audio Effects for all selected clips at once. Once enabled, that clip 
will be continue to be cached (and re-cached if you change the plug-in’s parameters) 
until you manually disable audio caching.

To disable audio caching for one or more selected clips:
Right-click an audio clip that’s been cached and choose Cache Audio Effects to disable 
audio effect caching for that clip.

Bouncing Audio Clips With Plug-Ins
Another way of easing the burden of audio clip effects on your system is to bounce the effected 
clip to another layer. This creates a new piece of audio media with the effect “baked in,” which 
is written to the directory location specified by the “Save clips to” field of the Capture and 
Playback panel of the Project Settings.

To bounce one or more selected audio clips with effects to another layer:
Right-click an audio clip with a plug-in applied and choose Bounce Audio Effects. If you 
right-click one of multiple selected clips, you’ll Bounce Audio Effects for each selected 
clip all at once. After bouncing an audio clip with effects, the original clip will be muted.

Bounced clips no longer have editable effects, but you can always choose View > Show Audio 
Track Layers to see the original underlying clip that still has the original plug-in effect applied, 
and you can unmute it, move it back up to the top, edit the effect, and bounce another version 
of the clip, which appears as the topmost layer.
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Chapter 133

FairlightFX

DaVinci Resolve 15 introduced FairlightFX, a DaVinci Resolve-specific 
audio plug-in format that runs natively on macOS, Windows, and Linux, 
providing high-quality audio effects with professional features to all 
DaVinci Resolve users on all platforms. Thirteen new audio plug-ins that 
can be used both in the Edit and the Fairlight page include a wide variety 
of plug-ins for repairing faulty audio, creating effects, and simulating 
spaces. This chapter explains what they do and how to use them.
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Common Controls For All FairlightFX
Before going into the specific controls of each FairlightFX plug-in, there are some common 
controls that all plug-ins share, found at the top of the custom GUI window for each plug-in.

Common controls for all FairlightFX

�� Presets: A cluster of controls that let you recall and save presets specific to each plug‑in.

–– Add Preset button: Click this button to save the current settings of the FairlightFX 
you’re using. A dialog lets you enter a Preset name and click OK.

–– Preset pop-up menu: All presets for the currently open plug-in appear in this menu.

–– Previous/Next preset buttons: These buttons let you browse presets one by one, 
going up and down the list as you evaluate their effects.

�� A/B Comparison: A set of buttons that lets you compare two differently adjusted 
versions of the same plug-in. The A and B buttons let you create two sets of 
adjustments for that plug-in, and toggle back and forth to hear which one you like 
better. The arrow button lets you copy the adjustments from one of these buttons to 
the other, to save the version you like best while experimenting further.

�� Reset: A single reset control brings all parameters in the current plug-in to their 
default settings.

Chorus
An effects plug-in. A classic Chorus effect, used to layer voices or sounds against modulated 
versions of themselves to add harmonic interest in different ways.

An animated graph shows the results of adjusting the Modulation parameters of this plug-in, 
giving you a visualization of the kind of warble or tremolo that will be added to the signal as you 
make adjustments.

The Chorus FairlightFX
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Chorus has the following controls:

�� Bypass: Toggles this plug-in on and off.

�� Input Format: (Only visible when Echo is inserted on a multi-channel track.) Lets 
you choose how multiple channels are input to the echo.  Stereo sets separate Left 
and Right channels.  Mono sums Left and Right to both channels. Left inputs the Left 
channel only, and Right inputs the Right channel only.

�� Delay: The amount of delay between the original sound and the Chorus effect.

–– Delay Time: Length of the Chorus delay lines.

–– Separation: Time separation of the delay voices.

–– Expansion: Sets L/R length differences, phase offset of modulators

�� Modulation: These controls adjust the low frequency oscillator (LFO) that drives the 
tremolo of the chorus effect in different ways.

–– Waveform: Specifies the shape of the LFO that modulates the rate of the Chorus, 
affecting the timing of the oscillations. There are six options: Sine (smooth 
oscillations), Triangle (sudden oscillations), Saw1, Saw2 ( jerky oscillations), Square 
(hard stops between oscillations), and Random (randomly variable oscillations).

–– Frequency:  Rate of LFO controlling the Chorus. Lower values generate a warble, 
higher values create a tremolo.

–– Pitch: Amount of frequency modulation, which affects the pitch of the Chorus.

–– Level: Depth of level modulation. Affects the “length” of the segment of Chorus 
that’s added to the sound. Low values add only the very beginning of the Chorus 
effect, high values add more fully developed Chorus warble or tremolo.

�� Feedback:

–– Amount (%): The percentage of signal fed back to the Chorus Delay Line. Values can 
be positive or negative, the default is 0 (no effect). Increasing this parameter adds 
more of the Chorus effect to the signal, lowering this parameter adds more of the 
inverted Chorus effect to the signal. At values closer to 0, only a faint bit of Chorus 
can be heard in the audio, but at values farther away from 0 (maxing at +/- 99), a 
gradually pronounced Chorus becomes audible.

–– Bleed (Hz):  Amount of feedback which bleeds into the opposite channel (Stereo 
mode only).

�� Output: Controls for adjusting the final output from this plug-in.

–– Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to 
“wet” or processed signal. 0 is completely dry, 100% is completely wet.

–– Output Level (dB): Adjusts the overall output level of the affected sound.

De-Esser
A repair plug-in specific to dialog. The De-Esser is a specialized filter that’s designed to reduce 
excessive sibilance, such as hissing “s” sounds or sharp “ts” sounds, in dialog or vocals. 

A graph shows you which part of the signal the controls are set up to adjust, while reduction 
and output meters let you see which part of the signal is affected and what level is 
being output.
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The De-Esser FairlightFX

The De-Esser has the following controls:

�� Bypass: Toggles this plug-in on and off.

�� Frequency Range: Two controls let you target the frequency of the “s” sound for a 
particular speaker.

–– Target Frequency: A knob that lets you target the frequency of the offending 
sibilance. Sibilant sounds are usually found in the range of 5 - 8kHz.  

–– Range: switches the operational mode of the De-esser. Three choices (from top to 
bottom) let you switch among Narrow Band, Wide Band, and All High Frequency 
which processes all audio above the source frequency.

�� Amount: Adjusts the amount de-essing that’s applied.

�� Reaction Time: Adjusts how suddenly de-essing is applied. There are three choices.

–– Relaxed: Equivalent to a slow attack.

–– Fast: Equivalent to a fast attack.

–– Pre-emptive: A “lookahead” mode.

De-Hummer
A repair plug-in with general applications to any recording. Eliminates hum noise that often 
stems from electrical interference with audio equipment due to improper cabling or grounding. 
Typically 50 or 60 cycle hum is a harmonic noise, consisting of a fundamental frequency and 
subsequent partial harmonics starting at twice this fundamental frequency. 

A graph lets you see the frequency and harmonics being targeted as you adjust this plug-
in’s controls.
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The De-Hummer FairlightFX

De-Hummer has the following controls:

�� Bypass: Toggles this plug-in on and off.

�� Frequency: Target source fundamental frequency. A knob lets you make a variable 
frequency selection, while radio buttons let you select common frequencies that 
correspond to 50Hz/60Hz electrical mains that are the typical culprits for causing hum.

�� Amount: Adjusts how much De-Hum extraction you want to apply.

�� Slope: Adjusts the ratio of fundamental frequency to partial harmonics, the adjustment 
of which lets makes it possible for various kinds of hum to be targeted. For example, a 
value of 0 biases hum extraction towards the fundamental frequency, while a value of 
0.5 gives equal extraction of all harmonics (up to 4), and finally a value of 1.0 targets the 
higher frequency partials.

Delay
An effects plug-in. A general purpose stereo delay effect, suitable for tasks varying from track 
doubling, to early reflection generation, through simple harmonic enhancement. Processes in 
stereo or mono, depending on the track it’s applied to.

A graph shows the timing and intensity of the echoes generated by this plug-in on each 
channel, and an Output meter displays the output level of the resulting signal.
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The Delay FairlightFX

Delay has the following controls:

�� Bypass: Toggles this plug-in on and off.

�� Input mode: (Only visible when Delay is inserted on a multi-channel track.) Lets you 
choose how multiple channels are input to the delay. Stereo sets separate Left and 
Right channels. Mono sums Left and Right to both channels. Left inputs the Left channel 
only, and Right inputs the Right channel only.

�� Filters: Alters the proportion of frequencies that are included in the delay effect. When 
the Delay plug-in is inserted on a Mono Channel, the Left and Right sections are 
replaced with a single “Delay” section.

–– Low Cut (Hz): A global High Pass filter.

–– High Cut (Hz): A global Low Pass filter.

�� Delay: Adjusts the timing of the delay.

–– Left/Right Delay (ms): Delay time of each channel.

–– Left/Right Feedback (%): Feedback % of the Left or Right channel back to itself. A 
negative value equates to % of feedback with a phase reverse from the original signal.

�� Feedback: Controls for adjusting the amount of bleed between channels.

–– High Ratio: Adjusts the frequency of a damping filter for the feedback signal.

–– Stereo Bleed: Adjusts the proportion of signal from Left and Right channel feedback 
which feeds into the opposite channel. When the Delay plug-in is inserted on a 
Mono channel, Stereo Bleed control does not appear.

�� Output: Controls for adjusting the final output from this plug-in.

–– Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to 
“wet” or processed signal. 0 is completely dry, 100% is completely wet.

–– Output Level (dB): Adjusts the overall output level of the affected sound.

Distortion
An effects plug-in. Creates audio distortion that’s useful for sound design and effects, ranging 
from simple harmonic distortion simulating an audio signal going through primitive or faulty 
electronics (such as bad speakers, old telephones, or obsolete recording technologies), all the 
way to mimicking an overdriven signal experiencing different intensities of hard clipping (think 
someone yelling through a cheap bullhorn, megaphone, or PA system). This plug-in includes 
soft tube emulation in the output stage.
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An animated graph shows the results of adjusting the Distortion parameters of this plug-in, 
giving you a visualization of the kind of harmonic distortion, waveshaping, and clipping that will 
be modifying the signal as you make adjustments. Input and Output meters let you see how the 
levels are being affected.

The Distortion FairlightFX

Distortion has the following controls:

�� Bypass: Toggles this plug-in on and off.

�� Filters: Two filters let you simulate devices reproducing limited frequency ranges.

–– LF Cut: Low frequency distortion shaping.

–– HF Cut: High frequency distortion shaping.

�� Distortion: Three sets of controls let you create the type and intensity of distortion 
you want.

–– Mode buttons: Switch the operational mode of distortion. The one to the left, 
Distortion, creates harmonic distortion. The button to the right, Destroy, is a more 
extreme polynomial waveshaper.

–– Distortion: Adjusts the amount of distortion that’s applied to the signal. Higher 
values distort more.

–– Ceiling: Adjusts the level of input signal that triggers clipping.

–– Output: Controls for adjusting the final output from this plug-in.

–– Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to 
“wet” or processed signal. 0 is completely dry, 100% is completely wet.

–– Output Level (dB): Adjusts the overall output level of the affected sound.

–– Auto Level button: Applies automatic compensation for gain added to the signal due 
to the distortion being applied. Having this button turned on prevents the signal from 
becoming dramatically and unexpectedly increased, while turning it off frees you to 
do what you want, if what you want is to hear a lot of distortion.
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Echo
An effects plug-in. A classic Echo effect, simulating the fate of the cursed Oread from Greek 
mythology. Processes in stereo or mono, depending on the track it’s applied to.

A graph shows the timing and intensity of the echoes generated by this plug-in on each 
channel, and an Output meter displays the output level of the resulting signal.

The Echo FairlightFX

Echo has the following controls:

�� Bypass: Toggles this plug-in on and off.

�� Input Format: (Only visible when Echo is inserted on a multi-channel track.) Lets you 
choose how multiple channels are input to the echo.  Stereo sets separate Left and 
Right channels. Mono sums Left and Right to both channels. Left inputs the Left channel 
only, and Right inputs the Right channel only.

�� Filters: Alters the proportion of frequencies that are included in the delay effect. When 
the Delay plug-in is inserted on a Mono Channel, the Left and Right sections are 
replaced with a single “Delay” section.

–– Low Cut (Hz): A global High Pass filter.

–– High Cut (Hz): A global Low Pass filter.

–– Feedback: Adjusts the frequency of a damping filter for the feedback signal.

�� Left Channel: Parameters that independently affect delay on the Left Channel. When 
the Echo plug-in is inserted on a Mono Channel, the Left Channel and Right Channel 
sections are replaced with a single “Echo” section with only the Delay Time, Feedback 
Delay, and Feedback controls.

–– Delay Time: Global Delay time for the Left Channel.

–– Feedback Delay: Echo Delay time for the Left Channel.

–– Feedback: Feedback percentage of the Left channel back to itself.

–– L > R Feedback: Percentage of Left feedback signal which feeds back to 
Right˛Channel.

�� Right Channel: Parameters that independently affect delay on the Right Channel.

–– Delay Time: Global Delay time for the Right Channel.

–– Feedback Delay: Echo Delay time for the Right Channel.

–– Feedback: Feedback percentage of the Right channel back to itself.

–– R > L Feedback: Percentage of Right feedback signal which feeds back to 
Left˛Channel.
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�� Output: Controls for adjusting the final output from this plug-in.

–– Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to 
“wet” or processed signal. 0 is completely dry, 100% is completely wet.

–– Output Level (dB): Adjusts the overall output level of the affected sound.

Flanger
An effect plug-in, giving that unmistakable Flanger sound dating from the days of dual tape 
machines with a slight delay added to one in periodic intervals causing flanging as they got 
back in sync with one another. Typically used to add a sort of warbling harmonic interest to a 
signal, in a wide variety of ways.

An animated graph shows the results of adjusting the Modulation parameters of this plug-in, 
giving you a visualization of the kind of warble that will be added to the signal as you make 
adjustments.

The Flanger FairlightFX

The Flanger has the following controls:

�� Bypass: Toggles this plug-in on and off.

�� Input mode: (Only visible when the Flanger is inserted on a multi-channel track.) 
Lets you choose how multiple channels are input to the Flanger. Stereo sets separate 
Left and Right channels. Mono sums Left and Right to both channels. Left inputs the Left 
channel only, and Right inputs the Right channel only.

�� Modulation: A low frequency oscillator (LFO) used to drive the Flanger effect.

–– Waveform (Hz): Specifies the shape of the LFO that modulates the rate of the 
Flanger. The three choices are Sine (a smooth change in rate), Triangle (a jerky 
change in rate), and Sawtooth (an abrupt change in rage). Affects the timing of the 
warble that is added to the sound.

–– Rate (%): Speed of the LFO, affects the speed of the warble that is added to 
the sound. Low rate values create a slow warble, while high rate values create more 
of a buzz.

–– Depth: Affects the “length” of the warble that is added to the sound. Low values add 
only the very beginning of a warble, high values add more fully developed warble.

�� Width: Consists of a single parameter, Expansion, which sets Left/Right channel length 
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differences, along with the phase offset of modulators.

�� Feedback: These controls determine, in large part, how extreme the Flanging effect 
will be.

–– Amount (%): The percentage of signal fed back to the Delay Line. Values can be 
positive or negative, the default is 0 (no effect). Increasing this parameter adds more 
of the Flange effect to the signal, lowering this parameter adds more of the inverted 
Flange effect to the signal. At values closer to 0, only a faint phase shift can be 
heard in the audio, but at values farther away from 0 (maxing at +/- 99), a gradually 
increasing warble becomes audible. The type of warble depends on the Modulation 
controls.

–– LPF Filter (Hz): Lets you filter the range of frequencies that will affect the 
feedback signal.

�� Output: Controls for adjusting the final output from this plug-in.

–– Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to 
“wet” or processed signal. 0 is completely dry, 100% is completely wet.

–– Output Level (dB): Adjusts the overall output level of the affected sound.

Modulation
An effect plug-in. General purpose modulation plug-in for sound fx/design. Four effects 
combine an LFO, FM adjustment, AM adjustment, Sweep and Gain filters to allow simultaneous 
frequency, amplitude and space modulation. In conjunction with the additional Rotation 
controls, simple Tremelo and Vibrato effects can be combined with auto-filter and auto-Pan 
tools in order to provide texture and movement to a sound.

An animated graph shows the results of adjusting the Modulator, Frequency, and Amplitude 
parameters of this plugin, giving you a visualization of the kind of modulations that will be 
applied to the signal as you make adjustments. Output meters let you see what level is 
being output.

The Modulation FairlightFX
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Modulation has the following controls:

�� Bypass: Toggles this plug-in on and off.

�� Modulator: A low frequency oscillator (LFO), shown in blue in the animated graph.

–– Shape: Specifies the shape of the LFO waveform that modulates the audio. Six 
options include Sine, Triangle, Saw1, Saw2, Square, Random.

–– Rate (Hz): Adjust the speed of the modulating LFO. Lower settings result in warbling 
audio, while extremely high settings result in buzzing audio the timbre of which is 
dictated by the shape you’ve selected.  

�� Frequency: Frequency modulation (FM) of a secondary oscillator, shown as green in 
the animated graph.

–– Level (%):  Controls the amount of Frequency Modulation that’s applied, intensifying 
or easing off the effect.

–– Phase: Since each of the four primary effects within this plug-in can be applied 
together, along with the fact that modulation with level components (Tremelo/
Rotation/Filter) have the ability to combine or cancel out one another, phase controls 
are available. Altering the phase of an individual effect allows control of such 
interaction (e.g., cancel out a high level change, or offset a cancellation).

�� Filter: Sweep and gain filters.

–– Level:  Lets you set the amount of filter sweep and gain to additionally use to modify 
the signal. The amount you’ve selected is previewed in a 1D graph to the side.

–– Tone:  Adjusts the center frequency of sweep.

–– Phase: Since each of the four primary effects within this plug-in can be applied 
together, along with the fact that modulation with level components (Tremelo/
Rotation/Filter) have the ability to combine or cancel out one another, phase controls 
are available. Altering the phase of an individual effect allows control of such 
interaction (e.g., cancel out a high level change, or offset a cancellation).

�� Amplitude: Amplitude modulation (AM) of a secondary oscillator, shown as green in the 
animated graph.

–– Level:  Amount of Amplitude modulation applied. (Disabled in Ring 
Modulation Mode.)

–– Phase: Since each of the four primary effects within this plug-in can be applied 
together, along with the fact that modulation with level components (Tremelo/
Rotation/Filter) have the ability to combine or cancel out one another, phase controls 
are available. Altering the phase of an individual effect allows control of such 
interaction (e.g., cancel out a high level change, or offset a cancellation).

–– Ring Modulation Mode:  Enables a Ring Modulation effect (where the signal is 
multiplied by the modulator, rather than modulated by it).

�� Rotation: These controls are only available when applied to a multi-channel track.

–– Depth:  Amount of Rotation applied.

–– Phase: Since each of the four primary effects within this plug-in can be applied 
together, along with the fact that modulation with level components (Tremelo/
Rotation/Filter) have the ability to combine or cancel out one another, phase controls 
are available. Altering the phase of an individual effect allows control of such 
interaction (e.g., cancel out a high level change, or offset a cancellation).

–– Offset:  Start offset of rotation in order to further place the signal in space.

�� Output: Controls for adjusting the final output from this plug-in.

–– Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to 
“wet” or processed signal. 0 is completely dry, 100% is completely wet.

–– Output Level (dB): Adjusts the overall output level of the affected sound.
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Noise Reduction
A repair plug-in designed to reduce a wide variety of noise in all kinds of recordings. Based on 
spectral subtraction, it’s able to automatically detect noise in sections of dialog, or it can be 
used manually by “learning” a section of noise that can be subsequently extracted from the 
signal. A graph shows a spectral analysis of the audio being targeted, along with a purple 
overlay that shows what noise is being targeted. Two audio meters let you evaluate the input 
level (to the left) versus the output level (to the right), to compare how much signal is being lost 
to noise reduction.

The Noise Reduction FairlightFX in action

Noise Reduction has the following controls:

�� Bypass: Toggles this plug-in on and off.

�� Auto Speech Mode/Manual radio buttons: These buttons toggle the overall 
functionality of the Noise Reduction plug-in between two modes:

–– Auto Speech Mode: Specifically designed for human speech/dialog, applying dialog 
extraction to the incoming signal to dynamically detect the noise profile outside of 
the detected speech. As a result, Auto Speech Mode does not require an initial a 
“learn” pass, and adapts itself better to noise that changes over time.

–– Manual Mode: Enables the Learn button, as this mode requires the user to locate 
a section of the audio recording that is only noise that the plug-in can analyze. 
To initiate this analysis, position the playhead at the beginning of a section of 
the recording that is only noise, click the Learn button so it’s highlighted, and 
play forward through the noise, stopping before any sound you want to preserve 
is reached, and clicking the Learn button to turn it back off. A noise profile is 
generated (shown in Purple on the graph), which is subsequently extracted from the 
remaining signal.

�� Threshold (in dB): Relates to the signal-to-noise ratio (SNR) in the source recording. 
Recordings with a poor signal-to-noise ratio will require a higher threshold value, 
resulting in more noise reduction being applied.

�� Attack (in ms): Primarily useful in Auto Speech mode, this controls the duration over 
which the noise profile is detected. Ideally, the attack time should match the variability 
of the unwanted noise. A low value corresponds to a faster update rate of the noise 
profile and is useful for quickly varying noise; a high value corresponds to a slower 
update rate and can be used for noise that’s more consistent.
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�� Sensitivity: Higher sensitivity values exaggerate the detected noise profile; the result 
is that more noise will be removed, but more of the dialog you want to keep may 
be affected. 

�� Ratio: Controls the attack time of the signal profile relative to the attack time of the 
noise profile. A faster ratio detects and preserves transients in speech more easily, but 
the resulting speech profile is less accurate.  

�� Frequency Smoothing: Smooths the resulting signal in the frequency domain to 
compensate for harmonic ringing in the signal after the noise has been extracted.

�� Time Smoothing: A toggle button enables smoothing of the resulting signal in the time 
domain as well.

�� Dry/Wet: A percentage control of the output mix of “dry” or original signal to “wet” or 
processed signal. 0 is completely dry, 100% is completely wet.

�� Makeup Gain: To let you compensate for level that may be lost due to the noise 
reduction operation you’re applying, this applies a pre-gain in, from -6dB to +18dB, just 
before the dry/processed mix. 

Pitch
An effects plug-in. Shifts audio pitch without altering clip speed.

The Pitch FairlighFX

Pitch has the following controls:

�� Bypass: Toggles this plug-in on and off.

�� Semitones: A “coarse” adjustment that can shift audio pitch up to +/- 12 semitones.

�� Cents: A “fine” adjustment that can tune audio pitch in +/- 100ths of a semitone.

�� Dry/Wet: A percentage control of the output mix of “dry” or original signal to “wet” or 
processed signal. 0 is completely dry, 100% is completely wet.

Chapter – 133  FairlightFX 2573



Reverb
A spatial simulation plug-in, capable of recreating multichannel reverberation corresponding to 
rooms of different sizes, adjustable via a graphical 3D cube control. This plug-in lets you take a 
“dry” recording and make it sound as if it’s within a grand cathedral, an empty room, or a 
tiled bathroom.

To understand this plug-in’s controls, it helps to know that the signal follows three paths which 
are combined to create the final effect:

�� A direct path.

�� An early reflection path (ER) simulating early reflection rays obtained from the first 
multiple reflections on the walls, traveling from the virtual source to the virtual listener.

�� A late reverberation path (Reverb) simulating the behavior of an acoustic model of the 
room.

A graph shows an approximate visualization of the reverb’s effect on the frequencies of the 
audio signal.

The Reverb FairlightFX

�� Reverb has the following controls:

�� Bypass: Toggles this plug-in on and off.

–– Room Dimensions: By controlling the size of the virtual room a sound is to inhabit, 
these parameters simultaneously control the configuration of Early Reflection and 
Late Reverberation processing. The acoustic modes from this simulated room are 
computed and fed to Late Reverberation processing. The shape, gain, and delay of 
the first reflections are computed and then fed to Early Reflection processing.

–– Height, Length, Width: Defines the dimensions of the reverberant space, in meters.

–– Room Size: The calculated Room Width x Length, in meters2.

�� Reverb: Additional controls that further customize the configuration of Early Reflection 
and Late Reverberation processing.

–– Pre Delay: Increase or negate the propagation time from the virtual source to the 
virtual listener. As a result, it modifies the initial delay time between the source signal 
and the first reflection.
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–– Reverb Time: Decay time of the Reverb tail. It controls the overall decay time of the 
acoustic modes from late reverberation processing. 

–– Distance: Modifies the distance between the virtual source and the virtual listener. 
It modifies only the configuration of early reflections processing.

–– Brightness: Modulate the shape of the decay time over frequency. At maximum 
brightness, decay time is identical at any frequency. At minimum brightness, higher 
frequencies result in shorter decay time and therefore duller sound.  

–– Modulation: Adds random low-frequency phase modulation from the tapping point 
of ER processing. At 0%, modulation is not used.

�� Early Reflection Tone: Four post equalization controls modify the tone of early 
reflections to suit a particular room’s characteristics.

–– Low Gain

–– Low Frequency

–– High Gain

–– High Frequency

�� Reverb Tone: Four post equalization controls modify the tone of the reverb tail to suit a 
particular room’s characteristics.

–– Reverb Tail Low Gain

–– Reverb Tail Low Frequency

–– Reverb Tail High Gain

–– Reverb Tail High Frequency

�� Output: These controls recombine the three audio processing paths into a single 
output signal.

–– Dry/Wet: A percentage control of the output mix of “dry” or original signal to “wet” or 
processed signal. 0 is completely dry, 100% is completely wet.

–– Direct Level: The amount of the direct level to mix into the final signal.

–– Early Reflection Level: The amount of early reflection to mix into the final signal.

–– Reverb Level: The amount of reverb to mix into the final signal.

Soft Clipper
The Soft Clipper is a limiting processor that reduces the output level above a defined threshold 
in a rounded manner so that peaks are more cleanly attenuated. The Soft Clipper plug-in will 
impart saturation effects when pushed hard above the threshold, allowing for the introduction 
of warmth and subtle distortion to the sound. A graph shows the shape of the curve adjustment 
this plug-in makes to the audio.

A soft clipper is often combined with a standard limiter in order to increase perceptual loudness 
of material without imparting harshness.

Chapter – 133  FairlightFX 2575



The Soft Clipper FairlightFX

�� Threshold: Introduces input gain to the signal prior to hitting the clipper, forcing audio 
peaks over the threshold by that amount. As such, it will drive the saturation and 
distortion.

�� Shape: The shape of the clipper can be varied to change the character of the soft 
clipper from full soft-clipping (all the way right, where the peaks are rounded) to full 
hard-clipping (all the way left, where the peaks are squared off).  

�� Audio Level: Lets you adjust the output gain to compensate for signal lost during soft 
clipping, if necessary.

Stereo Fixer
A simple plug-in designed to fix stereo source material in cases where only one side of a stereo 
signal was recorded, where one side of a stereo recording is a different level to the other, or 
where the stereo channels have been incorrectly Left/Right swapped.

This plug-in can also be used as a “Mid/Side” decoder, for recordings that were made using this 
microphone technique. 

This plug-in is for stereo clips only.

The Stereo Fixer FairlightFX
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�� Format: The input processing mode you want to use to fix the stereo output.

–– Stereo: (Default) No format conversion is performed.

–– Reverse Stereo: Swaps the Left and Right side.

–– Mono: The output from the plug-in is a mono mix of the two inputs.

–– Left Only: The left input is sent to both left and right outputs.

–– Right Only: The right input is sent to both left and right outputs.

–– M/S: The left output is the left (Mid) input minus the right input (Side). The right output 
is the left (Mid) input plus right input (Side).

�� Left/Right Gain: Lets you apply independent gain on the left or right outputs. This gain 
is applied after (post) the input processing mode.

TIP: For a comprehensive M/S decoder solution, simply chain two Stereo Fixer plug-ins 
together. Use the first unit to control the Side signal level, thus controlling the width of 
the second unit (set to M/S).

Stereo Width
An enhancement plug-in that increases or reduces the spread of a stereo signal in order to 
widen or reduce the separation between channels. If this plug-in is added to a Mono channel, 
it will be disabled, as there is no stereo width to either distribute or control.

A graph shows the currently selected width of stereo distribution as a purple arc, while inside of 
that graph a stereo meter shows the Left and Right distribution of the audio signal. Two audio 
meters measure levels, an Input meter to the left, and an Output meter to the right.

The Stereo Width FairlightFX in action

Stereo Width has the following controls:

�� Width: Lets you control the spread of the stereo output. Settings range from 0 (Mono) 
to 1 (Stereo) to 2 (extra wide stereo).

�� Diffusion: Adds more complexity to the output.

�� Sparkle: Adds more high frequencies to the spread.
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Vocal Channel
An enhancement plug-in for general purpose vocal processing consisting of High Pass filtering, 
EQ, and Compressor controls.

Side by side EQ and Dynamics graphs are presented above the controls. An output audio meter 
lets you monitor the final signal being produced by this plug-in.

The Vocal Channel FairlightFX

Vocal Channel has the following controls:

�� High Pass: Enabled by a toggle, off by default. Has a single frequency knob that sets 
the threshold below which frequencies are attenuated to reduce boominess or rumble.

�� EQ: A three-band EQ for fine tuning the various frequencies of speech, enabled by a 
toggle, including Low, Mid, and High Mode, Frequency, and Gain controls 

–– Low/Mid/Hi Mode: Lets you choose from different filtering options to use for 
isolating a range of frequencies to adjust. Different bands present different options.

–– Low/Mid/Hi Freq (Hz): Lets you choose the center frequency to adjust.

–– Low/Mid/Hi Gain (dB): Lets you boost or attenuate the selected frequencies.

�� Compressor:

–– Thres (dB): Sets the signal level below which compression occurs. Defaults to -25dB. 
The range is from -40 to 0dB. 

–– Reaction: Adjusts how quickly compression is applied when a signal exceeds the 
threshold. The default is 0.10.

–– Ratio: Adjusts the compression ratio. This sets the gain reduction ratio (input to 
output) applied to signals which rise above the threshold level. The default is 1.5:1. 
The range is 1.1 to 7.0.

–– Gain (dB): Lets you adjust the output gain to compensate for signal lost during 
compression, if necessary.
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Chapter 134

Audio Meters and 
Audio Monitoring

The Meters panel, which appears at the top of the Fairlight page when it’s 
enabled, provides a visual reference of the levels of each track in your 
mix, along with specialized meters showing the buses, monitoring mix, 
loudness, and a Viewer for seeing the video of the current project as you 
work. This chapter describes the use of these meters, and provides 
information about the different options that are available.
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The Monitoring Panel
Turning on the meters in the UI toolbar displays the Monitoring panel that runs along the top of 
the Fairlight page, which shows all of the audio meters that correspond to the tracks in the 
Timeline, as well as the Bus meters that correspond to the Mains, Subs, and Aux buses of your 
mix, the Control Room meters, and a video viewer.

The Monitoring panel

Track Meters and Monitoring Controls
At left, a row of audio meters corresponds to the channel strips of the Mixer, one meter for 
every audio track in the timeline. Each track displays the number of meters that corresponds to 
that track’s audio mapping, with mono tracks having a single audio meter, stereo tracks having 
two, 5.1 tracks having six, and so on.

Track audio meters with different 
numbers of meters depending on 
that track’s audio mapping

Each track and bus meter (with the exception of the Loudness meters) display RMS (root mean 
square) levels against a dB scale. A single line indicating the maximum value at any given 
moment in time is held briefly just above the current RMS levels, which appear as a solid bar 
extending from the bottom of the meter. RMS meters display a weighted “average” 
representation of the audio level that’s closer to the way audio is actually perceived, although 
not as accurate as the loudness meters discussed later in this section.
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Each meter bar is color coded to indicate two different thresholds of sound level, from low 
(green) to high (yellow) to very high (red).

The peak meter at top 

Each meter is identified by the track number it represents (track names are not shown over 
track meters) as well as the color of that track.

Using Post Fader or Track Source Meters
The Track Meters setting in the General Options of the Project Settings lets you choose how 
meters in the Fairlight page display their audio analysis. There are two options:

�� Post Fader: Meters always display the level of each clip’s signal after whatever fader 
adjustments have taken place. Fading a track’s level down diminishes the visible level 
of that audio signal in the meter. This setting is good if you prefer a visual indication 
of the relative levels you’ve set your various audio tracks to, which is a very NLE-
oriented behavior.

�� Track Source: Meters always use the volume levels of the audio clips in that track, 
even if you’ve lowered the level using the sliders. If you’ve keyframed a clip’s volume, 
that change will be reflected by the audio meters, even though fader changes are not. 
Viewing meters this way means you can always see how much level is available to clips 
in your mix regardless of what the current fader levels are set to, in the event you want 
to keep track of audio you want to bring back into the mix later on. This is a very DAW-
oriented behavior.
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Bus Meters
To the right of the track meters are the bus meters, in which all Mains, Subs, and Aux buses 
appear, separated by type, and each displaying the number of meters that corresponds to that 
track’s audio mapping. This way you can see the sum of all tracks that have been routed to a 
particular bus.

Bus meters for the Mains, Subs, and Aux buses

Compound Meters and 
Output Bus Selection Menu
The compound meters, to the right of the bus meters, consist of Control Room meters and 
Loudness meters, shown side-by-side to provide a comprehensive analysis of your overall 
audio mix. Below, pop-up menus let you choose which bus you want to monitor, as well as 
which set of speakers you want to use to do the monitoring.

The Control Room meters (at left), and 
Loudness meters (at right)

Monitoring Menus
The monitoring menus determine which bus gets analyzed by the compound meters. When the 
compound meters are displayed, the Monitoring pop-up menu that otherwise appears to the 
left of the monitoring controls in the Transport toolbar instead moves to a position underneath 
the Loudness meters. 
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This pop-up menu lets you choose which bus you want to monitor as you work. You can choose 
one of your mains, or you can choose a Sub or an Aux that you want to focus on for more 
detailed work.

The monitoring menu lets you choose which bus 
you want to monitor while working

The next pop-up menu to the right lets you choose one of the available sets of speakers once 
you’ve configured them in the Video and Audio I/O panel of the System Preferences. This gives 
you the flexibility to quickly listen to your mix on a variety of speakers and configurations to see 
how it holds up in different situations. For more information on configuring different speaker 
setups, see Chapter 3, “System and User Preferences.”

The monitoring menu lets you choose which 
bus you want to monitor while working

Control Room Meters
The mustard-colored Control Room audio meters show the sum of all audio channels that are 
routed to the currently selected bus being monitored (as selected in the pop-up menu below). 
These are peak meters measured in dBFS.

Loudness Meters
The set of meters all the way to the right are the Loudness meters, which consist of a set of two 
graphical meters and a numerical readout. These meters let you analyze the “integrated 
loudness” of the overall mix, which is the standard to which all contemporary mixing 
specifications refer when describing the deliverables you’re expected to provide to the client. 
Unlike the RMS audio meters found in the Timeline or mixer which measure audio in dB, 
loudness meters do a different kind of analysis, measured in LU (loudness units).

What Is LU?

A value of 1 LU (loudness unit) represents the smallest difference in audio levels that 
humans can actually perceive. Human hearing naturally sums all channels that reach 
the ear, so the summed channel meter to the right in the compound meters is an 
analysis of the loudness you actually hear.
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Loudness Meter Options
Two options in the General Options of the Project Settings let you customize the 
Loudness meters. 

�� Target Loudness level: Lets you set the LUFS value that’s used as a reference level 
for loudness metering. Defaults to –23 LUFS, which conveniently makes the display of 
these meters scale similarly to traditional audio meters that you’re already used to.

�� Loudness Scale: Lets you choose which scale you want to use with which to measure 
the meters. Options currently include the default of EBU +9 Scale (–18 to +9), and EBU 
+18 Scale (–36 to +18).

Graphical Loudness Meters
Two separate meters give you a dynamic graphical measurement of the Loudness of the 
selected bus being monitored according to the ITU-R BS.1770-3 and EBU R128 standards, which 
describe how to analyze the subjective loudness of a given audio mix for purposes of 
compliance with required quality control (QC) standards.

�� A steel-blue meter labeled M (for momentary) has as many channels as the selected 
bus you’re monitoring, excluding the LFE channel(s) of surround formats, which aren’t 
factored into loudness metering. This meter measures LEQ (equivalent sound level), 
within a 400ms window following the playhead as measured every 100ms. This lets 
you evaluate the LUFS (Loudness Units Full Scale) level of the mix at the current frame 
as you play. This discrete-channel analysis is used to calculate all other values of the 
loudness metering system.

�� A second steel-blue mono meter to the right displays the sum of all channels in the M 
meter, displayed in LU (loudness units). The numeric value displayed at the top of this 
meter is the maximum LU value that’s been analyzed during any stretch of timeline 
playback. This value is held until it’s reset, either by stopping and initiating playback a 
second time while Link to Playhead is enabled, or when you click the Reset button at 
the bottom of the loudness meter area.

Numeric Loudness Meters
A set of values to the right of the meters give running reports on the audio level of your mix. 
While the graphical meters are useful for analyzing your mix as you work, these numeric 
readouts are particularly valuable for providing the strict information you need to adhere to 
written QC standards. Their meaning is as follows:

�� Short: Measures the average LU level over a 30-second window following the 
playhead.

�� Short Max: Shows the maximum level over the same 30-second window. This analysis 
is required by EBU R128.

�� Range: Measures the dynamic range of the Loudness of your mix (in LU), which is the 
difference between the average soft and average loud parts of your mix. Analyzes the 
overall loudness over a played range of the mix, discounts the lowest 10% and highest 
5%, and then gives a standardized expression of the difference between the remaining 
soft and loud levels that were analyzed. The window of analysis is as long as you’ve 
been playing. This analysis is required by most QC specifications.

�� Integrated: Measures the LUFS value of the portion of the range of the mix you’ve 
played through. As you play, this integrated value accumulates. This analysis is required 
by most QC specifications.
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Using the Loudness Meters
When using the Loudness meters to do a structured analysis of your mix to determine QC 
adherence, a group of controls let you determine when analysis begins and ends.

�� Lock Metering to Transport: This setting is found in the compound meter option menu. 
When enabled, all loudness metering analysis is automatically reset whenever you 
move the playhead to another location in the Timeline. This is useful when you’re spot-
checking different parts of your mix, or working on a particular scene.

�� Pause and Reset buttons: When you’re doing a formal analysis of your mix, the Reset 
button lets you reset all currently accumulated analyses, and the Start button initiates 
loudness value accumulation. If you need to stop playback briefly to do something else, 
you can click Pause, and then click Resume when you’re ready to continue the analysis.

Viewer
A small viewer to the left of the Monitoring panel shows the frame of video at the position of the 
playhead. This is the same image that’s output to the external broadcast display of your 
workstation if you have one connected.

The Viewer lets you see the picture you’re mixing to

Clicking the Expand Viewer button at the bottom right-hand corner lets you open the Viewer 
into a floating window, which you can then position anywhere you want.

To close the floating Viewer, click the Dock Viewer button at the upper right-hand corner of the 
floating viewer window.

Click the button at the upper right-hand corner to dock the Viewer again
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Chapter 135

Signal Flow 
Diagrams

The diagrams in this chapter describe the audio signal flow that takes 
place within the Fairlight audio processing used by DaVinci Resolve. 
They’re intended for people who want an in-depth understanding of how 
audio is processed.
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Signal Flow Overview
The following simplified flow diagram describes Fairlight audio processing overall.
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Audio Processing Path
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